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Speedstack Specifications

Maximum layer count
Via rules
Materials library

Post press compensation
Finished thickness compensation
Stackup calculation

Drill types
Drill-via fill types

Back drill types

Design rules check

Si8000m/Si9000e integration
Flex-rigid modelling

Controlled impedance structures

Symmetrical stacks

Loss/Frequency dependent
modelling/graphing

Frequency dependent calculations
(causal interpolation of dielectric
constant)

Result presentation
Display series

Surface roughness compensation
Material library

File import

File export

128+
Conventional, blind and buried

Foils, Cores, RCC foils, Non-copper cores, Prepregs,
Solder masks, Flexible cores, Bondply, Adhesive,
Coverlays, Shields, Ident inks, Peelable masks

Yes (user defined)
Copper coverage/simple percentage

Copper thickness, stackup thickness, dielectric
thickness, solder mask thickness

Mechanical, Laser, Laser stacked, Through plated

Copper, Resin, Solder Mask, Non-Conductive,
Conductive, Sintering Paste, Copper Paste

Back Drill Must Cut Layer No, Back Drill Must Not
Cut Layer No, Back Drill Minimum Distance From
Cut Layer, Back Drill Maximum Distance From Cut
Layer, Primary Drill Size

Design logic, symmetry, copper balance, board
thickness, manufacturing tests, resin starvation

Bi-directional copy/paste structure parameters

Mesh/crosshatch ground plane modelling in
conjunction with Polar Si8000m/Si9000e

100+ structures supported with impedance goal
seeking and structure validation

Structure mirroring for symmetrical stacks

Differential, Odd mode, Even mode graphed over a
user-specifiable frequency range

Single frequency Er causal modelling using
interpolation of Er v frequency employing Svensson-
Djordjevic method

Length of line, Inches, Metres

All Losses, Impedance Magnitude, Inductance,
Resistance, Capacitance, Conductance, Alpha, Beta

Smooth, Hammerstad, Groisse, Huray, Cannonball-
Huray

On-line and on-premises

IPC-2581 Rev B, Ucamco Job file, Ucamco
Integr8tor and Ucam (.ssx), XML STKX and SSX,
Zuken CR-8000

CGen Coupon Generator, CITS File, Cadence
Allegro (IPC-2581 Rev B), CSV, DXF, Gerber, IPC-
2581 Rev B, Mentor Graphics, v10.00, Stackup
Image (JPEG, BMP, TIFF), Ucamco Integr8tor and
Ucam (.ssx), XML STKX and SSX, Zuken CR-8000,
Zuken DFM Center,
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Personal Computer Requirements

Computer

Processor

Operating system
Environment

System memory required
Hard disk space required
Video standard

Licensing

IBM PC compatible

Pentium 1GHz or better

Windows 10 or later

Requires .NET Framework v2.0 or above
2GB recommended

200MB (min.)

FHD (1920 x 1080%)
2 FHD (1920 x 1080*) monitors recommended

* Note: refers to effective resolution (some
systems automatically apply scaling to render text
readable — i.e. effective resolution refers to the
screen resolution after scaling.)

Electronic: local FlexNet license
Fixed: Parallel/USB key

Floating FlexNet license
(Windows servers only)
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Guide to the manual

Introduction

Getting started with
Speedstack

Configuring Speedstack

Using Speedstack

Design rule checking

Adding controlled impedance
structures

Frequency dependent
calculations (Speedstack Si)

Si Projects

CITS test files
Speedstack Flex
Speedstack HDI

The Speedstack materials

libraries

Printing stackup reports

Introduces Polar Instruments Speedstack.

Steps through the process of creating a simple stack
from a set of manufacturer's data.

Setting up the Speedstack environment including
license options, crosshatch and structure defaults, goal
seeking parameters and file locations.

Discussion of the Speedstack user interface; creating
and editing stackups.

Using Virtual Material mode; using Material Library
mode

Using the Speedstack Design Rule Checker to correct
stackup design errors.

Working with the Si8000m/Si9000e field solvers to add
controlled impedance structures to the stackup model.
Using the goal seeking facilities of the field solver to
obtain the correct impedance for a structure.

Working with frequency dependent calculations to
produce graphs and tables of insertion loss v frequency
for each stack substrate.

Using causal modelling
Using surface roughness compensation

Working with Si Projects in Speedstack with Si8000m
and Si9000e

Creating CITS test files for controlled impedance
structures in the stack

Working with flex-rigid stackups — using the Speedstack
Flex navigator

Working with HDI builds — sequential lamination

Using the Speedstack materials libraries, creating new
libraries, adding material to the library. Accessing the
online libraries

Printing Speedstack technical reports; using the stack
data tables, drill data tables, controlled impedance data
tables, bill of materials tables and frequency dependent
tables and loss graphs
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Introduction to Speedstack

Speedstack PCB Stackup Builder

Polar Instruments Speedstack PCB Stackup Builder is
designed to accelerate the PCB stack design process and
deliver significant reductions in the amount of time consumed
in PCB stackup documentation and control. Given designer
specifications the PCB fabricator can use the Speedstack
Stackup Builder to create in just a few steps the most cost
effective stack for the range of available materials.
Speedstack offers interconnect designers (PCB layout
engineers), PCB front-end engineers and fabricators a fast
and professional solution to layer stackup creation and
documentation. Speedstack provides formal documentation
for everyone involved in ensuring the correct materials are
used in the build process.

Speedstack PCB

Speedstack PCB is a versatile PCB layer stackup design tool
featuring powerful and easy to use graphical stackup editing
capabilities. For PCB fabricators Speedstack PCB interfaces
with the industry standard Polar Si8000m PCB Multiple
Dielectric Controlled Impedance Field Solver.

Lossless calculations

Speedstack PCB includes a link and license for the Si8000m,
using the proven Si8000m to provide the impedance data for
the stack. In addition, Speedstack PCB licence holders have
full access to the stand alone Si8000m Quick Solver.

Speedstack PCB is especially tailored for PCB fabricators
and PCB brokers — anyone with a requirement to design or
communicate controlled impedance PCB stackups.

Speedstack PCB customers are able to share stackups and
read impedance requirements from designers who are using
Speedstack Si PCB Insertion Loss Field Solver.

Speedstack Si

For electronic engineers involved in stackup design
Speedstack Si interfaces with the Polar Si9000e PCB
Insertion Loss Field Solver. Both Speedstack Si and
Speedstack PCB are able to directly output controlled
impedance test files associated with each stackup. For the
fabricator this is an ideal way to link the impedance test
requirements to a particular job. For the OEM this offers a
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clear method of sending impedance test specifications out to
suppliers or brokers. Designers and fabricators can work
together and select the best material combinations for
minimising build costs. Fabricators can share their in house
material libraries with OEMs and ensure the most effective
material choice is employed in the build.

Frequency dependent calculations

Speedstack Si caters for frequency dependent calculations
and adds comprehensive insertion loss calculation capability
into Speedstack; insertion loss can be graphed over a user-
specifiable frequency range. Frequency dependent structure
properties allow for insertion loss calculation: trace
conductivity, frequency range and result presentation mode.
Loss results can be shown in dB/m, dB/inch or dB/LL (length
of line.)

Causal modelling

Frequency dependent parameters include length of line,
trace conductivity, dielectric constant and loss tangent,
frequencies of interest and causal extrapolation points for
each substrate and also support amalgamated dielectric
structures. Frequency dependent calculations employ causal
interpolation of dielectric constant using Svensson-Djordjevic
modelling. Library materials tables include dielectric constant
and loss tangent fields and substrate causal extrapolation
reference points values may be set either manually or
automatically from the library (virtual material mode supports
loss tangent in laminates and soldermask.)

Surface roughness modelling

Speedstack includes surface roughness compensation in
frequency dependent calculations, supporting Hammerstad,
Groisse and Cannonball-Huray surface roughness modelling
methods.

Bidirectional copy and paste between Speedstack and the
Si9000e transmission line field solver allows for quick
transfer of structure parameters.

Technical reports optionally include insertion loss graphs for
user-nominated structures.

Speedstack Flex

Speedstack Flex allows OEM designers to create accurate
and efficient flex-rigid PCB stackups in just a few minutes,
with error-free documentation for tighter control over the
finished board. For PCB fabricators, Speedstack Flex
provides the flexibility to quickly calculate the impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
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and performance of the board. Speedstack Flex can be used
in conjunction with the Si8000m and Si9000e field solvers
when modelling and documenting mesh/crosshatch ground.
Structure data and mesh geometry can be readily shared
between Speedstack and the field solvers. The Navigator
provides a clear contextual view of the rigid and flexible
stacks within a flex-rigid build and allows easy alignment of
displayed materials between stacks. The associated
technical report also supports different materials on the same
dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.

Speedstack HDI

Speedstack’s Navigator quickly guides you through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. There is no limit to the number of press cycles that can
be documented.

Resin check / excess resin algorithms determine the order in
which the materials are pressed together and return useful
resin percentage information that can be used to determine
potential de-lamination problems.

User-definable settings within the navigator allow engineers
to display layers in transparent, invisible or 3D mode.
Speedstack HDI makes re-ordering and renaming sub-stacks
quick and easy with the Navigator. This is especially useful
for HDI constructions.

Rapid stackup creation

Users may specify the stackup semi-automatically with the
powerful Stackup Wizard or alternatively build the stack
manually, layer by layer. Speedstack is flexible and allows
full manual editing of stacks created by the Stackup Wizard.

Easy stackup editing

The Speedstack allows the user to view stackup in 2D or 3D
format. Layer and material annotation is clear and easy to
read and each layer may be selected and queried to display
the associated material type and properties, including the
associated data file. Visible drill information ensures that
designers instantly know which layers support conventional,
blind and buried vias.

Speedstack allows you rapidly to build and share stacks and
verify via aspect ratios and track spacing rules. The stack file
contains base material information combined with layer
description and a complete listing of transmission line
structures deployed in the stack. Keeping all stack
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information in one file ensures that manufacturing data is
accurately shared between original designer and fabricator.

Speedstack’s Stack Editor provides efficient and time-saving
features such as Copy/Paste Material properties so the stack
designer can copy all properties from a selected material and
then paste user-selectable property groups to other materials.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding and deleting foils and/or cores — increasing or
reducing the layer count

Moving foils and cores — maintaining the layer count
Exchanging two different thickness cores within the stack

Copying and pasting foils or cores — increasing the layer
count

High quality documentation and file format

Speedstack saves the stack in efficient electronic format and
outputs stack graphics in a variety of formats to suit your
requirements. Stack data may be output in GERBER, DXF,
BMP, JPEG, TIFF and XML. In addition, the stack data can
be exported in comma-separated form for inclusion in other
systems. Speedstack’s high quality customisable printouts
make it easy to discuss alternate builds and pricing impacts
with fabricators.

Applications engineers, front end and production engineers
benefit from receiving stack information in an intuitive, easy
to understand format. The Speedstack .sci file contains full
details of the layer stackup of a particular job. If changes are
necessary or preferred stacks are to be shared with
customers, Speedstack can cut the time for documentation
and information sharing to a fraction of the time taken when
employing traditional methods such as spreadsheet, word
processor or presentation software.

Integration with the Si8000m/Si9000e

Speedstack is fully integrated with the Polar Si8000m
Controlled Impedance and the Si9000e PCB Transmission
Line Field Solvers so the user can quickly add controlled
impedance structures to layers in the stackup. The designer
or board fabricator can use the Goal Seek facility of the
Si8000m/Si9000e field solvers to arrive rapidly at the
controlled impedance structure parameters to produce the
target impedance.
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Materials library

Speedstack supports a flexible materials library. This allows
the designer to use standard materials data and also
provides the facility to create new material libraries. PCB
fabricators can also build libraries of commonly stocked
materials to give interconnect designers visibility of the
materials held in stock. Speedstack thus supports three
types of library — custom user libraries of materials, generic
designer libraries of materials of given dielectric
characteristics (for example, thicknesses) along with a
comprehensive set of materials libraries from PCB base
material suppliers who are members of the Polar Speedstack
Material Partner program.

Online / on-premise materials libraries

The Speedstack Material Library includes an online library to
allow users to download material library MLBX files from the
Polar website. The online material library feature provides
the user with a list of available library files from suppliers in
the Speedstack Material Library Partner program.

Library filtering

Materials can be filtered by supplier and by the frequency at
which the dielectric constant and loss tangent (Dk and Df) are
specified. On selection the file is downloaded and is either
appended to the existing data or replaces the existing data.

On-premise material library

Speedstack also includes an on-premise option to allow for
customers on Polarcare support who cannot connect to the
online library due to network security restrictions; contact
polarcare@polarinstruments.com with your Polarcare
contract number to obtain the latest material library.

Speedstack's Virtual Material mode

Speedstack provides Virtual Material mode allowing you to
build and experiment with stackups (for example, to examine
the effects on impedance structures of different trace widths
or dielectric heights) without requiring real materials to be
entered into a materials library. In Virtual Material mode you
will use the Stackup Wizard to enter a few details about the
stack, the number of layers, overall board thickness, plane
and mixed layers, etc., along with solder mask and copper
thickness and build type (foil, core or HDI) and drills.
Speedstack will then build a stack to the specified board
thickness by equally distributing the dielectric regions. If a
preferred core thickness is specified the software will
maintain the dielectric thickness for core regions but then
equally distribute prepreg regions to reach the target board
thickness.
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Preferred builds

PCB fabricators are able to create and share preferred builds
and exchange the associated information with designers.
Build data also includes blind and buried via specification.
This simplifies the task of sharing stackup and drilling
information between board shops and the design community.

Dimensional information

Finished board thickness is a critical dimension in many
applications; Speedstack keeps track of the finished PCB
thickness and tolerance and allows fabricators the flexibility
of adding in-house post-press thickness for prepreg layers.
Additionally, Speedstack takes into account plating thickness
where appropriate.

High layer count boards

On boards with high layer counts it can be very easy to make
a change that would produce a non-symmetrical stack. The
Speedstack Design Rules Check monitors symmetry across
the stack, and ensures that material symmetry is maintained.
Speedstack also makes it easy to set the symmetrical build
mode to ensure that any changes you make are applied
equally across the stack.

Supplier management

When multiple-sourcing PCBs or when moving from
prototype to volume production, the stack and fabrication
design rule checks ensure that the manufacturing capabilities
of your chosen suppliers are not overlooked. In addition the
professional documentation output ensures that layer stack
information is accurately conveyed to PCB suppliers.

Graphical interface

Speedstack offers an easy to interpret graphical interface.
Clearly showing the layers supporting blind and buried vias,
Speedstack also records the data file for each layer
(including ident and peelable mask layers). The graphical
interface is especially designed to simplify the process of
communication between interconnect designer and
fabricator. OEMs who need to manage boards sourced from
multiple suppliers will also find this facility invaluable. In
addition to physical layers Speedstack adds mask and
notation for electrical layers.

Grid View

Speedstack’s Grid View provides a single grid-based dialog
where all materials can be edited from the same screen. This
allows the user rapidly to change the properties of multiple
materials and then apply all the changes simultaneously.
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Editable fields include Layer Name, Description, Dielectric
Constant, Loss Tangent and Processed Thickness.

The tabular data in Grid view can be exported to Microsoft
Excel for editing and the edited version imported from
Microsoft Excel into Grid View. Changes made in Grid View
are reflected in the main Stackup Editor and can be saved
back to the original stackup design.

Structure View

Structure View presents an interactive overview of the
controlled impedance / insertion loss structures that exist on the
stack up, offering enhanced visibility of all impedance
structures from the main edit view. Positioned to the right of
the stack up within the Stack Editor window, structures are
aligned with the stackup electrical layers on which they have
been defined.

Interfacing with other systems

Speedstack is able to load an XML file on launch. If an XML
file (.stkx) filename parameter is specified on the command
line it will import this file into Speedstack.

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured within the Configuration option.

Importing and exporting stackup information
IPC-2581 Rev B

Speedstack incorporates Import from and Export to IPC-
2581 Rev B option with interactive interface, supporting
stackupmaterial and structure information

Ucamco

Speedstack incorporates the facility to read in files in XML
format and Ucamco Job File format, providing comprehensive
integration with Ucamco and will import files from and export
to both Ucam and Integr8tor.

Zuken

Speedstack integrates directly with the Zuken CR-8000
Design Force and Zuken Design Force DFM Center PCB
manufacturing pre-processing and CAM system, simplifying
material communication in the supply chain. Designers can
define layers in DFM Center then export to Speedstack to
define materials and provide a fully documented stackup in a
format widely recognised by both PCB supply chain
managers and fabricators.

Stacks may be exported to the Polar CGen Coupon
Generator for subsequent processing into test coupons.
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The Export CITS File option will create test files for Polar
CITS controlled impedance test systems.

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats JPEG, BMP
and TIFF.

Export options also include Cadence Allegro, CSV, IPC-2581
Rev B and Mentor Graphics.

Import / export XML file formats support frequency
dependent structure properties.

Converting imported electrical layers to cores

When importing stackup data from some CAD / CAM
systems only the electrical layers are defined, so copper
layers may appear adjacent each other. Speedstack allows
conversion of two adjacent electrical layers into core or
flexible core materials using the Convert to Core function.

Structure net classes

Speedstack is able to import and store up to five net class
names with each structure. These net class names provide a
link to the matching impedance nets inside the ECAD PCB
layout system.
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Installing Speedstack

Installing and activating Speedstack

It will be necessary to install and activate the product license
and set operating options prior to building stacks or
performing calculations with Speedstack. See Configuring
Speedstack|Licensing to select the associated field solver
and purchased options.

Obtaining a Speedstack license

Speedstack is license using the FlexNet Publisher licensing
service. Contact Polarcare@polarinstruments.com for
installation/activation directions.

Download the software from the supplied link. Unpack and
save the installation file to a suitable folder then run Setup.

Uninstalling the software

Caution: Prior to uninstalling, make a copy of the Speedstack
folder structure and data files and store in a safe place.

To uninstall the Speedstack software:
Windows 7/8

Choose Settings|Control Panel; select Programs and
Features and right click Speedstack and choose Uninstall.

Windows10/11
Click The Windows Settings Icon and Choose Apps.

File Explorer

From The List of Apps And Features click Speedstack then

Setti . .
& Setmas click Uninstall

& Power

13
[ [}
I
3

{l
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Getting started with Speedstack

Online tutorial guides

Polar’s web site provides online downloadable quick start
and version specific user guides to familiarize users with the
operation and features of the software.

From the Help menu choose Speedstack Help to download
the Getting Started guide, along with tutorials for stack
editing, managing materials libraries, manufacturing
constraints and controlled impedance structures:

https://www.polarinstruments.com/help/speedstack/tutorials/

Download the user guide for your Speedstack version:

https://www.polarinstruments.com/help/speedstack/Nrmstart.htm

Stackup Templates

Polar’s web site provides online downloadable prebuilt
sample templates and associated technical reports (suitable
for Speedstack 2019 or higher) to familiarize users with the
operation and features of the software.

https://www.polarinstruments.com/support/stackup/templates.html

The stackup templates listed include both materials and drills
and are typical of standard stacks used in PCB construction
and can prove useful as a starting point when building your
own stacks.

Stackup samples include core and foil build models in both
material library and virtual library modes (see Creating and
editing stackups) for rigid stackups, flex-rigid stackups and
multiple press cycle HDI stackups.

Click on the link above or on the Polar web site navigation
bar click Resources|Stackup Templates and download the
Speedstack template project (.sci) file; save to a convenient
location and the use the Open Project command in
Speedstack to view and edit the stackup.

Note that the sample stackups are shown with dimensions in
microns.
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Using Speedstack Stackup Builder

Speedstack Stackup Builder

£Z Polar Speedstack Stack Up Builder:  Stack: Eval Imperial.stk  Project : Eval Imperial.sci

File

Edit View Tools Units Extemal Utilty Help

Double-click the Speedstack icon to start the Speedstack
program and display the Stackup Editor.

The Stackup Editor

The Stackup Editor screen displays all details of the stack,
including copper and prepreg materials, solder masks and
ident layers, drilling information, controlled impedance
structures and design rule check results.

Controlled impedance structure data may be transferred
between Speedstack and the associated Polar Si8000m or
Si9000e field solver to goal seek for the target structure
dimensions.

=4

El=slix0=—==-

il

Stack Up Edior | DRC =4 Cortroled Impedance | CI Reauits |

X TEEES=wgnT

L[] <fvors o[ |
ey .

Substrate 1 Height
Substrate 1 Diclectric Erl

Lover Trace Width wi
Upper Trace Width w2

Trace Separation s1[61z
Trace Thickness Ti[Es
Coating Above Substrate cifE@m
Ceating Above Trace <2 2540

Coating Between Traces c3 540

Coating Dielectric CEr[a0000

Differential Impedance: Zd[10029

Target Impedance. 100.00
Target Tolerance % 10.00

T

[Target Stack Up Thickness =

152400 [Stack Up Thickness = 1545.84 [Stack Up Thickness with Soldermask = 155664 [V22.09.01

Speedstack main screen
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The Speedstack main screen
The Speedstack main screen comprises:

e The Stackup Build and Construction Window — where
the board stackup is built and edited. Materials from
an extensive library of cores, prepregs, foils, solder
masks, bondply, adhesives and shields supplied by
manufacturers in the Speedstack Material Partners
program are added to the stackup in the Stackup
Editor. The Stackup Build and Construction Window
includes Structure View which presents an interactive
overview of the controlled impedance / insertion loss
structures that exist on the stackup, offering enhanced
visibility of all impedance structures from the main edit
view. Positioned to the right of the stackup within the
Stack Editor window, in 2D view structures are aligned
with the stackup electrical layers on which they have
been defined.

e The Grid View Window — provides a single grid
based dialog view of the stack where all materials’
descriptions can be edited from the same screen.

e The Controlled Impedance window displaying the
controlled impedance structures (if any) for the
selected layer. Structures may be added or deleted
and recalculated after editing. The Controlled
Impedance window also contains a Mirror Structures
function for a symmetrical stack and a Goal Seek
function which will adjust the structure’s trace widths
for a target impedance.

e Stackup Editor/Notes tab — a free form text area for
explanatory or commentary notes

e Design Rules Check (DRC) tab — allows design rules
and manufacturing constraints to be specified and
violations displayed

e Stackup Information properties area — table
containing information related to the whole stackup

e Selected Item Information area — properties table
containing the attributes of the layer currently selected
in the stackup

e The Controlled Impedance Results tab — summarizing
the controlled impedance structures within the stack

e The Menu bar — drop-down context sensitive menus
containing all the Speedstack Editor commands

e The Tool bar — incorporating short cut tool buttons to
the most common menu commands
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The Stackup Build and Construction Window

The Stackup Build and Construction Window is where the
board stackup is built and edited. New stacks are created
and existing stacks edited in this window. Stacks are
portrayed as a not-to-scale pictorial representation of the
sequence of materials in the stackup.

Materials from the Speedstack library of products, an
extensive library of cores, prepregs, foils, solder masks,
bondply, adhesives and shields supplied by manufacturers in
the Speedstack Material Partners program, are added and
arranged in the stack via the Build and Construction Window.

1.4000

Liquid Photolmageable Mask

PrePreg 1080

FR4 Core

Coppe

‘0000
1.4000

3.0000
6.0000
.0000

1.4000
12.0000
1.4000

3.0000

1.4000

Liguid Photolmageable Mask

Speedstack PCB Build and Construction Window allows the
OEM designer rapid creation of accurate and efficient rigid
and flex-rigid PCB stackups, and provides error-free
documentation for tighter control over the finished board.

The interactive graphical interface also provides the PCB
fabricator the flexibility to quickly calculate the effect of
substituting alternative materials within the stack to improve
manufacturability and reduce cost while maintaining the
specified parameters and performance of the board.

Speedstack Si Build and Construction Window is ideal for the
designer, fabricator or PCB technologist who needs to
manage PCB stackups with both impedance and insertion
loss control. In addition to incorporating Polar’s proven
insertion loss field solver capability, Speedstack Si allows
rapid import and export of insertion loss projects into the
Si9000e Insertion Loss Field Solver so you can analyse your
stack up design in detail.
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Changing the Stackup View

The Stackup Window provides a full representative non-
scale view of the stackup and, optionally, all the controlled
impedance and insertion loss structures in the stack.

The View menu allows for zooming in for a detailed view of
sections of the stack. Use the Zoom In (Ctrl + +Key)
command to focus on the section of interest. Zoom in and
out Of the view with the mouse wheel.

Panning in the stackup window
Use the mouse to pan horizontally across the stackup
window.

Vertical panning is enabled when the height of the displayed
stackup exceeds the height of the editor window

Primary-Side-P...
Primary-Side-I...

Primary-Side-S...
Primary-Side-L...

Ground-Plane/l...

Inner-Tracking-...

P N e T N i e i
3V3-Power-Pla...

1V5/2V5-Powe...

Inner-Tracking-...

Click into the stackup and drag it up and down into position.
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Structure view

Structure View presents an optional interactive overview of all

the controlled impedance and insertion loss structures that
g exist on the stack, offering enhanced visibility of all
impedance structures from the main edit view. To access
Structure View drag the stackup to the left or use the Show /
Hide Structure View button. Structure View is positioned to
the right of the stackup within the Stackup Editor.

Show / Hide Structure View

£ Polar Speedstack Stack Up Builder.  Stack : Eval Imperialstk  Project : Eval Imperial.sci

File Edit View Tools Units External Utility Help

Esd70D=S0XO=a&=;

o =T =

2Ol E A B

Stack Up Editor | DRC; 4 Controlled Impedance | C1 Resuts |

EXRTEEOEES=swgnl
e s[5l

P
B

777 LT 88

Substrate 1 Height H1 63500
Substrate 1 Dielectric Ertfazo0
Lower Trace Width w7800
Upper Trace Wiidth w2[sEs0
Trace Separation sifgis
Trace Thickness Ti [fa0
Coating Above Substrate (=0 T
Cazting Above Trace 2o
Costing Between Traces cafi0
Cazting Dielectric cefaooo
' Differential Impedance zd[10029
o Target Impedance. [ioom
) Target Tolerance % fem v
|Mis/Thous  [Target Stack Up Thickness = 60.0000  [Stack Up Thickness = 60.8600 [Stack Up Thickness with Soldermask = 62.8600  [V22.09.01 4

Structure View — 3D View

"’d Click the 2D View icon. In 2D view, structures are aligned
with the stackup electrical layers on which they have been

2D View defined — see below.

£ Polar Speedstack Stack Up Builder.  Stack : Eval Imperialstk  Project : Eval Imperial.sci

File Edit View Tools Units External Utility —Help

Eed D=L xO===;

o ==l G2

SOl & i

Stack Up Editer | DRC; 4 Controlled Impedance | C1 Resuts |

XX EENEE @y
e s[5l

g

7777 LT g E

170:75  TargetZdfi: 100
SingleEnded  Differeniial
et ek

20 [WiWZ] zar [WAW2| s1  [WEW2

Substrate 1 Height H1

Substrate 1 Dielectric Er1 [42000
Lower Trace Width wi [7.6500
Upper Trace Width w2 [£.6500
Trace Separation s1[81150
Trace Thickness 1 [i-2000
—————————— Coating Above Subsirate 1 [o000
Coating Above Trace 2 [1:0000
Coating Between Traces (=1
Coating Dielectric CE[2 0000
' Differential Impedance: Zd [10029
o Target Impedance [100.00
M| Target Tolerance % [10.00 v
[Mis/Thous  [Target Stack Up Thickness = 60.0000  |Stack Up Thickness = 60.8600 [Stack Up Thickness with Soldermask = 628600  [V22.09.01 4

Structure View — 2D View
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Click Zoom Extents from the View menu and drag the
stackup so that the stackup and structure view are both
displayed in the Stackup Editor window

Displaying 7 structures on All Layers

Target Zo : 50 Target Zo: 75 Target Zdiff : 100
Single-Ended Single-Ended Differential
Layer 1.8 Layer1, B Layer1.4.8

Zo | WIW2 | Zo |WIW2 | Zdiff | WIMW2

97244 30000
1.4000 1 0.00 e 5.74 s
3.0000
1.4000
3.0000
1.4000
3.0000
6.0000
6.0000
1.4000
12.0000
1.4000
6.0000
6.0000
3.0000
4 1.4000
3.0000
1.4000
3.0000

1.4000

Structures are arranged left to right in ascending order of
Target Impedance, (in the stackup above, 50Q then 75Q
then 100Q) then by Structure Type.

All structures of the same Target Impedance and Structure
Type will be positioned in the same column

In this example there are two 50Q) structures in Column 1,
two 75 Q structures in Column 2 and three 100Q structures
in Column 3

The column header contains the Target Impedance, Structure
Type and the stackup layers containing the structures.

Target Zo : 50 Target Zo: /5 Target Zdiff - 100
Single-Ended Single-Ended Differential

Layer1, & Layer1, & Layer1, 4, 8

Zo [WIW2 Zo0  WIMW2 Zdiff = WIMW2 S1 winwz

The Column Cell displays the structure’s calculated impedance
and Lower / Upper Trace Widths (W1 /W2) and Trace
Separation (S1).

79201 79201

7.8020 ' 7.8020

99.94
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Selecting a structure / stepping through the structures
| an || <Jiofa  s|s]| | Use the Structure Browse Control to select a structure or
step through the structures. In the graphic below the first
structure is displayed.

Structure Browse
Control

Stack Up Editor | DRC:4 Controlled Impedance | C| Resuts |
XN TEEIEE =@
| (o] (1]

Displaying 4 structures on All Layers

TargetZo: 75 Target Zdiff : 100

Single-Ended Differential

Layer1,8 Layer1, 4

Zo |(WIM2 | Zdiff | WIW2 s1

Substrate 1 Height
Substrate 1 Dielectric

Lower Trace Widih
Upper Trace Widih

Trace Separation stf0s12
15875 15875 Trace Thickness 1 [556
Taas - 21990 LS Coating Above Substrate cifEa
Costing Above Trace caf5am
Coating Between Traces =1
Costing Dielectric CErfagoo0
Differential Impedance zd[10029
Target Impedance [looo0
Target Tolerance % [oom

Use the arrow keys to step though the structures.

Selecting structures with the structure view

To select a specific structure within the structure view click
on the structure trace within the column cell. The structure is
selected in the structure view (shown highlighted in blue) and
the stackup and the Controlled Impedance tab.

Stack Lp Editor | DRC: 4 Controlled Impedance | C1 Resuts |
FRRTEEOEL~w@bT
BEEf - B

Displaying 4 structures on All Layers

Target Zo: 75 Target Zdiff : 100
Single-Ended Differential

Layer1.8 Loyer 1. 4

Zo |WIM2 Zdiff | WI1MW2 s1 Wimw2

. 7620 o 16881 o o 16891
17574 - 10029 W—— 206.12 ———

ric
Lower Trace Width
Upper Trace Width
Trace Thickness
Coating Above Substrate
Coating Above Trace
Coating Dielectric

s
18415

Impedance Zo[7574

Target Impedance 75.00
Target Tolerance % 10.00
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Filtering by layer
Speedstack can display all the layers and structures within
the stack or just the structures on a layer of interest.

- .<| < |71 of 4 ,.| ,.| The graphic below shows all layers and structures as

indicated by the Filter by Layer button on the Structure
Filter by Layer button Browse control.

Stack Up Edtor | DRC 4 Contoled Impedance | I Resuls |
X EENDL =@
- 1sf < |1 of 4 >

Displaying 4 structures on All Layers

TargetZo-75  Target Zdiff : 100
Single-Ended Differential

Loyer 1.8 Loyer1.4

Zo |WIMW2 | Zdiff | WIAN2 s1

Subsirate 1 Height
Substrate 1 Dietectric
Lower Trace Width

Upper Trace Width
Trace Separation

15875, 158,75 Trace Thickness
. 21590
184.15 Coating Above Substrate

To display just the layer of interest click the layer in the
stackup and click the Filter by Layer button

Edit View Tools

F777ITgE 200 = 4 EE L
Stack Up Editar | DRC 14 Corirolled impecance | Cl Resuits |
FXHTEENES=w@ng

EEd 70 =slXO == =55

Displaying 2 structures on Layer 1

TargetZo 75 Target Zdiff - 100
Single-Ended  Differenial

Layer 1 Layer 1

Zo |WIW2 @ Zdiff |[WIW2 K& S1

7620

17574 10160 19431

Substrate 1 Height
Substrate 1 Diclectric
_____________ 2 Lower Trace Width
Upper Trace Wicth

i
Coating Above Trace

Coating Between Traces

Coating Dielectric < [4.0000
Differenial lmpedance Zd[10029
Target Impedance 100,00

[ T

[Target Stack Up Thickness = 1524.00 |Stack Up Thickness = 1545.84 |Stack Up Thickness with Soldermask = 1596.64  |v22.09.01

[Microns

Click into an empty area in the Stackup Editor window to
cancel the selection and display the whole stackup.
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Exporting the structure view
From the File menu choose Export and choose Controlled
Impedance Data (image)

Stackup Image

| Controlled Impedance Data (image)

Fampuge | Al

Choose the file format (JPEG, BMP, TIFF, or PNG)/

Specify the image quality if appropriate and the background
and supply the path and filename

Format
{« JPEG " BEMP = TIFF " PNG
Low Quality High Quality

)

[+ ‘white Background

Output Path and Filename

Path 1:4Polar\SpeedstackStacks'M-Board control jpg I

Sa*.reFiIe| Cancel |

The Structure View is exported with the chosen options.

Single-Ended Differential
Lsyer 1, 8 Layer 1, 4

76.20 18591 188.91
17574 ST (10028 loear - 20602 s
2
3

15875 158,75

4 101.28 i 215.90 iy
6
7

10160
8|75.74 i

Using Speedstack Stackup Builder ¢ 19



Grid View

The Grid View window provides a grid-based dialog view of
the stack permitting multiple material properties to be

% edited from a single screen.
: Grid View

Using Grid View

This allows rapid and direct user amending, for example, of
the Finished Thickness / Isolation Distance of multiple
materials without having to open the properties dialog of
each material.

Dielectric Loss Processed
Constant Tangent Thickness

Layer Name, Description, Dielectric Constznt, Loss Tzangent and Processed Thickness columns are editable, other columns are read-only
Processed Thickness = Copper.FinishedThickness, Dielectric IsolationDistance, SolderMask.MaskThickness

Note: the text of the Layer Name, Description, Processed
Thickness, Dielectric Constant and Loss Tangent fields can
be edited. Other fields are read-only.

To edit the text within a field, click on the field to select the
text and amend or supply the new descriptive text for each
material type as required — click Apply to apply the changes.
The new values will be reflected in the Stackup Editor.

Recalculating the impedances

« If a field value is edited that would cause the impedance of
hd a structure to change, Speedstack will request a rebuild to
Rebuild and recalculate recalculate the new impedance.

Stack Up Edior | DRC: 4 Controlled Impedance | CI Resuits |
1 m— GH
XX SCEE B =@
al I« = :=-|:=-I|
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Using the Controlled Impedance window

The Controlled Impedance window displays all the controlled
impedance structures and associated parameters for the
selected layer.

Al | = <W >|>I|

Coated Microstrip 18

Substrate 1 Height H1 |6.3500

Substrate 1 Dilectric Elfa2000
Lower Trace \nfidth W1 (76500
Upper Trace Width W2 |6.6500
Trace Separation 51 18.1150
Trace Thickness T ’T
Coating Above Substrate C1 |1.0000
Coating Above Trace C2 |1.0000
Coating Between Traces C3 |1.0000
Coating Dielectric CEr’W
Differential Impedance Zd |100.29
Target Impedance ’W
Target Tolerance % 'W

Al | ,<| - |W ,| ,,| Step through the structures with the structure browse

control — structures with the impedance within tolerance are
shown in green, structures where the impedance is outside
the specified tolerance range are shown in red.

The Speedstack menu system

The File menu

Stackups that incorporate controlled impedance structures
are saved as projects.

The File menu allows for:

Creation of new stackups and projects
Opening and saving stackups and projects
Searching for stackup and project files
Generating printed output

Importing and exporting existing stackups and
projects and data files from companies providing data
exchange with Speedstack.
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Creating new stackups and projects

New stackups and projects may be created manually or with
the assistance of the Stackup Wizard which steps the user
through the process of choosing the build type (foil, core or
sequential HDI,) specifying the number of layers in the stack,
the stack target thickness, plane and mixed/signal layers,
drilling type (through plated/non-through plated.) and
selection of materials.

Note: The actual Wizard options available will depend on
whether Material Library mode or Virtual Material mode has
been selected.

See Material Library and Virtual Material modes.

File

| New » | Stackup Wizard Ctrl+N
Open Project Crl+0 Empty Stackup  Ctrl+5Shift+M
Open Stack Ctrl+5Shift+ 0
Search Ctrl+F
Save Project Ctrl+5
Save Project As  Ctrl+5Shift+5
Save Stack
Save Stack As
Export »
Import 3
Print 3
Properties Ctrl+1
Recent Files 3
Exit Crl+

Using the Stackup wizard in Material Library mode
Choosing the Stackup wizard in Material Library mode
displays a dialog that allows the user to choose the build
configuration and specify actual materials from the
Speedstack material library
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Stack Up Wizard (Material Library Mode)

General Flanes and Mixed Layers
Layer count ] - ¥ Symmetrical
Flane Layers Mixed Layers
Build Type |Core | 3 :
2
3 3
Materials 4
5
Soldermask |Liq|_|id Photolmageable Mask SM. II' Clear 3 6
Fail | 8 5
Prepreg | Clear Clear Clear
Frepreg |PrePreg 7628 PP/D05 Clear
Drilli
Prepreg | Clear —
Core |FH4 Core CO/006 Clear ¥ Through-Plated [~ Non Through-Plated
Apply Cancel
Stack Up Thickness: 57 48032 (Mils) Stack Up Thickness with Soldermask: 59 44882 (Mils)

Stack Up Wizard (Virtual Matenial Mode)

Stackup Wizard (Material Library mode)

Using the Stackup Wizard in Virtual Material Mode
Choosing the Stackup wizard in Virtual Material mode
displays a dialog that allows the stack designer to build and
experiment with a stackup without requiring real materials to
be entered into a materials library.

Mumber of Layers
Target Stack Up Thickness
Positive Telerance %

Megative Tolerance %

Symmetrical

Plane Layers
]

2
3

€0 ) T

Next >

3 = MNeminal Dielectric Constant 4.2000
62.5521 Neminal Loss Tangent 0.0195
10 Solder Mask Top v v
10 Solder Mask Dielectric Constant 4.0000
Solder Mask Loss Tangent 0.0155
Mixed Layers Solder Mask Thickness 1.0000
1 Preferred Core Thickness JRCARIFERH ~ | |5.5055118110236:
. 2 9527559058 A, ’—;7
3 Copper Thickness 39370078741 0.7000
g 4.921259842¢
ild T 5.905511811(
5 Build Type 7.874015748(
. 11.81102362;
g o = € Core 21.25984251€0P!
39.37007874C ¥
Finish Cancel

Stackup Wizard (Virtual Material Library)

In Virtual Material mode the designer specifies stack
details: the number of layers, overall board thickness, plane
and mixed layers, core or foil build type, solder mask and
copper thickness along with any transmission lines required
on a layer. Supply values for the material and solder mask
thicknesses, dielectric constant and loss tangent to match
the required design values.
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Apply Finishing

L

Reset Finishing

5500551181 R
1.9685039370 A
on5A

Preferred Core Thickness

Note: In Virtual Material mode the designer is working with
finished dimensions so the Apply Finishing and Reset
Finishing toolbar icons are disabled and shown greyed out.

Speedstack will then build a stack to the specified board
thickness by distributing the dielectric regions equally.

Specifying preferred core thickness
If a preferred core thickness is specified Speedstack will
maintain the dielectric thickness for core regions but equally
distribute prepregs to reach the target board thickness.
Values can be selected from a drop-down list and modified
and edited as required.

Opening projects

Stackups that incorporate controlled impedance structures
are saved as projects. Click Open Project and navigate to
the project folder; projects are saved as .sci files. The
stackup along with all its design rule checking settings and
controlled impedance information is loaded.

Saving stackups

Click the Save button to save the stackup. Users are
recommended to save the stackup frequently during the
stackup creation process to avoid data loss; stackups are
saved as .stk files.

Saving projects
Use the Save Projects command to save a stackup along
with its controlled impedance structures.
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Search Existing Stackup Files

Searching for stackups and project files

When creating new stackups and projects it will often be
found convenient and timesaving to reuse an existing stack
or project, modifying as required and the saving as a new
stack or project. From the File menu choose Search and
click Change Folder to navigate to the collection of stacks.

3E Select Search Felder(s) - O *
File Types
Stack [ stk) I
Stack with Controlled Impedance (.sci) 3
Default Path

C:\Program Files (x86)\Polar\Speedstack\Samples

Change Folder

Search Sub Folders v

Apply | Cancel |

2|

Choose from stacks and/or projects (stacks with controlled
impedance); click Apply. The stackups and projects within
the chosen folder structure are displayed.

Supplying search criteria

By default, all stack and project files in the folder are listed.
The search may be refined by specifying layer count and
board thickness.

For example, to display only 8-layer stacks click the Layer
count check box and in the Number of Layers text box
specify 8.

Filter
Layer Count v Mumber Of Layers a
Board Thickness r Minimum Thickness 0 Maximum Thickness 2000
Clear Filter | Filter
Stack Data
Mumber Of Layers Actual Thickness Flanes 0.50z/18microns loz/3Bmicrons Zoz/TOmicrens | File Name

8 4.5 1.8 2.34567 APE17 5ci
2 2,367 1.234567.8 PCi_&_Layer_2_Doublets_w_hatch.
8 3.6 1.8 2,3.4567 Speedstack v20_06 Sample.sci

Similarly, check Board Thickness and specify minimum and
maximum thickness to display only matching stacks.
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Click Clear Filter to restore the display to all stack and

project files.

Cancel

a5 Search Existing Stackup Files - m} x
—Filter
Payex Coty r Mumber Of Layers lg—
Board Thickness r Minimum Thickness |ﬂ Maximum Thickness |D
Clear Filer | Fier |
Mumber Of Layers  + | Actual Thickness | Flanes | 0.50z/18microns | Toz/3Bmicrons | 2Zoz/T0microns | File Name | Fil_+ |
12 53.8 2,571 12345678 Doublet-2 sci cil
12 53.8 2,571 1,2,3,4567.8 Doublet-Simple.sci TilEE
12 53,38 2,57, 11 1,2,3,4567.8 FlexRigid_12Layer_Steplsc Cil
12 28,1456 4679 Qualcomm v14 test.sci CAl
10 [~ 3568 1,2,9.10 345678 10-layer-segquentiallam-mil-i |
10 £2.9724) 3,568 1,2,9,10 345678 10-layer-sequentiallam-mm-i C:\|
10 42 5187 3,568 1.2,3,4567.8 AP523_HDI.sci cul
10 60.8582 3,568 1.2.9.10 3456738 fred sci cu
10 60.8582 3,568 1.2.9.10 345678 HOI_PressCycles_mm_CuFi C3l
10 £0.8582 3568 1.2.9.10 3456738 testsci cul
& 646 4.5 1.8 234567 E-Layer-sample sci Al
] 826772 3.6 2,367 AP528-real sci cil
o £ RO0A T C NDETID VKARA Al 4
« | _lJ
Target Value | Upper Signal Layer | Single Ended | Differential | Coplanar | Broadside | Trace Width | Trace Thickness
» |50 1 v r r [l 12 0.7087
100 1 - v - r 8 0.7087
50 4 v r r - 3 1378
100 4 r v r r 4 1378
50 7 v r r r [ 1378
100 7 r ICd r r 4 1378
50 10 ¥ r I r 12 0.7087
100 10 r Icd r r 3 0.7087

Lead File

7|

Step through the resulting list, choose the matching stack or
project and click Load File.
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Importing Stackup information
Speedstack incorporates the facility to read in files in:

IPC-2581 Rev B format
Ucamco Job File format
XML STKX and SSX formats
Zuken CR-8000 format
Ucamco Integr8tor and Ucam format

Import ]

IPC-2581 Rev B
Speedstack can import Stackup and impedance structure data
using the IPC-2581 Rev B XML file format. Use the IPC-2581
Rev B command to import IPC-2581 Rev B (XML ) files using

the interactive interface. The stack shown below displays
both stackup material and structure information. The foil,

| IPC-2581RevB

| Ucamco Job File L | lrmport
XKML File (.stha) Clear Rules
Zuken CR-8000
Ucameco Integrdtor and Ucam (.s5x)

prepreg, core and solder mask material data grid colours are
determined by the Speedstack Configuration,

Import [PC-2581 Rev B

IPC-2581 File

—Software Package (that generated the file)

Filename
Revision
Units

IC:\Frogmm Files (x86)\PolarSpeedstack’\Samples \AP517xml
]
INCH

Name
Revision
Vendor

Palar Instruments Lid Speedstack
17.1.21725
Polar Instruments Ltd

Import
_ Concel |

Notes: 0|

~Import Options
[V Assign IPC-2581 as Material Supplier

[¥ Assign IPC-2581 Layer Namels) as Material Type

[¥ Calculate Upper Trace Widths (W2) using Default Eich Factor (2.0004m)

Assign imported Loss Tangent to Notes field - Mane -

—Display Options
£ All (Stack Up and Structure Data)
% Stack Up Dats only
" Structure Data only

]

¢ )1PC-2581

CONSORTIUM

To edit the data displayed below select the row, right-click menu and choose the

appropriate function

Speedstack

Number Speciication Name

Layer Name

Layer
Function iz

Sequence

Material Description

Resin
Content

Dielectric
Constant

Loss
Tangent

STACKUP THICKNESS
LEGEND_TOP

LEGEND_TOP_SPEC

LEGEND
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The dialog above provides user guidance through the import
process.

The IPC-2581 File Information pane displays useful file data
including the file name, revision and units. IPC-2581 supports
inches, millimetres and microns.

The Software Package pane details the application (including
the revision and vendor) that generated the IPC-2581 file.

Setting import options
Set the import options to control how the IPC-2581 data is
allocated in Speedstack:

|Import Cpticns
v Assign IPC-2581 as Material Supplier
[v Assign IPC-2581 Layer Mame(s) as Material Type
v Calculate Upper Trace Widths (W2) using Default Etch Factor (3.000pm)

The material type can optionally be derived from the layer
name and the upper trace width can be derived from the
given trace width and default etch factor.

Setting display options
From the Display Options dialog pane choose to display all
data or stackup or structure data only

hsplay Options

" Al (Stack Up and Structure Data)
{* Stack Up Data only
" Structure Data only

Sorting layer information

The stackup imported from the IPC-2581 file is shown in data
grid form. Data can be sorted by column — click on each
column header to sort in ascending or descending order by
sequence, layer number, layer name, etc.

Assigning layer functions

During the import process it may be necessary to consult the
board authority or design documentation to ascertain the
function of each layer, signal, plane, dielectric, core, etc.; the
Layer Function determines the layer / material type.

Right click each layer and use the Set Layer Function to
assign the layer its designated function.
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| Set Layer Function to L SIGNAL

Set Dielectric Constant / Loss Tangent values PLAME
MIXED

DIELCORE
DIELPREG
DIELADHW

SOLDERMASK

Setting loss values

Dielectric constant and loss tangent values can be set for
each layer; select the layer (it will highlight in blue) and then
right click the layer, the dialog should show the current
values; enter each value and click Apply.

Set Dielectric Constant / Loss Tangent Values n

Dielectric Constant |4_2||][| Apply
Loss Tangent Iuﬂaﬂ Cancel

With all the editing completed, click Import to bring the file
into the Speedstack Editor.

g 4.000
LEGEND_TOP 2.000

4.200
SOLDERMASK_TOP

4 )
i 1.400 AL

DIELECTRIC 3.400 -
DIELECTRIC. 2 3.400
4200
2100 e
L2/ DIELECTRIC_3/L3 8.000 s
1.400 Sl

DIELECTRIC_4 3.600 4200
DIELECTRIC_5 3.600
4200
1.400
L4/ CTRIC_6/L5 1233 £ 4.200

DIELEC - 3.600 4200

DIELECTRIC 8 3.600
4.200
1.400 : ! >
L6/ DIELECTRIC_9/L7 4 4200

DIELECTRIC_10
4.000
DIELECTRIC_11
L8 1.400
SOLDERMASK_TOP

The imported stack can be processed using the Speedstack
editing functions.
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Ucamco Job Files

The .Job file format contains a varying amount of stackup
information depending upon the how the system has been
configured by the Ucam user.

Speedstack will import files from both Ucam and Integr8tor.

Choose File|Import|Ucamco Job File|lmport and select the
.job file and click Open. The Ucamco .Job File Import dialog
is displayed:

Ucamco Job File Import

Please map each .Job layer / drill class assignment to the equivalent
Speedstack matenal type:

1. Select a class from the right-most list
2. Click the button to nominate the matenal / layer type

~.Job Extra Assignments
Solder Mask | | |
Idents | |
Peclables | | |
—Job Layer Assignmenis
Signal | |
Mixed | |
rover_| | -]
Hatched | | |
Job layer classes that are unassigned will be imported as Signal
~Job Drill Assignments
oo || =] [ <]
Flated | | |production
Nonplated | | |
Reset pply | Cancel

The .Job file contains user-definable material / drill class
definitions so it will be necessary to map these definitions to
the various Speedstack material and drill types.
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To apply assignments select the class from the drop down
list then click the associated button to nominate the material
or layer type. Click Apply.

Note: Where stack data are not included in the .job file it will
be necessary to include or update properties (for example,
solder mask properties such as thickness and dielectric
constant) before adding impedance structures.

Integr8torJob files
When Integr8tor files are imported the Ucamco .Job File
Import dialog is displayed as shown below.

Ucamco Job File Import

Please map each .Job layer / drill class assignment to the equivalent
Speedstack matenal type:

1. Select a class from the right-most list
2. Click the button to nominate the matenal / layer type

.Job Extra Assignmenis
Solder Mask | | ~| [=m -
l[dents - ilk:
= | J ::::Idem'lask
Peelables | | |
.Job Layer Assignmenis
Signal | j IE j
Mizxed | j inner |
Power | j
Hatched | | |

Aob layer classes that are unassigned will be imported as Signal

_Job Drill Assignmenis

Laser | ﬂ -
Flated | | [rout

Monplated | j

Feset Apply | Cancel

Select the assignment options as described above and click
Apply. Click Reset to clear the assignments.
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Clear Rules

The Clear Rules command will delete all previously learned
rules.

XML files
Choose File|lmport| XML File (.stkx), select the .stkx file for
import and click Open.

Zuken CR-8000
Choose File|lmport|Zuken CR-8000 format, select the .stkx
file for import and click Open.

Ucamco Integr8tor and Ucam format (.ssx)
Choose File|lmport|Ucamco Integr8tor and Ucam format,
select the .ssx file for import and click Open.

Converting imported electrical layers to cores

When importing stackup data from some CAD / CAM
systems only the electrical layers are defined. In this case
copper layers may appear adjacent each other in the
Stackup Editor. Speedstack allows the user to quickly
convert two adjacent electrical layers into Core or Flexible
Core materials using the Convert to Core function.

Select the adjacent layers within the stack — Speedstack
adds the Convert to Core command to the Edit menu.

| Convert To Core » | Core

Flexible Core

Select the Core type — Speedstack displays the core library;
select the core — the layers are converted into the selected
core; note that when converting two foils to a single core
material the lower copper trace will be shown inverted.

Consider the stack below. Using ‘Convert to Core’ alongside
other Speedstack editing functions, an electrical layer only
stackup can be converted into a useful fully defined stackup
containing full definitions of foils, prepreg and core materials.

0.0000
0.0000
0.0000
0.0000

0.0000
0.0000

0.0000
0.0000

Add a prepreg layer between layers 1 and 2.
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Repeat for layers 3 and 4, 5 and 6 and 7 and 8.

Select layers 2 and 3 and convert to a core.

Repeat for layers 4 and 5, 6and 7.

The resulting stack should appear similar to the stack below.

Copper Foil 1.4000
PrePreg 1080 4.200/0.0195 ;3.0000
1.4000

FR4 Core 4.200/0.0195 11 8.0000
| 1.4000

PrePreg 1080 4.200/0.0195 ' . 3.0000

0.7000
Flex Core 4.200/0.0195 L.14.0000
0.7000

PrePreg 1080 4.200/0.0195 3.0000
1] 1.4000

FR4 Core 4.200/0.0195 | 8.0000
1.4000

PrePreg 1080 4.200/0.0195 3.0000

Copper Foil 1.4000

Exporting stackup information

Speedstack incorporates the facility to export stack data to
external programs. From the File menu choose Export and
choose the format from the Export sub-menu.

Coupon Generator (CGen)
CITS File

DXF

Gerber

Stackup lmage

Controlled Impedance Data (image)

Cadence Allegro k
C5V..,

IPC-2581 Rev B

Mentor Graphics k
XML File (.sthz) 3
Zuken CR-2000 3
Zuken DFM Centre 3
Ucamece Integr@tor and Ucam (issx) 3

Support Informaticn

Exporting to Coupon Generator (CGen)

Stacks may be exported to Polar CGen Coupon Generator
(the stack will be exported via the Speedstack Clipboard) for
processing into test coupons. Click Export To | Coupon
Generator (CGen) — open CGen and from the File menu,
import the Speedstack Clipboard (see CGen User Guide.)
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Export CITS File

Use the Export CITS File to create test files for Polar CITS
controlled impedance test systems. Supply board details via
the Board Details dialog.

Customer |Green Park Ccts
Board Type ‘Main Controller
Part Number [MC1234
Revision Number Rev 103

MNotes

Make File | Cancel |

Click Make File to generate .cif files (CITS test files).

Generating printed output

Speedstack can generate printed output in DXF, Gerber,
CSV and XML, as well as graphic image formats.

DXF, Gerber, CSV and XML files
Choose DXF..., Gerber..., CSV... or XML File and navigate
to a suitable folder, name the file as appropriate and save.

Stackup images
Speedstack can export stackup images in JPEG, BMP, TIFF
and PNG file formats. Select from 2D or 3D displays.

&= Export StackUp Image
Output Selection Format
& Flex-Rigid Overview (Al Stacks)  JPEG (" BMP £ TIFF £ PNG
(" Current Stack Shown in Editor
Low Quality High Quality
Made J
& 20 ~ 3D P T T 1[)I[):g
Output Path and Filename
Path ||
Save File | Cancel |

Use the Low Quality — High Quality slider to specify JPG
quality. Choose the Flex-Rigid Overview (All Stacks) to
display the master stack and associated sub-stacks or just
the Current Stack Shown in Editor. Specify the destination
folder and file name and save.
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Controlled Impedance Data (image)

See Structure View — Exporting the structure view

Cadence Allegro (IPC-2581 Rev B)

Speedstack supports reading/writing in IPC-2581 Rev B
formatted data. Choose the Cadence Allegro/IPC-2581 Rev
B option and supply the file name and destination folder: the
Export IPC-2581 Rev B dialog is displayed.

o x

IPC-2581

—IPC-2581 File —Software Package (that generated the file) |
Filename [C:\Program Files (x86}\Polar\Speedstack \Samples\Eval Imperial xml Name [Speedstack
Revisicn B Revision 122.7.20
Units Vendor
i INCH Polar Instruments Lid — CONSORTIUM
—Export Options —Display Options
¥ Export Target Impedance as the IPC-2581 Impedance data ' All (Stack Up and Structure Data)
" Export Caleulated Impedance as the IPC-2581 Impedance data " Stack Up Data only
Assign resin rich Dielectric Constant value - [35000 Apply " Structure Data only
To edit the data displayed below select the row, right-click menu and choose the
appropriate function

Speedstack i

SOLDERMASK_TOP

Resin
Content

1 | Liquid Photolmageable Mask

Choosing export options
Use the dialog to modify, if necessary, the file information
details and choose the export options.

— Export Options
% Export Target Impedance as the IPC-2581 Impedance data
{" Export Calculated Impedance as the IPC-2581 Impedance data

Assign resin rich Dielectric Constant value : IE.BD[H]

ﬂ'ml:-"

Specify whether Speedstack’s target or calculated
impedance is to be used to populate the IPC-2581 file.

Supply a value for dielectric constant and click Apply.
Click Export.
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Mentor Graphics

Choose the Mentor Graphics option, choose the file version
and supply the file name and destination folder. (Note the
.ssx file extension.)

Zuken CR-8000/DFM Centre

The Zuken CR-8000 and DFM Center PCB manufacturing
pre-processing and CAM systems integrate directly with
Polar Instruments’ Speedstack PCB system. Choose the file
version, navigate to a suitable folder and save the file (XML
format).

Ucamco Integr8tor and Ucam

Choose the Ucamco Integr8tor and Ucam option and file
version and supply the file name and destination folder.
(Note the .ssx file extension.)

Assigning properties to projects and stackups

The stack file Properties dialog may be displayed
automatically each time a new stackup is created (see
Tools|Options|General) and provides a range of text fields for
descriptive information, stackup name, stackup author,
company name, file create date, version, etc.

From the File menu choose the Properties command to add
descriptive text fields — information contained in the
Properties dialog will be displayed on stackup printouts.

To display the Properties dialog each time a new stackup or
project is created, from the Tools menu choose Options and
click the check box below on the General tab

|W Display File Properties Dialog for Mew Stackups and Projects |

Backing up stackups and libraries

It is strongly recommended that stackup files (assigned the
.stk extension), project files (assigned the .sci extension) and
library files (assigned the .mlbx extension) be backed up to a
secure location.

Opening recent files
Click Recent Files to select and open a file from the most
recently used file list.
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The Edit menu

Edit
| Add > Foil
Add Cl Structure Core
Delete Del RCC
Swap Ins Mon Copper Core
Prepre
Copy Ctrl+C .
Solder Mask
Paste Abowve Ctrl+V
Paste Below Crl+Shift+V Flex Core
i ) Bondply
Properties Ctrl+Shift+I
Adhesive
Set To Signal Coverlay
Set To Plane Ident
Set To Mixed Peelable
Set To Hatched
Dl

Hatch Profile

Mowve Up Ctrl+Up
Mowe Down Ctrl+Diown
FlexMav Mowve Up Ctrl+5Shift+Up

FlexMav Mowve Down Ctrl+Shift+ Down

Undo Ctrl+Z

Redo Ctrl+5Shift+Z

Set Stack Default Colours

Reset All NVDP Attributes

The Edit menu contains the commands necessary to create
and modify board stackups. The designer or fabricator works
within the free-form stackup build and construction window
and in Materials Library mode adds layers of foil, core,
prepreg, etc., from the materials library.

Material Library and Virtual Material modes

Speedstack provides the option to switch easily between
Material Library and Virtual Material modes allowing the
stack designer to build and experiment with stackups (for
example, to examine the effects on impedance structures of
different trace widths or dielectric heights) without requiring
real materials to be entered into a materials library.

Controlled impedance structures can be added to the stack.
When Add CI Structure is selected Speedstack switches to

the Controlled Impedance pane and allows the designer to

add structures appropriate for the selected layer. The items
that can be edited depend upon whether the StackupEditor
or Controlled Impedance tab is selected.
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Layers can be changed to signal, plane, mixed or hatched,
moved up or down or copied and pasted, or assigned
properties as required.

Use the Delete and Swap commands to delete materials or
swap materials from the Materials Library.

The View menu

Use the View menu to change the Stack Editor display whilst
adding or removing materials or modifying or refining the

stack.
View

20 View Ctrl+Shift+2
3D View Ctrl+Shift+ 3
Zoom In Ctrl++
Zoom Cut Ctrl+-
Zoom Bxtents Ctrl+0
Default View Ctrl+9
Open Mavigator F4

Restore Mavigator
Proportional Stack Viewer  F3

Open Material Library  Ctrl+L

Open User AppData Folder

The View menu allows Speedstack to display the stackup in
a 2-dimensional or 3-dimensional aspect.

Zoom In to get a close-up view of the stack or Zoom Out to
see more of the stack at a reduced size. Zoom Extents will
adjust the zoom level to display the whole stack.

Hint: Click the mouse centre button/wheel to Zoom Extents.

With the Flex / HDI option installed choose the Open
Navigator command to view the master and associated sub-
stacks. The floating Navigator window may get covered by
other application windows when switching between
programs; — use the Find Navigator to display a reduced
Navigator window at the top left screen corner.

Proportional Stack Viewer

Use the Proportional Stack Viewer to display the stack
currently selected in the Stack Editor so the material
thicknesses are shown proportional to each other. This can
be informative as a visual aid, especially when considering
the dielectric thicknesses between electrical layers.
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The Tools menu
Use the Tools menu to configure Speedstack.

Tools

Options Ctrl+Shift+ 0
Manufacturing Constraints Ctrl+ M
Set Finishing Method Ctrl+M

Set Target Stackup Thickness / Enable Finishing  Ctrl+T

Virtual Matenal Mode Ctrl+Shift+Y

Language 3

The Options command displays the configuration options,
manufacturing constraints, target stack thickness and
finishing options. See Configuring Speedstack for details.

The Units menu

Use the Units menu to select the stackup units, Microns,
Mils/Thous, Millimetres or Inches

Units

Microns Shift+F1

Mils/Thous  Shift+F2

Millimetres  Shift+F3
Inches Shift+F4

External Utility

Use the External Utility commands to start a program
external to Speedstack. The programs are defined in the
Configuration Options|External Ulilities dialog.

The Help menu

Use the Help menu commands to access the User Guide for
the current Speedstack version or tutorials relating to
common Speedstack operations.

Review the licensing terms with the License and About
Speedstack commands.
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Configuring Speedstack

When first run, the Speedstack environment is initialised to
its factory settings. These may require adjustment before
outputting a finished stackup and/or project. Default settings
are changed using Tools|Options, Tools|Manufacturing
Constraints and Tool|Set Finishing Options.

Environment and default settings

From the Tools menu choose the Options command to
display the Configurations Options dialog.

General Options

Default Stack Up View Display Data
o0 Dizplay Fields 1 and 2 are reserved for Layer Numbers and Layer Types
|Display Field 3 | Display Field 4 | |Display Field 5
S |Descriptiu:un hd |N.:.ne j |Isu:u|aﬂun Distance hd
Units
" Mils/Thous {+ Microns " Millimetres " Inches
[+ Open last used file on application start up
I+ Display File Properties Dialog for Mew Stackups and Projects

Choose the Default Stackup View — 2D or 3D; select the data
fields that will appear alongside the stack in the Stack Editor

|Di5p|ﬂ",’ Field 3 |Disp::|a|~,.r Field 4 | |Displa|~,.r Field 5
|Descriptil:un - |N|:|ne j |Base Thickness -
Supplier Finished Thickness
Supplier Descrintion Base Thickness Copper Coverage
E&b Finished Thickness lzolation Distance

Copper Coverage Dielectric Constant
%;zk humber Isolation Distance Resin Cantert

Dielectric Constant Tg

Resin Contert Colour

Tg ¥ | [Data Filenames W

Choose the stackup units; Speedstack supports Mils/Thou,
Microns, Millimetres and Inches. Click the Open last used...
check box to specify that Speedstack should open the last
used file on start-up.

Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Distance for dielectric layers.
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Clicking the Display File Properties Dialog... will display the
File Properties Dialog each time a new stackup or project is
initiated.

Structure Defaults

Structures Board Thickness
Default Snap To

Lower Trace Width {\W/1) [250.00 [5.00 Erznfll s s 1600.00
Upper Trace Width (2) [247.00 [5.00 Plus % 10
Lower Ground Strip Width (G1)  [2500.00 [5.00 Minus = |10
Upper Ground Strip Width (G2) |24?5.DD |E-.I}D Drilling
Trace Separation (S1) |250.00 |5.00
Ground Strip Separation (D) |250.00 |5.00 Minimum Hele Size 500.00
Trace Offset (01) j0.00 |5.00

Separation Region Dielectnic (REr)  |4.0000

When adding new controlled impedance structures default
values (shown above in microns) are entered for the
structure parameters. Use the Structure Defaults tab to
specify the default structure parameters, for example trace
widths and separations board thickness and minimum drill
hole size.

The Snap To value may be set for each parameter. Note that
although all Snap To values shown above are set to 5.00
microns, each parameter value can be set individually.

Licensing
Use the Licensing tab to tick the purchased licensing options.

(" Speedstack License Only

(" Enable Speedstack PCE and Si2000m link
{* Enable Speedstack Si and Si3000e link

License Ophons:

v Speedstack Flex / HDI License (SF)

Iv Hatch Mode License (XFE)

V¥ Speedstack Import / Export License (10)
v Speedstack ! Ucamco Integration License (UCAMCO)

To activate the Speedstack controlled impedance function,
ensure that the Si8000 or Si9000 is installed; from the
Licensing tab choose either Use Polar Si8000m License or
Use Polar Si9000e License option as appropriate.
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Choosing default file locations

Select default matenials library file
C:\Program Files (x8E)\Polar\SpeedstackiSamples'\Speedstack Metric mibx Browse. ..

Select default folder to store Stack Up (" stk) files
C:\Program Files (x86)\Polar\SpeedstackiSamples Browse...

Select default folder to store Material Filter [ mlf) files

Select default folder to store custom print settings (~.prs) files
C:\Program Files (x86)\Polar\SpeedstackiSamplesiFilters Browse...

C:\Program Files (x86)\Polar\Speedstack\Samples'Filters Browse...

e

Use this dialog to choose which materials library the
Speedstack uses at start-up. Click the File Locations tab and
use the Browse button to navigate to the library (.mlbx) file.

The File Locations tab provides for default locations for
stackup or project files, Material Filter (.mlf) files and custom
print settings (.prs) files. Browse to the target folders and
click OK to confirm (create new folders if necessary).

Specifying goal seeking parameters
Click the Goal Seeking tab to specify the default values for
trace widths and separations used during goal seeking.

W1 Maximum Trace Width

1 Minimum Trace \idth

51 Maximum Trace Separation
51 Minimum Trace Separation
01 Ma:xamum Trace Separation
D1 Minimum Trace Separation
H Maximum Value

H Minimum Value

W Convergence II}EI}7
W Maximum lterations lﬂ}i
o000
12500
o000
12500
o000
sono

During goal seeking the calculated value for impedance will
progressively converge upon the target value.

In the Convergence text box specify the difference between
the target impedance and the actual impedance at which
goal seeking will terminate.

Use the Maximum lterations text box to limit the number of
iterations used during goal seeking.
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Setting user defaults
Information added to the User tab will be transferred to the
File Properties dialog and used on printouts

Enter information as appropriate into the associated text
fields; optionally, select a graphic for use as the company
logo — optimum graphic size is 180 x 32 pixels — the
graphic is printed in the preview box.

Default User Information

Company Logo

Used to fill in stack property fields when starting a new stack file.

|D:'-.Pu:ular'-.Graphics'-.F'ular Logos“MewPaolarl Browse...

Recommended size for the logo is 180 pixels in width.

Large images will be scaled down.

Author |J Travers
Company |>WZ Com
Department |Engineering
Site [North Bridge|

- T

Specifying default CITS test file parameters
Speedstack allows the user to generate a CITS test file for
each controlled impedance structure within the stack.

Select the CITS Test tab to specify the default test
parameters to be used when initiating a CITS test file.

Horizontal Units Channels
Units |Inches j Single Ended |Channe| 1 ﬂ
Test From |3— Differential |G'IEI|'II'IE| 1&2 ﬂ
Test To I?—
Test Method |Absolute -]
Vertical Scale |1E' j
Diiferential Unbalanced Warning Level |15

Each test file contains the test parameters (test units,
distance, number of channels, etc.) to be used when testing
the stack’s controlled impedance structures using a Polar
CITS (Controlled Impedance Test System). The test file may
be edited via the Edit Test Data dialog.

CITS test methods
Note that the preferred test method is Absolute

The Average method should only be used with the express
approval of the specifying authority.

See Polar Application Note AP8515 — CITS Test Methods
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Choosing background and stackup layer colours
Choose the Colours tab to change stackup component
colours from their factory defaults.

|A|:.|hesi'n.res j
Base Colour

Background

Bondphy

Coppers

Care Diglectrics
Coverays

Dielectrics

Flexi core

Highlighted Material
|derts ¢ Documerntation
Lager Drills NTP

Laser Drlls TP
Mechanical Drills N TP
Mechanical Drills TP
Peelables hd

Change

Reset All

il

i

Click Reset All to return to cancel changes.

Miscellaneous Options

Mumber of Undo Levels 5
Maximum Laser Drilled Layers 5

[w Drill Validation Check

This option prevents invalid drills from being added to the stack up. For instance, a drill that starts from the lower copper side of core
materials. Uncheck this option if you use a dnlling technology that permits drills to be placed between electrical layers which are not
typically supparted by conventional mechanical and laser drills

Use the Miscellaneous tab to:

e Specify the maximum number of undo for editing
actions

e Choose the maximum number of layers a laser drill
can span. (Exceeding this number will produce a Dirill
not Valid error message.)

e Apply Drill Validation Check — preventing invalid drills
being added to the stackup. Unchecking this option
will disable the Speedstack invalid drills check in order
to support the Ormet® Z-Axis Interconnect* technology

* Ormet® Z-Axis Interconnect is a method of connecting
two PCB boards using a conductive paste filled into the
vias of a drilled prepreg.)
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Hatch Defaults

Hatch Fitch |433_53
Hatch Width |'|2?.DD
Copper Percentage ||:* i

Use the Hatch Defaults tab to specify the default values for
Hatch Pitch and Width and Copper Percentage when setting
a plane to hatched (see Hatch Configuration.)

Rebuild and Calculate Structures

These options control the way that the Controlled Impedance structure parameters are
updated from the stack up. When new structures are added or the Rebuild and
Calculate option is selected, Speedstack will update all structures based on the
selections below. Default : All options selected.

W Substrate Height (H m)

[ Substrate Dielectric (Er n)

[+ Trace Thickness (T1)

[+ Coating Above Substrate (C1)
[+ Coating Dielectric (CEr)

The Rebuild and Calculate Structures tab allows the
designer to specify which parameters are included when
controlled impedance structures are recalculated after
modifying the stack.

Manufacturing Constraints

The Manufacturing Constraints options consist of a collection
of manufacturing capabilities, minimum gaps and trace
widths, buried and blind via and trace aspect ratios, drill
aspect ratios, etc. that can be applied during design rule
checking (see the DRC tab detail below.)

v Manufacturing Tests (Tools | Manufacturing Constraints)

Active Constraint : Polar Microns

[v Min. Trace Width ¥ Min. Gap Width
Aspect Ratios

[+ Mechanical Drill I+ Buried Laser Microvia
I+ Blind Laser Microvia v Trace

[+ Fesin Starvation

They will normally refer to differing levels of technology
offered by one or more PCB manufacturers for a range of
prices. The required information (shown in the example
below) can normally be obtained from the manufacturer.
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Manufacturing Constraints

Active Constraint : Polar Microns

Manufacturers Name Blind Laser ViaA. R.| Buried Laser ViaA. | Mechanical Drill A. R. Minimum Trace Width

Minimum Gap Trace A R. Units

Polar Mils . . . Mils
Polar Millimetres . . . Millimetres
Polar Inches . . . 1 1 Inches

Instructions: Double-Click the Data Grid row to edit, add or delete a constraint

Highlight and Set Active Constraint
’7 Highlight Set |

Close

Click the Highlight button to highlight the current active
constraint; to apply a new constraint select the constraint row
and click Set.

Editing and adding constraints
To modify a constraint or add a new constraint, double click
within the constraint row to be edited.
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Edit Constraints

LInits

" Mils {* Microns

(" Inches " Millimetres
Option Mame |F‘|:|Iar Microns
Minimum Gap |?5
Minimum Trace Width |75
Mechanical Drill A.R. 8.5

Blind Via A.R. 05

Buried Via AR. 05
Trace A.R. 1

1of 4 = ==
Add | | Done | Cancel

Instructions
Add: Press Add, which will add a new blank constraint. Motice the
'n of n' record number will increase. Now key in the constraint
details and select Done.
Delete: Press Delete to remove the existing constraint. Motice the
'n of n' record number will reduce. Then select Done to close the
dialog.
Edit: Edit the existing constraint and select Done to close the
dialog.

Modify each setting as required; click Done to confirm the
settings and close the dialog.

To add a new constraint click the Add button, fill in the
settings fields and click Done to finish. The new constraint
will be added to the table of current constraints. Click the
Delete button to remove the constraint from the list.
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Set Target Stackup Thickness/Enable Finishing

Set the Target Stackup Thickness and tolerances via the
dialog below.

Target Stack Up Thickness / Enable Finishing

Target Stack Up Thickness &0.0000 (Mils)
Tolerance

* Percent ™ Absclute

Positive Tolerance + 100 i
Megative Tolerance - 100 i

Enzble Prepreg Finishing ~
Ensble Copper Finishing [

Apply | Cancel |

Tolerance may be set in terms of percentage or absolute
values:

Tolerance

{" Percent {+ Absolute

Positive Tolerance + &.0000 (Mils)
Megative Tolerance - &.0000 (Mils)

Note that positive and negative tolerance values can be set
independently. The values should reflect the currently
selected units.

To enable prepreg and/or copper finishing tick the associated
check boxes. Click Apply.

Note: Unchecking the Enable Finishing options disables the
Apply and Reset Finishing buttons. Note that these buttons
are only available in Materials Library Mode — they are
disabled in Virtual Material Mode.
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Finishing Options

From the Tools menu choose the Set Finishing Method
command to display the set finishing corrections dialog.
Speedstack offers two methods: Copper Coverage Method
and Simple Percentage Method.

Uz

E Set Finishing Method X

Copper Coverage Method Simple Percentage Method

Copper Coverage Method Currently
Selected

i

Each method requires that the amount of copper to be added
where plating is required be set. In addition, where the
Excess Resin design rule check is used the minimum
acceptable value must be set.

Simple Percentage Method

Use the Simple Percentage Method to set the percentage of
prepreg base height, which will be used to determine the
isolation distance. The percentage is set for each electrical
layer type pair.

Specify the IPC-6011 Copper Finishing Class and plating
thickness. Click Edit to specify the Class name and value

£i= Percentage Prepreg Corrections

Prepreg
Set Finished Thicknesses of Prepreg materials (% of base material) when
prepreg is pressed between

Signal and Signal layers [poo0 =
Signal and Mixed layers [sso0 %
Signal and Plane layers E—.?
Mixed and Mixed layers E—.?
Mixed and Plane layers [fzo0 =%
Plane and Plane layers [500 %

Copper Finishing

Enter values of thickness according to preference. The selected value will be
the one added to the base thickness of copper layers when plating

1D | Class Name Value | Active |~ Edit
1 0.7000 Yes =
2 Class?2 0.7000

3 Class3 0.7000

4 Class4 0.7000

5 Classb 0.0000 .

Excess Resin Test

Minimum Excess Resin 15 %
coes

Click Set to activate the class.

Copper Coverage method
The Copper Coverage method allows the user to specify the
amount of copper that will be embedded into the prepreg.

This can be set as a single value for each electrical layer
type. Alternatively the amount of copper embedded will be
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calculated on an electrical layer by layer basis dependent
upon the copper coverage for the layer set in the properties
window. The greater the copper coverage the smaller the
amount of copper that is embedded.

Specify the IPC-6011 Class and plating thickness.

ﬁg Copper Coverage Based Prepreg Corrections >

Percentage Copper To Be Embedded in Prepreg

{* Set by Layer type

Signal Layer % |75
Mixed Layer % 15
Plane Layer % |5

{" Proportional to Coverage

Copper Finishing

Enter values of thickness according to preference. The selected value will be
the one added to the base thickness of copper layers when plating.

Clazs Name Value Selection
|Class 1 18.0000 v
|Class 2 |18.0000 .
|Class 3 18.0000 .
|Class 4 18.0000 .

Excess Heszin Test

Minimum Excess Resin % |15

Apply | Cancel |

Note: The two methods of finishing are not compatible with
each other. The Copper Coverage method requires that the
finished thickness of prepregs be entered in the library; that
value stays locked in the stack unless the Simple Percentage
method is set up; if Reset Finishing is then clicked the
finished thickness reverts to the base thickness.

Virtual Material mode
The Virtual Material Mode command toggles between Virtual
Material and Material Library modes.

Note: Switching to Virtual Material Mode disables the Apply
and Reset Finishing buttons.
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Note: Virtual Material mode and the Simple Percentage
method of finishing are not compatible. Speedstack displays
the message below if the two are selected simultaneously.

Speedstack >

"-.I The Simple Percentage Method of finishing is not supported when
W' Speedstack is in Virtual Material Mode. Please use the Tools | Set
Finishing Method and select Copper Coverage Method.

oK

Working with external utilities

Speedstack can call an external program / utility / script via
the External Utilities menu options. The menu items are
configured via Configuration Options|External Utilities.

Choose |  Clear |
Choose |  Clear |
Choose |  Clear |
Choose |  Clear |
Choose |  Clear |

To specify a program click Choose and navigate to the
program and click Open. The program will be added to the
External Utility menu.
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The Speedstack toolbar

The Speedstack toolbar comprises shortcut links to the most
popular commands.

EEATOSEIXO==S=rRE /777 1T E200 = A EE

7=

Note: toolbar buttons will be enabled/disabled depending on
whether Speedstack is performing stack editing or controlled
impedance calculations. Pause the mouse over each tool
button to display the tool’s screen tip

File operations

L M

=

M

¥\

Create new stackup

Library mode

Virtual Material mode

Stackup Wizard

Stack building operations

[

Symmetrical Mode off

Symmetrical Mode on

Mirroring Mode

Add layer to the stackup

Click to select the layer type. The list of layer types is
displayed in the associated sub-menu.

Layers available include:

Foll Add foil layer to the stackup
Core Add core layer

RCC Add resin coated copper layer
Non-Copper Core Add non-copper core
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Prepreg Add prepreg layer

Soldermask Add solder mask
Flexible core Add flexible core layer
Bondply Add bond ply adhesive
Adhesive Add Adhesive
Coverlay Add coverlay layer
Ident Add screened ident layer
Peelable Add peelable mask

j[f: Add mechanical/laser drill between layers

Editing the stackup
x Delete selected stackup material or drill

@ Swap selected material

Note: the Copy and Paste buttons below are only enabled for
the Stack Editor and DRC tabs — they are disabled for the
Controlled Impedance and Cl Results tabs.

Copying and pasting materials

l

Copy material of the selected layer

L

Paste material above selected layer

L
:“% Paste material below selected layer

'Eu;'ff‘l Copy material properties

.{2,55 Paste material properties

Changing plane types

Set the selected electrical layer as a signal
layer

| [

Set the selected electrical layer as a plane
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i‘ Set the selected electrical layer as a mixed
signal/plane layer

? Set the selected electrical layer as a hatched
plane

Note: the Move Selected Layer buttons below are only
enabled for the Stack Editor and DRC tabs — they are
unavailable for the Stackup Editor in Grid View and disabled
for the Controlled Impedance and Cl Results tabs.

l Move selected layer up one layer

T Move selected layer down one layer

? Display properties dialog for the selected layer
2 or drill

Note: the Apply and Reset Finishing buttons below are only
enabled for the Materials Library Mode with the Prepreg and
Copper Finishing Options checked (see Set Target Stack
UpThickness/Finishing Options) — they are disabled for the
Virtual Materials Mode.

Applying finishing

@ Apply finished thickness

g Reset finished thickness

Changing the stackup view

20

Display 2-dimensional view

Display 3-dimensional view

)

Grid View

T
I

Proportional Graphics View

e

Managing the materials library

ili Go To/Display materials library
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Exchanging data with the Si8000m or Si9000e Field solver

Copy controlled impedance data to field solver

Paste controlled impedance data from field solver

Copy to Si8000m or Si9000e Project

o Bl B
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Creating and editing stackups (Virtual Material mode)

Material Library and Virtual Material modes

Speedstack provides the option of switching easily between

Material Library and Virtual Material modes, Virtual material

mode allows the stack designer to build and experiment with
stackups without requiring real materials to be entered into a
materials library.

In Virtual Material mode the Stackup Wizard allows rapid
entry of stack details, the number of layers, overall board
thickness, plane layers, solder mask and copper thickness.
Speedstack will then build a stack to the specified board
thickness by distributing the dielectric regions equally. If a
preferred core thickness is specified Speedstack will
maintain the dielectric thickness for core regions but equally
distribute prepregs to reach the target board thickness.

This section will describe the steps to construct an 8-layer,
symmetrical FR-4 stack to the specification below using
Speedstack’s Virtual Material mode.

Thickness: 60 mil

Signal layers: 1,3,6,8

Plane layers: 2,4,5 7

Er: 4.2

Preferred core thickness: 8 mil

Copper (all layers): 10z. /1.4 mil

LPI Mask: 1 mil

PTH drill passes: Layers1-8

Laser microvia passes: Layers1-2,8-7

Impedance structures: SE 50 Ohm Layer 1, Diff 100 Ohm Layer 1

Using the Stackup Wizard (Virtual Material mode)

W

From the Units menu choose Mils/Thou

From the Tools menu toggle Virtual Material Mode On (or
toggle the Material Library/Virtual Material mode icon.)

Ensure the Library/Virtual Material mode icon indicates
Virtual Material mode.

From the File menu chose New|Stackup Wizard.
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The Stackup Wizard supports up to 128 layers

Stack Up Wizard (Virtual Material Mode)
Number of Layers Nominal Diglectric Constant I"-ZDDD
Target Stack Up Thickness Nominal Loss Tangent ID.{I‘IB5
Friie el 2 Solder Mask Top 7 Solder Mask Bottom v
Negative Tolerance “ Solder Mask Dielectric Constant [+0000
Symmetrical o Solder Mask Loss Tangent ID_D‘IB&
Eerslacs Solder Mask Thickness |1 0000
1 A 1 A Preferred Core Thickness Select ;I |12.DDDD
2 2
3 3 Copper Thickness 0.7000
1 1
5 5 _
6 [ —Build Type
7 7
8 o 8 v & Fail " Core " Seguential/HDI
<Previous Next > Finish |  Cancel |

In the example below the Stack Editor displays the last few
layers of a 128 layer stack

4 0195

4 200/0.0195

128 Fail

SM 4 000M0.0195

Use the Zoom Extents command to view the entire stack;
navigate quickly to the layer to be edited with the mouse
wheel zoom.
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Stack Up Wizard (Virtual Material Mode)

Setting basic stack data

Consider constructing an 8-layer stackup. Supply the
parameters for the stackup as shown in the Stackup Wizard
dialog below.

Mumber of Layers
Target Stack Up Thickness
Positive Tolerance %

Megsative Tolerance %

Symmetrical

Flane Layers
7

3

6

8

Next >

g - Meminal Dielectric Constant [420i0
60 MNominal Loss Tangent ’W
10 Solder Mask Top v v
10 Solder Mask Dielectric Constant ’W
Solder Mask Less Tangent ’W
Mixed Layers Solder Mask Thickness [loooo
1 Preferred Core Thickness Select ﬂ |S
E Copper Thickness ’W
E Build Type
é + Fail ~ Core " Sequential/HDI
Finish Cancel

Step through the Stackup Wizard:
e Choose the number of layers
e Specify the board target thickness
e Specify whether the stackup will be symmetrical

e Designate plane and mixed layers.
Note the symmetrical arrangement of the chosen
plane layers

e Supply the other material parameters. Note that when
in Symmetrical mode, the Solder Mask Bottom
checkbox (shown greyed out) matches Solder Mask
Top when its checkbox is ticked.

e Choose the build type, foil, core or sequential HDI

Foil and Core builds

This most basic 8-layer stackup is the foil build, with a foil on
the outer layer of the stack; it is the most common build for
even higher layer count boards.

Another common type of 8-layer stackup — with core
materials on the outer layers — is called a core build.

Core builds are typically used in microwave applications
where expensive microwave materials are laminated
together with a lower cost internal bonding layer.

Click Finish to display the stackup or Next to add drills.
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The graphics below illustrate typical 8-layer foil and core
builds before drills are added.

8-layer foil build 8-layer core build

Sequential HDI builds
Choosing a Sequentail HDI build displays the Define Sequential

Build dialog where the HDI build may be constructed.

Define Sequential Build

= BB Z

| E—

*
N N N N =X
* —

Il

|

Finish |  Cancel |

< Previous | Mext = |

Creating and editing stackups (Virtual Material mode) ¢ 59



The structure of the HDI is by construction type. (See IPC-
2315, IPC-2226.) The Speedstack wizard supports Types |,
Type Il, and Type lll as shown below

*N ] 3 : T %FB CE

(NL,TTTY

CB

N Type | Stack
N Type Il Stack
N Type Il Stack
N Set number of foils added to foil build
== Foil build sub-section with one core
2 Foil build sub-section with two core
Foil build sub-section with three core
* Set number of cores in foil build sub-section
| Reset to foils and prepregs
FB | Reset to foil build

Reset to core build

Use the toolbar to define the sequential HDI build.

Click Next to add drills or Finish to add the (optional) stackup
file properties and display the stackup. View the stackup
sequence in the Navigator; right click and choose HDI
Build|Sequential Plan.

HOI Build

* Sequential Plan
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Adding drills

Drill information is assigned to drill columns (up to 11
columns are available) Select Column 1 and specify the First
Electrical Layer as Layer 1 and the Second Electrical Layer
as Layer 8; choose Mechanical, Through Plated with No Fill
and click Add to add the first drill to the stack.

Add Drills
—Electrical Layers =]
First Electrical Layer  Second Electrical
Stack Up Column Mo (Start Layer) Layer No (End Layer)
i = =l e =l
; —Hole Inf
6 Fill Type Hole Count Minimum Drill Size
7
2 N Fill - o Jo.0o
?ﬂ Different Hole Sizes Minimum Drill Size Tolerance (fbs)
1 Jo Jo.00
Minimum Hole Size Minimum Barrel Wall Thickness
J0.00 Jo.00
Minimum Pad Size :
0.00 .
Delete Last Delete All Add .
<Previous Finished | Cancel -

Adding microvias

Choose Column 2, specify the First Electrical Layer as 1 and
the Second Electrical layer as 2; choose Laser with No Fill
and click Add. Repeat the process to add another microvia to
Column 2 between electrical layers 8 and 7 (shown below.)
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Click Finished.

The Stackup Wizard displays the New Stackup File
Properties dialog; enter the (optional) stackup properties.

MNew Stackup File Properties = B
The fields below are optional
Descriptive Stackup Name |M-Board V Stack
Stack Top Side Label |
Stack Bottom Side Label |
Date Created j070/203
Version IF{ev 000
Rewision Show/Hide Revision Information
Author Jm
Company IF‘oIar
Department IEngineenng
Site Morth Ind Estate
Associated Documents

ok | Skip |

Click OK to close the dialog and edit the stack. Speedstack
builds the stack to achieve the specified board thickness.

2 Click the See 2D View button to assist in visualisation while
editing the stack.

See 2D View
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Use the View menu to zoom in and out of the stack.

Zoom In
Zoom Out
Zoom Extents
Default View

Hint: Click the mouse wheel in the Stack Editor (Zoom
Extents) to view the entire stack.

The Stackup Editor displays summary information for the
whole stack and for items within the stack as they are
selected.

—Stack Up Information
Field | Value
Electrical Layer Count 2
Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9685
Solder Mask Thickness 1.9685
Target Stack Up Thickness 629521
Stack Up Thickness &Z.9521
Stack Up Thickness with Soldermask  64.9606
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Selected Item Information : Dl

Field Value
First Electrical Layer No 8
Second Electrical Layer No 7
Mechanical Dirill Falze
Laser Drill True
Fill Type Ma Fill
Diata Filenames

Hole Count 0
Different Hole Sizes 0
Minimum Heole Size 0.001
Minimum Allowsable Hole Size 152000

Editing the stack

With the “virtual” stack in the Stack Editor the stack can be
changed as required.

Changing material properties

To change the properties of a material, right click the
material in the stack and choose Properties; fill in the text
fields with the associated information and click Apply. Most
material properties can be changed, including the material
descriptions, base and finished thickness, dielectric
constants, drill parameters along with the graphical colours.

Choosing Symmetrical mode

Stackups are often designed symmetrically to prevent
[T warping and twisting — using similar materials in the top
' and bottom halves of the stack.

| Symmetrical OFF

Clicking the Symmetrical button will toggle the Symmetrical
. mode on or off. In Symmetrical mode the stack editing
Symmetrical ON  functions will process materials in the upper and lower
halves of the stack simultaneously.

Changing the material description

In this example stack, ensure symmetrical mode is selected
then right click the solder mask material in the stack to
display the Solder Mask Properties dialog.
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Solder Mask Properties

Mair ] Notes ] Attributes

General [nformation
Supplier

Supplier Description
Description
Stock Number

Type

Solder Mask
Thickness
Dielectric Constant
Less Tangent

Data Filename

Apply
|PCI|EIF Samples Close
|sm-001
|IJquic| Photalmageable Mask Cost W
|500-00
|SolderMask Lead Time  [000
W Mask Colour m
Ir Graphical Colour _

o
|

Change the Solder Mask Description to Liquid Photo
Imageable (LPI).

Description ||Jquid Photo Imageable (LPI)

The change on the Description in both solder masks is
reflected in the Editor window.

Liquid Photo Imageable (LPI) 1.000

Liquid Photo Imageable (LPI) 1.000

Changing electrical layers

Electrical layer types may be changed from plane to signal,
mixed and hatched. Right click the layer to be changed and
choose from Signal, Plane, Mixed or Hatched.

Set to Signal
Set to Plane
Set to Mixed
Set to Hatched

Speedstack will take the designated layer type into
consideration when adding controlled impedance structures.

Setting hatched planes

With the XFE option Speedstack supports hatched planes,
implementing the same crosshatch calculation technique

Set Layer to Hatched <04 in the Si8000m / Si9000e. If a crosshatch plane is

Plane

required click Set Layer to Hatched Plane —use the Hatch
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Configuration dialog to set hatch pitch and width or set the
hatch width by percentage copper area. Click Apply.

Hatch Configuration Eaichlch wp [17.0701 =l
‘\H P HW Hatch Width W[5 —

"\ r—Set Hatch \width for desired Copper Area %

100

MNon Copper Area %

Adding controlled impedance structures

To add controlled impedance structures, click the Controlled
Impedance tab, select the copper layer (in this example,
Layer 1) and click the Add New Structure button.

Stack Up Edtor | DRC : 3 [ Controlled Impedance || C1 Resuts |

+

|Add Mew 5tructure|

Speedstack suggests structures valid for the layer based on
the plane layer types.

Structure Control

—Mumber Of Signal ——
Tracks Apply |
¥ Single Trace Apply Al |

" Differential Cﬂatedmcmstnp
E Advanced |

Coated Coplanar
Strips With Low...

For this example, choose a 50 Ohm single ended coated
microstrip; leave the tolerance at 10%; click Apply then Done.

- The new structure is shown in the stack, highlighting the
Structure on Layer  materials employed by the structure.
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The structure also appears in the Controlled Impedance
panel, along with its parameters.

Stack Up Editor | DRC: 0 Cortrolled Impedance | CI Resuts |

XY T ENEL @

Coated Microstrip 18

Substrate 1 Height H1 [63500
Substrate 1 Dielectric Er1fa2000
Lower Trace Width wi[as42s
Upper Trace Width w2 [97244
Trace Thickness T [o7000
Coating Above Substrate cifoooo
Coating Above Trace c2 [foooo
Coating Dielectric cer[a0000
Impedance Zoloo0
Target Impedance W
Target Tolerance % W

Calculating the structure impedance

Parameters calculated from the stack materials, such as the
substrate height and dielectric are read only and shown
greyed out; other parameters may be edited. If the editable
parameters are known they may be entered directly.

For example, modify W1 to read 10.5 and W2 to read 9.5
and click the Rebuild and Calculate All Structures.

The impedance is calculated as 51.94 Ohms
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Goal Seeking the target impedance

Speedstack can adjust one or more structure parameters to
achieve a specified target impedance. Leave the Target
Impedance at 50 Ohms and click the Goal Seek button

Goal Seek button

From the Set Up Goal Seek dialog choose W1/W2 only

Set Up GoalSeek

N

Goal Seeking Parameter(s)
& W12 only

~

~

~

" H1 Only

~

~

~

oK | Cancel |

Click OK — Speedstack adjusts trace width (below) to
achieve the target 50 Ohm impedance.

Substrate 1 Height H1 |6 2000
Substrate 1 Dielectric Erifs2000
Lower Trace Width W1 10.7037
Upper Trace Width w2 [57037
Trace Thickness T1 |1.4000
Costing Above Substrate C1 IW
Coating Above Trace C2 |1.0000
Costing Dielectric CEFIT
Impedance Zo W
Target Impedance W
Target Tolerance % IW

With the impedance in tolerance the navigation buttons
display green.

Mirroring structures

This example stack is symmetrical so structures may be
copied to the lower half of the stack (i.e. on the lower outer
layer.) Click Mirror Structures if Stack Symmetrical.

The impedance structure on Layer 1 is copied to Layer 8.
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Rebuilding the stack

During stack editing changes to the stack (for example,
inserting prepreg materials into a layer or altering the existing
material thickness) will affect the impedance value of one or
more structures. If Speedstack senses that an impedance
structure has changed it issues a Rebuild alert.

Stack Up Editor | DRC: 0 Controlled Impedance | CI Resuts |

=X 3¢ Q&jﬂ.;éﬁadwﬂﬁ”z
—|Rebulld and Calculate All Structures

Click Rebuild and Calculate All Structures — Speedstack
recalculates the impedance for the new parameters. If the
impedance value is out of tolerance the structure browse
control changes colour to red.

Virtual Material mode allows the designer to experiment with
material properties to examine the effects on impedance
structures of different trace widths or dielectric heights, etc.
Materials may be added, moved, copied, pasted or removed
and the properties of materials changed — Speedstack will
sense the changes and allow the “generic” stack to be rebuilt
and recalculated.
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Creating and editing stackups (Material Library mode)

This section describes creating stackups using the Material
Library mode. Stackups may be created manually using the
Stackup Wizard or using the editing window. Ensure Tools|
Virtual Material Mode is toggled Off.

Using the Stackup Wizard (Material Library Mode)
The Stackup Wizard guides the user through the process

.B of creating complex stackups in only a few steps. Click the
Stackup Wizard button or choose Stackup Wizard from the
Stackup Wizard button File|New sub menu. The gtackup editing window is cleared
and the Stackup Wizard displayed.
AL stack Up Wizard (Material Library Mode) — d x
General Planes and Mixed Layers
Layer count - ¥ Symmetrical
Build Type | ﬂ Plane Layers Mixed Layers
Materials
Soldermask | J
Foil | [
Prepreg | J Clear Clear
Prepreg | J Q -
Prepreg | J Drilling
Core | J [ Through-Plated I Mon Through-Plated
Apply | Cancel |
Stack Up Thickness: 0 (Mils) Stack Up Thickness with Soldemaskc: 0 (Mils)

Using the Wizard the user can specify the layer count and
build type, stackup materials, planes and drill types in a
single operation.

Electrical layer count

Begin by specifying the electrical layer count — up to 64
electrical layers may be specified. Choose the number of
layers from the drop down list box.

Build type

Choose the build type (Foil or Core) from the drop down list
box. Core builds contain only core materials; most builds will
be foil builds — containing internal layers of cores with two
outer foils.
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General

Layer count R -
Build Type | Fail =] @

Choosing stackup materials
Note; if Core build type has been specified the Foil material
control will be disabled.

The Wizard allows for a stack comprising solder mask, foil,
and cores with up to three prepreg materials between.

AL Stack Up Wizard (Material Library Mode) - O *
General Flanes and Mixed Layers
Layer count 8 - v Symmetrical
Fl Lay Mixed Lay
uld Type |F0i| j : ane Layers 1|x AYErs
2
3 3
Materials 4
Soldermask |Liq|_|id Photolmageable Mask SM: J Clear 5 E
Fail |Copper Foil FO/002 J Clear ] g
Prepreg [PreFreg 1080 PP/001 J Clear Clear Clear
Frepreg [PrePreq 1080 PP,/001 .| Clear —
Prepreg | J Clear Drilling
Core |FH4Core o7 J Clear [+ Through-Flated I Mon Through-Plated
Apply | Cancel |
Stack Up Thickness: 59 2 (Mils) Stack Up Thickness with Soldemask: 61.2 (Mils)
The Wizard displays a running total of the stackup thickness
in the Wizard’s status bar.
Adding layers
] To include a layer (in this example a foil layer) click the Foil

Add Material button; the library of foil materials is displayed.
Choose the foil material from the list and click the Add
Material Above button; the material is added as a foil layer
to the stackup.

Supplier Supplier Description| Description Stock Mumber | Cu Base Thickness | Type
4 PolarSamples FOiD04 CopperFoil0.7 100-D04 0.7 Copper
PolarSamples FO#002 CopperFoil 1.4 100-002 1.4 Copper
PolarSamples FO0003 CopperFoil2.8 100-003 2.8 Copper
PolarSamples FO/005 CopperFoil0.7 100-005 0.7 Copper
PolarSamples FO/006 CopperFoil1.4 100006 1.4 Copper
PolarSamples FO/006 CopperFoil2.8 100-006 2.8 Copper

Creating and editing stackups (Material Library mode) ¢ 71



Repeat the procedure for prepreg and core materials and the
(optional) solder mask layers. Use the Clear button to
remove a layer from the stackup.

Matenals

Soldermask |Liquid Photolmageable Mask SM, | Clear |
Foil [Copper Foil FO/002 | Clear |
Prepreg [FreFreg 1080 PP/001 |  clear |
Prepreg [FreFreg 1080 PP/001 |  clear |
Prepreg | | Clear |
Core [FRé Core CO/017 .| clear |

Nominating power planes and mixed layers

Use the list boxes to specify planes as power planes or
layers as mixed layers. Select all planes as required. To
remove a plane from the list select the plane number from
the list and click Clear.

Flanes and Mixed Layers
v Symmetrical
Flane Layers Mixed Layers
1 1
2
3 3
4
B
& &
8 8
Clear Clear

The dialog above shows Layers 2, 4, 5 and 7 specified as
power planes

Adding drill information

To add a drill between electrical layer 1 and the last layer
click the Through-Plated and Non-Through-Plated check
boxes as required.

Drrilling

W Through-Plated [ MNeon Through-Plated @

With all build options specified click Apply to complete the
stackup. The finished stackup appears in the Editor window.
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The example stack below includes two prepreg materials
between layers.

Liquid Photolmageable Mask
Copper Foil
PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080
Copper Foil

Liquid Photolmageable Mask

1.000

3.000

3.000

§.000

3.000

3.000

§.000

3.000

3.000

5.000

3.000

3.000

1.000

Summary information is shown in the Status Bar and
includes the units in use, the target stackup thickness and
the stackup thickness without and with soldermask.

MilsiThous

Target Stack Up Thickness = §0.0000 |5tack Up Thickness = 55.2000 |5tack Up Thickness with Scldermask = 81.2000
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Changing the stackup view
ar For many editing operations changes to the stack may be
easier to visualize when shown two-dimensionally. Click
See 2D View the See 2D View button

Liquid Photolmageable Mask 1.000
Copper Foil
PrePreg 1080 3.000

PrePreg 1080 . 3.000
FR4 Core . 8.000

PrePreg 1080 3.000

PrePreg 1080 3.000
FR4 Core 8.000

PrePreg 1080 3.000

PrePreg 1030 3.000

FR4 Core 8.000

PrePreg 1080 . 3.000
PrePreg 1080 3.000
Copper Foil

Liquid Photolmageable Mask 1.000

Filtering Materials

When adding or swapping materials, available materials
(foils, prepregs, etc.) are listed in the associated material
library dialog.

Lists can be filtered for materials matching desired
parameters (dielectric thickness, Er, etc.) See Using
Speedstack Materials Libraries.

Saving stackups
It is strongly recommended that users save work frequently and
maintain safe backups of stackups and projects.
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Creating stackups manually

Speedstack allows the designer to add or edit stackup layers
in any order, from top to bottom, bottom to top or from the
centre layer outwards. This example will create a four-layer
stackup, starting at the centre core layer and adding layers
above and below.

Consistency of units

When defining dimensions for a stackup (for example, layer
thicknesses) ensure that all measurements are defined using
the same units (mils, mm, etc.) throughout the structure and
its libraries.

Note: the libraries supplied for these examples are preloaded
with sample data only.

Click the File|[New command and choose Empty Stackup —
creating a project will clear the stackup screen and notes and
information text areas — click OK.

Speedstack

You are about to start a new project. Clicking OK will discard all data in
the current project. Click Cancel if you do not wish to continue,

OK | Cancel

Supply the descriptions in the New Stackup File Properties
dialog.

Click the File|Save Stackup or Save Project command to save
the stackup or project. Users are recommended to save
stackups or projects frequently during the stackup creation
process to avoid data loss. Stackup files, project files and
library files should be backed up to a secure location.

Editing the stack

When editing the stack, it will probably be most convenient to
right click an object in the stack and select the associated
command from the context menu. The menu will reflect the
commands available for the selected object — commands
that are not appropriate for the object are greyed out.
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Open Materials Library

Add

Add C.l. Structure

Foil

Core

Full Stack Up Editor Mode ReC

Flexible Core
Set to Signal Bondply
Set to Plane Adhesive
Set to Mixed

Prepreg

Set to Hatched

Yiew Hatch Profile
Edit Hatch Profile

Copy
Paste Above

Paste Below

Non-Copper Core
Soldermask
Coverlay

Ident

Peelable

Drrill

Delete
Swap
Move Up

Mowve Down
Properties

Flexi-Rigid »

Alternatively, select the object (copper, prepreg, core, etc.)
with the left mouse button and choose the command from
the Speedstack toolbar.

Adding layers to the stackup

Items added to the stackup are added from the currently
open materials library. Speedstack opens Program
Files\Polar\Speedstack\default.mlbx if it exists; if a different
library is required, open it via Open Materials Library. The
Materials Library toolbar is displayed

A WP R0k BE TUE %% - &

[®

Open Library

.

Open and Append Library

+
=
— | Add Layer Material

Note: Speedstack does not ship with the default.mlbx library.

For this discussion open one of the two sample library files,
Speedstack Imperial.mlbx or Speedstack Metric.mlbx.

Use the Open Library icon to navigate to the Program
Files\Polar\Speedstack\Samples folder, created at
installation time.

To add the library to the current library, use the Open and
Append Library icon

Adding a core layer

Click the Add Layer Material button and choose Core...the
Core library is displayed

The Core library contains full details of the core material,
including base and finished thicknesses, dielectric constant,
and upper and lower copper thicknesses.
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Supplier Description | Description | Stock Mumber Dielectric Base Thickness | Dielectric Finished Thickness | Dielectnic Constant UpperCu Base Thickness | Lower Cu Base Thickne
COM01 FR4 Cor= 2 400001 2 2 42 0.7 0.7
covoo2 FR4 Core 2 400-002 2 2 42 1.4 1.4
COJyo03 FR4 Cors 2 400-003 2 2 42 28 2.8
COJ004 FR4 Core 3 400-004 3 3 42 0.7 0.7
o005 FR4 Core 3 400-005 3 3 42 1.4 1.4
Click on any of the column buttons to sort the library list by
the selected column.
— Choose a core type from the list of cores and click the Add
N Material Above button. The core is added to the stackup
, screen. When editing a stack this button adds a core above
Add Material above

the selected layer.

Add Material below

Stackup core layer

Layers may also be added below the selected layer. The
Add Material below button adds a core below the selected
layer.

As each layer is added the stackup information table is
updated to reflect the current status of the stackup.

Stack Up Information

Field Walue
Electrical Layer Count 2

Stack Up Cost 0.00
Copper Thickness 11.0236
Dielectric Thickness 51.9635
Solder Mask Thickness 1.9685
Target Stack Up Thickness &2.9521
Stack Up Thickness 62 991
Stack Up Thickness with Scldermask 645606

Stackup information table

Note: The Stackup Information is printed in red when the
stack thickness is outside its tolerance.

With the core selected, the Selected Item table displays the
properties of the core.
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Selected ltem Information : Caore

Field Value -
Upper Cu Base Thickness 35.00
Upper Cu Fimshed Thickness 35.00
Upper Copper Coverage 0
Minimum Trace Wwidth 75.00
Data Filenames

Dielectric Base Thickness 100.00
Dielectric Finished Thickness 100.00
Dielectric Constant 42
Loss Tangent 0.0195
Resin Content b3

Tg 180
Td 0

CAF Resistance 0

£ Bxis BExpansion 0
Excess Resin 0.00
|zolation Distance 100.00
Lower Cu Base Thickness 35.00
Lower Cu Fimshed Thickness 35.00
Lower Copper Coverage 0
Minimum Trace Width 75.00

Core layer information

To observe the properties of any material, click the material
in the stack and read off the properties in the Selected ltem
Information panel.

Editing the selected layer properties

To change the properties of the selected object (for example,
to modify the dielectric constant or the value for the finished
thickness of the dielectric), right click the object in the
stackup and choose Properties from the shortcut menu; in
this example the Core Properties dialog is displayed.

Note that the Enable Finishing setting in the Tools|Set
Stackup Thickness/Finishing Options dialog must be
unchecked to enable the Finishing Thickness to be specified
manually.

Change the value to the corrected value and click Apply.
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Core Properties

Main lNotes ] Attributes

General Information
Supplier

Supplier Description
Diescription

Stock Mumber

Type

Upper Copper
Base Thickness
Finished Thickness

Data Filename

Finizhing Applied
Dielectric

Base Thickness

Finished Thickness

Dielectric Constant

Loss Tangent

Resin Content %

Tg

Lower Copper
Base Thickness
Finished Thickness

Data Filename

Finishing Applied

Apply
|POIar Samples Exchange Copper | Close
|coso08
|FR4 Core Cost 8.00
[400-008 Tolerance  [10.00
[FR4 Lead Time  |0.00
35.00 Copper Coverage % 0.00
35.00 Graphical Colour
- Remove Copper w

(disabled if structures or sub-stacks est)
-
100.00 Td 0.0
100.00 CAF Resistance 0.0
4.2000 Z Awis Expansion 0.0
0.0195 Excess Resin 0.00
53.00 Isclation Distance 100.00
130.0 Graphical Colour
35.00 Copper Coverage % 0.00
35.00 Graphical Colour
~l Remave Copper r
(disabled if structures or sub-stacks exist)
-

Set Layer to Plane

Adding data file names
If available, add the data file name(s) to the upper and lower
copper layers and click Apply.

Close the dialog when all changes are completed.
Changes will be reflected in the Stackup Information table.

Changing a layer function
In this example both the signal layers above and below the
core dielectric are changed to planes.

Click the lower signal layer and click the Set Layer Plane
button. Repeat for the upper signal layer.

The changes are reflected in the stackup window
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Exchanging layers

To change just the core dielectric (leaving the copper layers

unaffected), right click the core material (for example the FR4

in the graphic above) and choose Swap from the context
@ menu or left click the core material and click the Swap
Selected Material button. Choose the new core type from the
library and click the Swap button. The layer properties will
change to reflect the new material and changes appear in the
Stackup Information table.

Swap Selected Material

Adding prepreg layers
" With the core selected, click the Add Material button and
- choose Prepreg...; the Add Prepreqg library is displayed.
= | Add Material
PB:I:::;egtmples PB:;;I:rDe;criptinn ::T::Zﬁ?;ﬁ :;;j;umbe( ;»eledric Base Thicknass SII:eledric Finished Thickne :i:leetric Constant ;_.:;jss'sl'angent ::;in Content
PolarSamples PPi001 PrePreg 1080 300-001 75 75 4.2 0.0185 60
Pt Sarpies POOR2 T = = &
PolarSamples PPi003 PrePreg 3113 300-003 100 100 42 0.0195 53
PolarSamples PP/005 PrePreg 7628 300-005 200 200 4.2 0.0185 45
The Prepreg library contains details of the prepreg material,
including base and finished thickness, dielectric constant and
loss tangent, resin content and excess resin.
- Choose the Prepreg material from the database and click the
=" Add Material Above button.
Add Material Above

PrePreg 1080 i 3 D O]

FR4 Core

The prepreg layer is added above the core.

To change the properties of the prepreg material right-click
the layer and choose Properties from the short cut menu.
Items with a white background can be modified.

Dielectric
Base Thickness 12500 Td oo
Finished Thickness 12500 CAF Resistance oo
Dielectric Constant 4.2000 £ Bz Expansion ICCi
Loss Tangent ’W Excess Resin IT
Resin Content % 47.00 Isolation Distance IW
To 130.0 Graphical Colour |7

Select the Core material and click Add Material|Prepreg to
H display the prepreg library and click the Add Below button. The
layer of prepreg is added below the core.

Add Prepreg Below
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PP PrePreg 1080

Core FR4 Core

PP PrePreg 1080

Modify the properties as necessary.

Choosing the Display Data fields

The Speedstack Stack Editor provides a range of useful data
fields for optional display alongside each material. Base and

Finish (Display Field 4) refer to thicknesses and weights and

appear to the left of the stackup graphic.

Hatch Defaults | Extemal Utilities | Rebuild and Caleulate Structures |
General | Structure Defaults I Licensing I File Locations I Goal Seeking I Auto Stack I User I CITS Test I Colours I Passwords | Miscellaneous I

—Default Stack Up View ——— [ Display Data
a0 Display Fields 1 and 2 are reserved for Layer Numbers and Layer Types
Display Field 3 Display Field 4 | Display Field &
@ 3 Description ;I Base Thickness LI Finished Thickness ;I
Finished Thickness A
. Finished Thickness Copper Coverage
[~ Units Copper Coverage Isolation Distance
Isalation Distance Dielectric Canstant
& Mils/Thous " Microns ™ Millimetres (| Dielectric Constart Resin Content
Resin Cortert Tg
Tg Colour
Processed Thickness ¥ Data Filenames hd
¥ Open last used file on application start up
¥ Display File Properties Dialog for New Stackups and Projects
Apply | Cancel |

Display Field 5 appears to the right of the stackup graphic.
Choose the data of interest from the drop down lists.
Note: Processed Thickness is the Finished Thickness for
copper layers and Isolation Thickness for dielectric layers.

Adding a foil layer
Select the upper layer of prepreg and click the Add Layer
Material button and choose Foil to display the copper foil

library.
Supplier Description | Description | Stock Mumber Cu Base Thickness | Type Caost Lead Time
FCWoD1 Copper Foil  100-001 0.7 Copper 1 a
Fowon2 Copper Foil  100-002 1.4 Copper 2 a
FoWoD3 Copper Foil  100-003 2.8 Copper 3 a

Choose the foil type and click Add Above, the copper foll
layer is added above the selected prepreg layer.
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PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

PrePreg 1030

FR4 Core

PrePreg 1080

Copper Foil

Repeat the procedure for the lower prepreg layer: select the
lower prepreg layer and add a layer of copper foil below the
layer (shown below as layer 4 in the 3D view).

To alter the foil properties, right-click the foil layer and
choose Properties. Using the Properties dialog the user can,
for example, specify that the trace is shown inverted.

—Copper
Base Thickness IW Copper Coverage % IF
Finished Thickness I Graphical Colour o
Data Filename I
Trace Inverted v :_— ove Cop per ) ul
Finishing Applied 3 -

Note that the stackup is being built symmetrically about the
centre layer.

Adding solder mask layers

With the upper layer of foil selected, click the Add Layer
Material button and choose Soldermask to add a layer of LPI
solder mask above the foil.

Supplier Description | Description | Stock Mumber | Mask Thickness | Dielectric Constant | Colour | Type Cost
SMa01 Liquid Photolmegesbe Mesk 500-001 1 4 Green SolderMask 0.5
SMao2 Liquid Photolmegesbe Mesk 500-002 1 4 Green SolderMlask 0.6
SM03 Liquid Photolmagesbke Mask 500-003 1 4 Blue SoldertMask 0.5
SM004 Liquid Photolmagesble Mesk 500-004 1 4 Red SolderMask 1
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Repeat the process for the solder mask material below the
lower foil layer.

Liguid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Foil
Liquid Photolmageable Maszk

Adding the Ident layers

Select the lower LPI Soldermask layer and click the Add
Layer Material button and choose Ident to add a layer of
Screened Ident below the layer. The sample Ident library
includes ink thickness and colour

Supplier Description | Description | Stock Mumber | Ink Thickness | Colour | Type | Cost
ICvo01 Screensd ldent 500-001 2 White Ident 0.1
ICvo02 Screenad ldemt 600-002 2 Yelow Ident 0.1
IDVo03 Screened ldent 900-003 2 Black Ident 0.1

Repeat for the upper layer.

Screened Ident
Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
FR4 Come

PrePreg 10580

Copper Foil

Liquid Photolmageable Mask

Screened |dent

Adding a drill

1[[: To add a drill between layers click the Add Drill button; the
AddDrill Add Dirill dialog is displayed.
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El= Add Drill

Main lNl::tes ]

Electncal Layers

Stack Up Cal First Electrical Layer  Second Electrical Back Drill Must-Cut Back Drill Must-Mot-Cut

tack Up Lolumn Mo (Start Layer) Layer Mo (End Layer) Layer Mo Layer Na

1 =l =l 4 = =l =]

Dnill Information Hole Information
" Mechanical Fill Type Hole Count Minimum Drill Size
{+ Laser Ma Fill - |D |D.|}|}
i Laser (Stacked) Different Hole Sizes Minimum Drill Size Tolerance (Abs)
" Back Drill i j0.00

[v¥ Through Plated

Data Filenames

[ First Layer Capped

-

Back Drill Information

Mimmum Distance From
Must-Cut Layer

Minimum Distance From
Must-Mot-Cut Layer

nnn
Uy

Maximum Distance From

Must-Cut Layer

n nn
(TR

Maximum Distance From
Must-Not-Cut Layer

nnn
Uy

Primary Dnill Size

n nn

Minimum Hole Size

Minimum Barrel Wall Thickness

|0.00

Mimmum Pad Size

|0.00

|0.00

nnn
Uy

|u.uu-

Add | Close |

Drill information is stored in columns. Select the column in
which to place the drill. Choose the first and second electrical
layer numbers (layers 1 and 4 in the example).

Specify the drill type, mechanical or laser and whether
through plated and whether the layers are capped.

Note that with laser drills the order of drill layers is important,
e.g. layer 1 and 4 is different from layer 4 and 1.

Choose the Fill Type from the dropdown list of fills.
Optionally, add the NC drill data filenames.

Optionally, add the hole count, number of different hole sizes
and the minimum hole size. Click Add and close the dialog.
The drill information is added to the stackup. The example
below contains through plated and laser drill information.

Note: The drill properties (i.e. Drill Information and Hole
Information) are retained between each Add Drill operation.
This can speed up the process of adding drills, especially
when multiple drills of the same type are being added to the
stackup.

The finished stackup is shown below
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Screened [dant

Liguid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080
Copper Foil
Liguid Photolmageable Mask

Screened [dant

Drill capping

The Drill Cap feature documents when via holes are
capped, i.e., where a conductive ‘cap’ is added to the via
hole during fabrication. Capping is often applied to buried
vias, (plated holes that start and end on inner layers of a
stack up.)

Mechanical drills Drill Cap option

— Drill Information
f* Mechanical Fill Type
" Laser Na Fil -
" Laser (Stacked)
" Back Drill
¥ Through Plated ¥ First Layer Capped
¥ Second Layer Capped

Mechanical drills offer four drill cap states: (the default state
is no drill cap when adding a drill)

¢ Neither first or second layer capped
o First layer capped
e Second layer capped

e Both layers capped

Laser drills Drill Cap option

— Drill Information
" Mechanical Fill Type
& Laser [No Fil
" Laser (Stacked)
" Back Drill
¥ Through Flated ¥ First Layer C
[ Second Laye
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Laser drills offer two states (as with mechanical drills the
default state is no drill cap when adding a drill)

¢ Not capped
e First layer capped
Note that the Second Layer Capped checkbox is disabled.

Specify the Drill Cap option and click Apply — the capping
specified is reflected in the Drill Information pane.

Selected Item Information : Dl

Field Walue
First Electrical Layer Mo 4
Second Electrical Layer Mo 7
Mechanical Drill True
Laser Drill Falze
Back Dnll False
Through Flated True
First Layer Capped True
Second Layer Capped True
Fill Type Ma Fill
Data Filenames

Deleting drills

To delete a drill right click the drill and from the context menu
choose Delete. To delete all drills choose Delete all Drills —
confirm via the dialog below.

Speedstack *

You are about to delete ALL drills from the stack. Do you wish to continue?

Yes MNo Cancel

All drills will be cleared from the stack.
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Adding stack vias
Speedstack can add stack vias to the stackup in a single

operation. To add stack vias between layers 1 and 5 in the
stackup below, select layer 1 and click Add Dirill.

Liquid Photolmageable Mask

per Foil
PrePreg 3113

Copper Foil

PrePreg 1651
Copper Foil

PrePreg 1651

FR4 Core

Specify the column number — (Column 1)

1.000

5627

8.000

Specify electrical layers 1 and 5 (Note: drills cannot have the

first electrical layer on the underside of a core material)

Choose Laser (Stacked)
From the Fill Type drop down list choose Copper.

Click Add.
&[S Add Drill
Wain |Notes I
— Electrical Layers
First Electrical Layer  Second Electrical Back Drill Must-Cut Back Drill Must-Not-Cut
Stack Up Column No (Start Layer) Layer No (End Layer) Layer No Layer No
I = =lls = h = | =
r—Drill Inf —Hole Inf
" Mechanical Fill Type Heole Count Minimum Drill Size
C Lsser - o fooo
' Laser (Stacked) Different Hole Sizes Minimum Drill Size Tolerance (Abs)
" Back Drill Jo Jo.00
¥ Through Plsted [ First Layer Capped Minimum Hole Size Minimunm Barrel \wall Thickness
] I” Second Layer Capped Iﬂ'm Iﬂ_m
Data Filenames
Minimum Pad Size
ID.[H}
~Back Drill Inf

Must-Cut Layer

Minimum Distance From

Minimum Distance From
Must-Not-Cut Layer

Must-Cut Layer

Maximum Distance From

Maximum Distance From
Must-Not-Cut Layer

Primary Drill Size

add | Clse |
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The stack vias are added to the stack (below.)

1.000

Liguid Photolmageable Mask

Copper Foil
PrePreg 3113
Copper Foil
PrePreg 1651
Copper Foil
PrePreg 1651
Copper Foil

PP PreFreqg 1651

Core FR4 Core

5627

8.000

Via stub removal (controlled depth drilling / back drilling)

PCB vias provide a conductive path to allow the transition of
electrical signals between circuit layers through the walls of
plated holes.

The most common method of connecting two signal layers is
to create a plated through hole through the entire board and
then remove the unwanted portion of the plated through hole
— the stub, the unused portion of via extending further than
the last connected inner layer — by back drilling.

Stubs can lead to reflections, discontinuity errors that
become critical with increasing propagation speed, so are
commonly removed.

The stackup below shows a plated through hole back drilled
from layer 8 to 6, resulting in a via between layers 1 and 6.
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Peelable Mask
Screened Ident

Liquid Photolmageable Mask

Copper Foil
PrePreg 3113

PrePreg 3113

FR4 Caore

PrePreg 3113

PrePreg 3113

FR4 Core

PrePreg 3113

PrePreg 3113

FR4 Core

PrePreg 3113
PrePreg 3113

Copper Faoil

Liquid Photolmageable Mask

Add Drill

Specifying back drills
To add a back drill click Add Dirill to display the Add Drill

dialog.

203.2000
50.8000

35.5600
86.3600
3600

53.3400
203.2000
35.5600

91.4400

91.4400

91.4400

91.4400

Main INntes I

— Elecinical Layers
Stack Up Column

First Electrical Layer

Second Electrical

Back Drill Must-Cut

Back Drill Must-Mot-Cut

Data Filenames

[T First L
I_ Secon

Mo (Start Layer) Layer Mo (End Layer) Layer Mo Layer No
E =~ s =l = F ] [ER—— -
— Dl Information — Hole Information
" Mechanical Fill Type Hole Count Minimum Drill Size
{" Laser IN" Fil ;I Iﬂ Iﬂ.ﬂ'ﬂ
" Laser (Stacked) Different Hole Sizes Minimum Drill Size Tolerance (Abs)
@ Back Drill o 0.00
I Through Plated Ly E] Minimum Hole Size Minimum Barrel Wall Thickness

0.00

Mimmum Pad Size

0.00

{0.00

Must-Cut Layer

— Back Drill Information

Mimmum Distance From

Minimum Distance From
Must-Met-Cut Layer

0.00

Must-Cut Layer

Maximum Distance From

j0.00

Maximum Distance From
Must-Mot-Cut Layer

0.00

Primary Drill Size

jo.00

0.00

.

add |

Close |
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To specify the controlled drilling depth, from the Add Dirrill
dialog:

Choose Back Drill from the Drill Information
Choose the drill column and specify the start layer.

Choose the layer number from the Back Drill Must Cut
Layer No.

Choose the layer number from Back drill Must Not Cut
Layer No.

Elecincal Layers

Stack Up Cal First Electrical Layer Second Electrica Back Drill Must Cut Eack Drill Must Mot
tack Up Column Mo (Start Layer) Layer Mo (End Layer) Layer Mo Cut Layer Mo

7 = s =l = B =l -

X

Material

=

Material

Delete Selected

Copy Selected

Specifying back drill information

Many drill machines are capable of modifying drill depth to
accommodate inner layer thickness variations. The Back Drrill
Information fields allow designers and suitably equipped
board shops to specify controlled stub lengths.

Use the Back Drrill Information fields to specify the Minimum
and Maximum Distances from Must-Cut Layer and Minimum
and Maximum Distances from Must-Not-Cut Layer.

Adding notes
Click the Notes tab and click Add to supply descriptive and
explanatory notes.

Deleting a layer
To remove a layer from the stackup select the layer and
click the Delete button.

Copying a layer

With layers defined it will often be found more convenient to
copy an existing layer and paste it into the stackup than to
create a new layer “from scratch”.

Select the layer to be copied and click the Copy Selected
Material button.

Click the layer nearest the destination location and choose
Paste Above or Paste Below as appropriate

Note: when modifying the stackup it may be necessary to
redefine the drill information to reflect the changes.
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Copying material properties

Speedstack can copy material properties from one material
in the stackup and paste them onto multiple materials
simultaneously.

— For example, to replace the three prepreg materials below
coy Layer 3 in the stackup below with the Layer 1 material,
- Copy Material PrePreg 1080, select the source material (shown
Properties

highlighted below) and click Copy Material Properties

1.100

1.950

Liquid Photolmageable Mask

A & O 50

Copper Foil C 3.100

PrePreg

NP L7 PP PP

FR4 Core ’
|

PrePreg 3080

PrePreg 1651

12.000

PrePreg 1651
Select the three target layers

1.100

14950
Liguid Photolmageable Mask
Copper Foil C - . 3.100
PrePreg 1020 == — -.—;‘ Iw.-.#;-----.,-,..-.—/—-.‘_-?u.-ﬁ-}—r
W & I SIS
FR4 Caore
Pre
2 ‘ ’ 12.000
L == S e I & i ‘_?'
{EI““E Click Paste Material Properties — the Paste Material
—== Paste Material Properties dialog is displayed.
Properties
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Paste Material Properties

Flease select the Property Groups that you wish to paste to the selected matenals:

General Properties (All Matenals)
[v General Information (Supplier, Description, Stock Mumber etc)

[v MNotes (5 x Mote properties)
[v Colour (Draw colour)
Conductor Propertes (Faoil, Core, RCC, Flex Core)
[v Copper (Base and Finished Thickness, Copper Coverage etc See Note 1)
MNote 1: Layer Numbers and Layer Types assigned to Copper layers are not copied.

Dielectric Properties (Core, RCC, Prepreg, Flex Core, Bondply, Adhesive)
[v Diglectric (Base and Finished Thickness, |solation Distance, Diglectric Constant etc)

Solder Mask Properties (Solder Mask)
[v¥ Solder Mask (Thickness, Dielectric Constant etc)

Coverlay Properties (Coverlay)
[v Coverlay (Base and Finished Thickness, Dielectric Constant etc)

Ident Properhes (ldent)
[v I|dent (Thickness tc)

Peelable Properhes (Peelable)
[v¥ Peelable (Thickness etc)

¥ Select/ Deselect All ooy | cancel |

Select the property groups that are to be applied to the target
materials and click Apply. Properties that do not apply for a
material type are ignored.

e 1950
Ligquid Photolmageable Mask

Copper Foil C [ e aEe 3.100

PrePreg 1080

FR4 Core

12.000

In this example all material properties have been applied to
the three target materials.

Note: When changing multiple materials simultaneously it is
important to review the resulting stackup.
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1

¥

Move Selected

Material Up

Move Selected

Material Down

e

KL

Apply Finishing

Reset Finishing

It will probably be necessary to recalculate any associated
controlled impedance structures, especially if dielectric height
and copper thickness parameters have changed.

Moving materials

To move materials within the stackup click Move Selected
Material Up and Move Selected Material Down.

When a material is moved it is exchanged with the layer
above or below, respectively.

Applying finishing
To apply the finished thickness factor throughout the board,
click the Apply Finishing button with no material selected.

To reset the finished thickness back to the original base
thickness of the materials throughout the board, click the
Reset Finishing button with no material selected.

Note: when applying or resetting finishing, if a material is
selected it will be necessary to specify whether finishing is to
be applied to the selected material only or the whole stack.
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Displaying the stackup in 2-dimensional view

= To change the view of the stackup from its default 3-
d dimensional aspect, click the See 2D View button. The
See 2D View stackup is displayed in 2-dimensional view.

Screened |dent
Liquid Photolmageable Mask
Copper Foil

PrePreg 1080

FR4 Come

PrePreg 1080

Copper Foil
Liguid Photolmageable Mask

Screened [dent

Click the View 3D button to restore the 3 dimensional view.

See 3D View

Mirror Builds

Mirror Build allows the designer to consider the stack in two
halves, designing and building, for example, just the top half
and mirroring the structure into the lower half.

Build the top half of the stack, including any controlled
impedance structures and click the Mirror Build button;
specify whether the current set of layers is the upper or lower
half of the stack. To maintain symmetry, Speedstack will add
a layer of material as appropriate to the stack;

Mirror Build

Which half of the new stack i1s this?
Bottom

b

It will be necessary to add another prepreg to Cancel
complete the Mirrored stack.

the stack is reflected symmetrically into the lower half.
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Symmetrical Builds

In Symmetrical Build mode the Speedstack maintains stack
symmetry as the stack designer creates or edits a stack.
Changes in one half of the stack are reflected in the opposite
half of the stack to ensure a symmetrical stack.

This example considers an 8-layer stack — beginning with
three cores and then using Symmetrical Build.

Creating a new stack
Create a new empty stackup and add three cores.

Y 4 /" /////

Vr L Ll

When constructing complex structures, it will often be found
easier to use the two-dimensional aspect.

To change the view of the stackup from its default 3-
dimensional aspect, click the See 2D View button. The

LS S

o

el

View 2D button stackup is displayed in 2-dimensional aspect.

FR4 Core

FR4 Core

FR4 Core

Adding a prepreg layer in Symmetrical Mode
In this example it is necessary to add prepreg layers
between cores to achieve the required dimensions.

Switch to Symmetrical Mode and work in the top half of the
stack — in Symmetrical Mode as layers are added to the top

Symmetrical OFF  half of the stackup Speedstack will add layers to the lower half
of the stackup to maintain stack symmetry.

Symmetrical ON
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To add a layer of prepreg between Layers 2 and 3 select
Layer 3 (the selected layer is shown highlighted in the figure
below.)

Click the Add Material button and add a layer of prepreg
above Layer 3 (shown highlighted in the figure below).

In Speedstack’s symmetrical mode the prepreg layer is
automatically reflected in the lower half of the structure.

FR4 Core

FR4 Core
PrePreg 1080

FR4 Core

Adding a second prepreg layer

Now add a second layer of PrePreg 1080 above the layer
just added; the new prepreg layer is reflected in the lower
half of the stack as shown below.

FR4 Core

PrePrg 1080
FR4 Core

PrePrag 1080

PrePreg 1080

FR4 Core

Next, add a layer of prepreg above layer L1 in the upper half
of the stackup.

Speedstack in symmetrical mode automatically maintains
stack balance by adding the corresponding layer below L6.
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FR4 Core

PrePrag 1080

FR4 Core

PrePrag 1080

Adding foil, LPI Mask and Ident layers
Next, add a foil layer (L1 below) which is mirrored as L8; as
part of the process Speedstack inverts layer L8.

PrePrag 1080

Copper Foil

Next, LPI solder mask is applied to the top side of the
stackup and reflected on the bottom side.

Copper Foil
FraPreg 1050

FrePreg 1057

Copper Faoil
Liqgud Photolmageable Mask

Ident layers (which are not considered components of
electrical symmetry) will not be automatically reflected by
Speedstack as they are added and must be applied
separately to each side of the board.

Select the upper solder mask and add an Ident material
above; select the lower solder mask and add an Ident
material below.
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Screenad Ident
Liquid Photolmageable Mask
LCopper Fail

Copper Foil
Liqud Photolmageable Mask

Assigning ground planes
— With all the material in place, assign ground planes; begin
’ with layer L2 — it’s reflected in layer L7. Right click the
Set Layer To Plane  copper (L2) in the top core and choose Set Layer to Plane.

FR4 Caore

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg

FR4 Core

Repeat the process for the other ground plane layers; layer
L4 is designated a ground plane, the change is reflected in
L5 in the lower half of the stack.

PrePreg 1080

FR4 Core

PrePreg 1080
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Screened Ident

The completed stack is shown below

Liquid Photolmageable Mask

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

Liguid Photolmageable Mask

Screened Ident

Using Ormet® Z-axis Interconnect

Speedstack provides support for Ormet® Z-Axis Interconnect
— or other Any Layer Interstitial Via Technology. Z-Axis
Interconnect provides a method of connecting two PCB
boards using a conductive paste filled into the vias of a
drilled prepreg.

In Speedstack, Z-Axis Interconnects may be incorporated
into a stackup to connect two cores or foils together.

Ensure the Tools|Options|Miscellaneous|Drill Validation
Check box is unticked

[~ Drill Validation Check

This option prevents invalid drills from being added to the stack up. For instance, a drill that starts from the lower copper side of core
materials. Uncheck this option if you use a drilling technology that permits drills to be placed between electrical layers which are not
typically supported by conventional mechanical and laser dills

With this validation check disabled, Ormet® Z-Axis
Interconnects can be placed between electrical layers which
are not typically supported by conventional mechanical and
laser drills. The Speedstack graphic below shows
interconnects (highlighted in red) bonding adjacent cores.
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Adding Ormet® Z-Axis Interconnects

Adding a Z-Axis Interconnect to a Speedstack stackup
consists of adding the specified prepreg between the two
cores to be connected and then adding the drills with the
sintering paste fill.

With the Drill Validation option disabled as described above,
add the prepreg between layers 4 and 5 as shown below.

FR4 Core
PP 1035

Core FR4 Core

Add mechanical drills between layers 4 and 5 and specify the
fill type as Sintering Paste.

Core FR4 Core -

Core FR4 Core 5 19685
0.7087 10 1} 13 0.7087

et

Edit the Prepreg Properties to reflect the interconnect.

Supplier Description IF‘repreg H035 + Omet 701
Description {1035 + Omet 701
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Design rule checking

Speedstack includes facilities to check for errors in stackup
design, such as layers placed in invalid order or
asymmetrical structures. The condition of the design rule
checkboxes is carried over from session to session.

The Design Rule Checker (DRC) displays results in the DRC
dialog. As each design rule is broken the Speedstack
increments the error count on the DRC tab.

Viewing design rule errors
Click the DRC tab to view errors.

Stack Up Editor DRC:20 lCn:nntn:nIIed Impedance ] C| Results ]
DRC Test Selection
[ Design Logic v Symmetry |+ Copper Balance
I¥ Board Thickness
[v¥ Manufacturing Tests (Tools | Manufacturing Constraints)

Active Constraint : Polar Microns

v Min. Trace Wwidth W Min. Gap Width
Aspect Ratios

Iv Mechanical Drill Iv Buried Laser Microvia
Iv Elind Laser Microvia v Trace

[+ Resin Starvation

The Design Rule Checker checks include checking for:
Two adjacent copper layers
Resin coated copper on internal layer
External prepreg layers
Internal solder mask material
Internal ident material
Internal peelable mask
Symmetry — different material types
Copper not balanced

Board thickness (if the board is outside tolerance the
Stack Information in the Stack editor is displayed in red)

Manufacturing tests

Minimum trace width (the test is carried out when
calculating controlled impedance)

Minimum trace separation (the test is carried out when
calculating controlled impedance)

Drill aspect ratios for plated holes
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Track aspect ratio
Excess resin test (Resin Starvation)

If the Resin Starvation check box is ticked values are shown
as below; scroll through the layers as required

Note: If the Resin Starvation check box is ticked, all prepregs
must include valid values for the excess resin field.

Polar Application Note AP509 includes a discussion on
calculating excess resin.

Users can choose to display all errors or to select from a
combination of design errors, symmetry errors and copper
balance errors, etc.; check the boxes as required.

Click on the errors shown in the list to highlight the errors in
the stackup screen.

Resin Level Low: -100.0%

Resin Level Low: -100.0%
Resin Level Low: -100.0%
Fesin Level Low: -100.0%

Errors are highlighted in red.

Copper Foil

HE PrePreg 1080

Core FR4 Core

Correcting design rule errors

Users are strongly recommended to work through and
correct errors in the order in which the errors are listed. Note
that clearing each error may clear other errors in the
process.

Manufacturing tests should be fixed before sending the PCB
for manufacture. Hole sizes should be adjusted to comply.
Failures with track and gap should be corrected, possibly by
changing prepreg thickness and/or dielectric constants.

A collection of manufacturing constraints can be defined and
the required one selected.
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Creating and using manufacturing constraints

From the Tools menu, select Manufacturing Constraints: the
Manufacturing Constraints window opens, displaying any

manufacturing constraints added. By default, there will
always be at least one.

Manufacturing Censtraints
Active Constraint : Fabricator A"

Manufacturer's Name

Blind Laser ViaA R.| Buried Laser ViaA

Mechanical Orill A R.

Instructions: Double-Click the Data Grid row to edit, add or delete a constraint

Highlight | Set |

"Higﬂight and Set Active Constraint

Minimum Gap Minimum Trace Width Trace & R Units
| Polar Microns 0.5 85 75 75 1 Microns
| Polar Mils 05 85 3 3 1 Mils
| Polar Millimetres 05 35 0.075 0.075 1 Millimetres

Polar Inches 0.5 8.5 0.003 0.003 1

Inches

Close

4
It is important to always have one constraint set active.

To set the active constraint, select the required data grid row
and click Set. The active constraint is shown above the grid.

The Active Constraint name in the example Manufacturing
Constraints list above is displayed as shown below so the

current selected set of Manufacturing Constraints is easily
identifiable
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Stack Up Editor  DRC:1 |Enntmlled Impedance I Cl Results I
—DRC Test Selection

¥ Design Logic ¥ Symmetry ¥ Copper Balance
¥ Board Thickness

¥ Manufacturing Tests (Tools | Manufacturing Constraints)

Active Constraint : Fabricator A

¥ Min. Trace \Width ¥ Min. Gap \Width
Aspect Ratios

¥ Mechanical Drill ¥ Buried Laser Microvia
v Blind Laser Microvia v Trace

[~ Resin Starvation

Maximum Drill &spect Ratio Exceeded

DRC errors are listed below the rules. Clicking the error will
highlight the problem graphically on the stackup

1.0000
1.4000
1.9500
. 14000

3.0000
: 1.4000

5.5520

 1.4000
12.0000
1.4000

27760

1.4000
3.0000
1.4000
1.9500
1.4000

1.0000
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Editing constraints

Double-click on a constraint row will bring up the Edit
Constraints dialog; use the dialog to add, delete or edit
constraints (gaps, trace widths, aspect ratios, etc.)

Edit Constraints

IInits

i+ Mils " Microns

(" Inches " Millimetres
Option Name |Fa|:nricatn:nr A
Minimum Gap |3
Minimum Trace Width 13
Mechanical Drill A.R. 6

Blind Via A.R. 0.5

Buried Via AR. 0.5
Trace AR. I

< < Bof &
Add | Delete | Done | Cancel

Instructions
Add: Press Add, which will add a new blank constraint. Notice the
'n of n' record number will increase. Now key in the constraint
details and select Done.
Delete: Press Delete to remove the existing constraint. Motice the
'n of n’ record number will reduce. Then select Done to close the
dialog.
Edit: Edit the existing constraint and select Done to close the
dialog.

To edit a constraint set, use the navigation buttons to select
the set to be modified, change the values as required and
then press Done.

To delete a constraint set, use the navigation buttons to
select the set, then press Delete.

To add a new constraint set, press the Add button, this will
add a new (empty) constraint row, enter the name and
constraint values and press Done.
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Adding controlled impedance structures

Speedstack incorporates the facility to add controlled
impedance structures to a layer in the stackup.

Speedstack is integrated with the Polar Instruments
Si8000m/9000e controlled impedance field solvers so
impedance values for a structure may be calculated at the
click of a button.

Structure parameters may be copied to the field solver for
processing (for example by the Si8000m/9000e Goal Seeking
function) and calculated values pasted back into Speedstack
for insertion into the stackup.

Each structure can be assigned up to five net class names.
These net class names provide a link to the matching
impedance nets inside the ECAD PCB layout system.

Speedstack Si caters for frequency dependent calculations,
adding comprehensive insertion loss capability into
Speedstack.

Bidirectional copy and paste from Speedstack Si into
Si9000e includes all the relevant loss tangent, roughness
and roughness modelling methods along with frequencies of
interest.

Shield materials and controlled impedance / insertion loss

Please note:

Speedstack is capable of supporting many shield types for
stack up design and documentation. For controlled
impedance and insertion loss applications, however, it is
important to use the correct type of shield material. Shield
materials are often designated by the shield vendor as For
high speed signal transmission applications.
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Adding a controlled impedance structure

For the example stack below, add a controlled impedance
structure to signal layer 4.

2.000

s 1.000
Screened ldent 00

3.000

Liquid Photolmageable Mask
Copper Foil 0.70 o 2.000

PrePreq 1080
3.000

FR4 Core
2.000
PrePreg 1080
FR4 Core
PrePreg 1080

FR4 Core

PrePreg 1080 2000

5 Photolmageable Mask o —/
Screened |dent

Sample stackup (showing signal layer 4 selected)

Note that in this example Layer 5 is a mixed signal/plane
layer. Potential reference planes for Signal Layer 4 are
therefore Plane Layer 2, mixed Signal/Plane Layer 5 and
plane Layer 7.

With Layer 4 selected, click the Controlled Impedance tab.
The Add Structure button is displayed.

Stack Up Editor | DRC: 1 Centrolled Impedance | CI Resuts |

+

Click the Add Structure button; the Structure Control dialog is
displayed containing the controlled impedance structures
applicable to the selected layer in the stack. Choose values
for the target impedance and tolerance. If necessary, resize
the Structure Control dialog to view all structures.
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—Mumber Of Signal ——
Tracks . soil |
" Single Trace ] Apply All |
& o ) Edge Coupled
+ [ifferential Offset Strpli...
" Broadside = il |
Edge Coupled
Cffget Stripli...
_ D Ofise v
Target Impedance |‘|{H].D
Target Tolerance % I'Hlﬂ
Total of Structures Added ID
Primary Reference Plane |2 — I
Secondary Reference Plane |? L= |

Click the Single Trace, Differential or Broadside option button
as appropriate (in this case, choose Single Trace|Offset
Stripline 1B1A with a 50 Ohm impedance.)

Note: Broadside only appears as an option where the signal
trace is between two reference planes and Differential is
selected.

Specify the values for Target Impedance and Tolerance.

Choosing reference planes

As there are multiple reference planes available (layers 2, 5
and 7, it will be necessary to specify which planes to use for
this structure. Click Advanced.

108 ¢ Speedstack PCB Stackup Design and Documentation



—Plane(s) Above Signal Layer

Signal Layer = 4

—Plane(s) Below Signal Layer

Caution: When using this option,
please ensure that the electncal
effects of any intervening power [
mixed planes are taken into
consideration

ok |  cancel |

Choose a reference plane from the list of available planes. In
the example structure plane layer 2, mixed plane 5 and plane
layer 7 are available for reference.

Note: if plane layer 7 is chosen as reference, it will be
necessary to take into account the electrical effects of mixed
signal/layer plane 5.

In this example choose mixed signal/plane layer 5. Press OK
to confirm. The chosen reference planes are shown below.

Total of Structures Added |1

Primary Reference Plans Ig Done |

Secondary Reference Flane |5 Cancel |

Repeat for all structures to be added. Click Apply for each
structure then click Done to finish. In this example, choose a
single structure.

Layers with controlled impedance structures are indicated
by a red Ohms symbol.
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2.000

3.000

Core FR4 Core

&.000

PP PrePreg 1020

Core FR4 Core

The stackup window changes to reflect the selected signal
layer and its associated reference planes. The applied
structure is displayed in the Controlled Impedance pane.

Offset Stripline 1B1A

Substrate 1 Height H1[eooo0
Substrate 1 Dielectric Er1]4.2000
Substrate 2 Height Hz2 [io000
Substrate 2 Dielectric Er2|4.2000
Lower Trace Width wil59055
Upper Trace Width W2 149213
Trace Thickness T1 [o7000 |
Impedance Zo[o.00
Target Impedance 50.00
Target Tolerance % fooo

The window displays the parameters of the controlled
impedance structure. Fields shown "greyed out" are values
derived from the choice of materials in the stackup. For this
structure, enter the appropriate values for lower and upper
trace widths.
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Controlled impedance toolbar

Controlled impedance operations are performed via the
Controlled Impedance toolbar.

XY CEHENEE W@

Add controlled impedance structure to current layer

Delete structure from current layer

Clear all structures from current layer

Rebuild and recalculate all structures

Calculate displayed structure

Snap parameters and calculate structure

Mirror structures

e
mem | Goal seek

Bd|  Set CITS test

Free hand notes

Structure layer properties

Structure validation

Structure Net Classes

Frequency Dependent Properties

Structure Browse Control
Use the structure browse control to display the structure on
each layer and navigate through the structures

L:4 | I« -=:'1(H1 = | =
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Calculate Displayed
Structure

i
Snap Parameters and
Calculate Structure

Calculate Displayed Structure

Click the Calculate Displayed button to display the impedance
value of the structure with the current parameters. The
parameters may then be varied to alter the value of the final
impedance. In the example above the trace width can be fine-
tuned in order to approach the value of the target impedance;
other parameters are changed by modifying the stackup
dimensions (for example, core thickness, H1.)

Hint: clicking Apply All in the Structure Control dialog adds a
single instance of all structures matching the stackup layer
and the chosen criteria; the designer can then choose the
structure producing the value nearest the target impedance
and delete the structures that are not needed.

Snap Parameters and Calculate Structure
The Snap Parameters and Calculate Structure button
snaps or rounds parameters to practical values that are
more appropriate for fabrication.

The Snap feature supports the following structure
parameters: Lower Trace Width (W1), Upper Trace Width
(W2), Lower Ground Strip Width (G1), Upper Ground Strip
Width (G2), Trace Separation (S1), Ground Strip
Separation (D1), Trace Offset (O1)

The Snap To value for each parameter is held in the
configuration settings (in the example below, 0.25 mils.)
See Configuring Speedstack — Structure Defaults.

Lower Trace \width W1 |7.6500 Lower Trace \width W1 |7.7500
Lpper Trace \n/idth W2 |6.6500 Upper Trace WWidth W2 |6.7500
Trace Separation 51 18.1150 Trace Separation 51 |3.0000

Original parameter values Snapped parameter values

Changing parameter values

Clicking the Calculate function yields a value for impedance.
Parameters (for example, the dielectric height) may be
amended to yield a value for impedance closer to the target
impedance.

For this example, select the core layers; click the Swap
Selected Material button and choose a different core (ensure
the same dimensional units are used throughout the
structure) and click the Refresh and Calculate Impedance
button. The impedance is recalculated to its new value.

To achieve an impedance acceptably close to the target
impedance, use the goal seeking function of the Si8000m to
alter other parameters (in this case, change the upper and
lower trace widths).

112 ¢ Speedstack PCB Stackup Design and Documentation



Goal seeking with Speedstack

Speedstack provides the facility to solve for horizontal
parameters (e.g. trace width and separation, ground strip
separation, etc.) to produce the target impedance (or
calculate that the target impedance is unachievable with the
current values).

Click the Goal Seek button to display the Set Up GoalSeek
dialog; the options available will depend on the controlled
impedance structure.

Set Up GoalSeek
Goal Seeking Farameter(s)
* W2 only
~
~
~
" H1 Only

" H2 Only
~

~

Ok Cancel

Click OK; the Speedstack attempts to arrive at the target
impedance by iteratively modifying the specified parameters.
It may be necessary to add or delete prepregs to achieve the
target impedance.

Goal seeking with the Si8000m/9000e

To Field Solver

Speedstack Stackup Builder is fully integrated with the
Si8000m/Si9000e Controlled Impedance Field Solvers.
Users can transfer Stackup layer dimensions to the Field
Solver, solve for stackup parameters to produce the target
impedance (or calculate that the target impedance is
unachievable with the current values) then transfer the
solved dimensions back to Speedstack.

Ensure the Field Solver is running and that its units match
the Speedstack units.

With the stackup parameters displayed in the Controlled
Impedance window, click To Field Solver to transfer the
current Speedstack parameters to the Si8000m/Si9000e.
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Paste from
Speedstack

Switch to the field solver and click the Paste from
Speedstack button to load the parameters into the
associated field solver fields. The field solver reflects the
structure and parameters of that selected in Speedstack.

Offset Stripline 1B1A

Tolerance  Minimurn — baximurn
B.uuonj‘tl 00000 | 60000 | E0DO0 Caloulate

|

| 42000 j | 00000 | 42000 42000 Caleulate

[ 90000+ 00000 [ 90000 [ 90000 Caloulats
Substrate 2 Dielectric B2 [ 42000 =} *[ 00000 [ 42000 [ 42000 Caloulate

|

|

|

Substrate 1 Height H1

Substrate 1 Dielectric En
Substrate 2 Height Hz2

Lower Trace 'Width W1 54378 = £[ o000 [ 53978 [ 5497
5.0 3Bjt| 00000 | 650136 | G0135  Caloulate
U.?Uunjtl 00000 | 07000 | 07000 Caloulate

Upper Trace Width W2
Trace Thickness T

Impedance Zo 50.00 50.00 50.00 Calculate
More...

For the data shown above seek a final value for impedance of
50 Ohms; H1, Er1 and T1 are fixed, so goal seek on W1,W2.

Click the Upper Trace Width (W2) Calculate button to goal
seek on trace width. The field solver returns new values for
trace width to produce 50 Ohms final impedance.

Lower Trace ' idth
Upper Trace ' idth

w1 | 5.aan?i,'t| 0.0000 | 59907 | 5.9907
W | 4.aan?i,'t| 0.0000 | 49907 | 4.9307

Copy to Speedstack

From Field Solver

Click the Copy to Speedstack button, switch to Speedstack
and click the From Field Solver button to display the solved
parameters for the target impedance.

Note: it may be necessary to round some dimensions (for
example, the dielectric heights) to the nearest practical
values and recalculate the impedance.

Changing layer functionality

It is often convenient to base a new design on an existing
stackup and then add or remove electrical layers to create
the new stack, leaving the previous existing structures intact
or to switch between layer types (Signal, Plane, Mixed,
Hatched) without removing structures.

Speedstack allows the designer to retain and re-allocate
structures when changes are made to the electrical layers of
the stackup. This enables reallocation of structures after the
following stackup changes:

Adding foils and/or cores — increasing the layer count
Deleting foils and/or cores — reducing the layer count

Moving foils and cores up and down, even beyond
another copper layer — maintaining the layer count but,
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for example, exchanging two different thickness cores
within the stackup

Copying and pasting foil or core — increasing the layer
count

Changing layer type — signal to plane, plane to signal,
mixed to signal or plane, signal to hatch, hatch to signal

Deleting a rigid core and adding a flex core — to maintain
layer count but swapping material type

Deleting a rigid core and adding two foils — to maintain
layer count but switching to an HDI type build

For the following examples, consider the stack below.

Liguid Photolmageable Mask 4.000
Copper Foil 0.700
PP PrePreg 1080 4200 1.950

1.400
Core FR4 Core 4200

PP PrePreg 3080 4200
PP PrePreg 1651 4200

PP PrePreg 1651 4200
Core FR4 Core 4200

PP PrePreg 1651 4200
PP PrePreg 1651 4200

PP PrePreg 3080 4200

Core FR4 Core 4200 3.000
1.400

PP PrePreg 1080 4200 1850
Copper Foil 0.700

Liquid Photolmageable Mask 4000

Switching layer types and reallocating structures

;" === =a= ===  Switch signal layer 2 to a plane layer and plane layer 3 to
Set Layer To Plane a S|gna! Iaye_r. Speedstack issues a warning |_nd.|cat|ng that
continuing with the change will require the existing
structures to be re-allocated.

Speedstack

l.-/'-_-'\- This action will invalidate some or all existing structures, You will be
W' ableto check and re-allocate them afterwards using the Structure

Validation and Structure Layer Properties options. Do you wish to
proceed?

Yes Mo
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Select Yes to confirm the change to the stackup. The stack
editor reflects the change in the stackup, layer 2 is a plane
layer and layer 3 a signal layer.

Liguid Photolmageable Mask 4.000

Co pper Foil 0.700

PrePreg 1080 1 ’ ________________________________________________________________ 1.950

FR4 Core

PrePreg 3080

PrePreg 1651

Speedstack also displays a flashing Rebuild indicator; due to
the changes to the stackup it is necessary to refresh the
structures.

Stack Up Editor | DRC: 5 Controlled Impedance | CI Resuits |
XS EE RS =gt
All |I=:| =:|_ }l}ll

4 Click the Rebuild and
» Recalculate icon —
Rebuild Speedstack displays

an information dialog
indicating which
structures need re-
allocating.

and
Recalculate

I.-”'_"\-.I The following structures require attention. Please re-allocate each
"W structure using the Structure Layer Properties option.

Layer: 1, Edge Coupled Coated Microstrip 18, 100 ochms
Layer: 1, Coated Microstrip 1B, 73 chms

Layer: 4, Edge Coupled Offset Stripline 1B14, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

Click OK then click the Structure Layer Properties icon to
reallocate the structures to the correct signal and plane
layers.

Stack Up Editor | DRC : 4 Controlled Impedance |1 Resus |

303 S i 6 (N 2 = s &
i'i'_{l 10of4 _}|j Sirur:ture Layer Properties

The Structure Layer Properties dialog includes two layer
columns, the Current layer column and the New layer
column. The Current column shows the Signal / Plane
stackup layers assigned to the structure before the stackup
was changed.
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The New column allows the structure to be re-allocated to
reflect the new stackup layer types.

Structure Layer Properties

crostrip 1B

pper Signal Layer |-| |-|

Lower Signal Layer I I

|Ipper Flane Layer |3 |2

Lol Lef L L

Lower Flane Layer I I

Structure Inverted IFalse
Mumber of Structures on same Ig [ Mowve All

Signal / Plane Layers

Apply | Cancel |

In this case notice the Upper Plane Layer is changed from
layer 3 to layer 2.

In many cases multiple structures will have the same Signal /
Plane layer assignments. In the example above Speedstack
indicates that there are two structures affected. Click the
Move All check box to re-allocate all matching structures in a
single operation then click Apply.

+* Rebuilding the stack indicates that other structures (i.e., the
™ | Rebuild and two structures on layer 4) also require layer reallocation.
Recalculate

PP PrePreg 1651

Core FR4 Core

PP PrePreg 1651
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&J Structure Layer
Properties

I.-”' OB The following structures require attention. Please re-allocate each
W' structure using the Structure Layer Properties option.

Layer: 4, Edge Coupled Offset Stripline 1814, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 chms

Use the structure selection arrow keys to step through to
the structures on layer 4 then click Structure Layer
Properties.

Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

s1_ w2

 —— ——

Upper Signal Layer [ 3 -]
Lower Signal Layer | | 7]
Upper Plane Layer 3 2 ]
Lower Flane Layer 6 |6 =l
Structure Inverted False

Number of Structures on same 2 ¥ MoveAl

Signal ! Plane Layers

Reallocate the layers as required then click Apply. With the
structures re-allocated Rebuild and Calculate the structures
as describer earlier.

Note that structure Trace Width and Separation parameters
are retained at their original values together with the Target
Impedance and Tolerance. (Depending upon how the
structures have been re-allocated it may be necessary to
goal seek the trace width and separation parameters to meet
the target impedance.)
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PP

Caore

PP
PP
PP

Caore

PP
PP
PP

Caore

PP

Increasing the layer count

It is a common requirement for designers to base a new
design on an existing proven stackup and then add or
remove electrical layers to create a new stack, leaving the
previous existing structures intact.

Consider the 8 layer stack below.

Liquid Photolmageable Mask 4.000

Copper Foil

PrePreg 1080
FR4 Caore
PrePreg 3080

PrePreq 1651

PrePreq 1651

FR4 Core

PrePreq 1651
PrePreq 1651
PrePreg 3080

FR4 Core

PrePreg 10380

Copper Foil

0.700
1.950
1.400

3.000

4200

4200

1.400
3.000
1.400
1950

0.700

Liquid Photolmageable Mask 4.000

For this example, add a core between layers 5 and 6.

Speedstack will display a warning that proceeding with the
change will require the existing structures to be reallocated.

I.-"'_"“- This action will invalidate some or all existing structures, You will be
W' ableto check and re-allocate themn afterwards using the Structure

Validation and Structure Layer Properties opticns. Do you wish to
proceed?

es Mo

Click Yes to proceed.

In order to maintain a symmetrical stack, delete the Prepreg
3080 materials and add Prepreg 1651 materials to create a
symmetrical 10 layer stack.
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Liguid Photolmageable Mask 4.000
Copper Foil 0700

PP PrePreqg 1080 4 200 1950

Core FR4 Core

PP PrePreg 1651
PP PrePreg 1651

Core FR4 Core

PP PrePreg 1651

PP PrePreqg 1651 4200
Core FR4 Core 4200

PP PrePreg 1651 4200 6.000

PP PrePreg 1651 4200 6.000

Core FR4 Core 4200 :

1.400

PP PrePreq 1080 4200 14950
Copper Foil 0.700
Liguid Photolmageable Mask 4.000

Rebuild and Recalculate  Click Rebuild and Recalculate

Speedstack displays an information dialog indicating the
structures that need reallocating.

Speedstack >

Layer: 4, Edge Coupled Offset Stripline 1B14A, 100 chms
Layer: 4, Offset Coplanar Strips 1814, 50 ohms

oK

Click OK.

Use the structure navigation buttons to select the structure
layer then click the Structure Layer Properties button to
display the Structure Layer Properties dialog.
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Structure Layer Properties

Edge Coupled Offset Stripline 1B1A

51 w2
——
1 1 H H

Upper Signal Layer |4 |4 j

Lower Signal Layer | | J

Upper Plane Layer |3 |3 j

Lower Plane Layer |.|; |5 j

Structure Inverted Falze

Mumber of Structures on same

Signal / Plane Layers Z el
Apply | Cancel

Note that for the modified stack the lower plane layer has
been reallocated to layer 8.

Click Apply and then Rebuild and Recalculate.

If necessary, goal seek on line widths to bring the impedance
within specification.

For the above stack edit the Drill Properties to finalise the
stack changes.

Repeat the procedure for each structure as necessary.

Structure net classes

Speedstack allows up to five Net Class names to be stored
with each structure. These net class names provide a link to
the matching impedance nets inside the ECAD PCB layout
system. Net classes are supported in Speedstack’s import /
export file formats.

Net class columns can be selected for display on the
technical report.
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i

Net classes

To display the Structure Net Classes dialog click the Net
Classes button

Enter the net class names in the text boxes and click Apply.

Structure Met Classes nl
Met Class 1 T
Met Class 2 TX1
Met Class 3 RX0
Met Class 4 RX1
Met Class &
Apply | Cancel |

Up to five net class names may be stored with each structure.

Click the Select Impedance Columns button and Select the
Net Class columns to display the net classes on the

Select Impedance :
P Speedstack technical report.
Columns
Select Controlled Impedance Table Columns — O X
Selected Columns Ayailable Columns
Impedance Signal Layer ~ <
Ref. Flane 1in Layer Broadside 2nd Layer
Ref. Flane 2 in Layer . Trace Pitch {51+ W1)
Lower Trace Width (W1) o Lower Ground Strip Width (1)
Upper Trace Width (W2) Upper Ground Strip Width (G2)
Trace Separation (51) Up Trace Offset {O01)
Target Impedance Ground Strip Separation (D1}
Tal {+/- %) o Substrate 1 Height (H1)
Calculated Impedance own Substrate 2 Height (H2)
Substrate 3 Height (H3)
NetClass2 Delete Substrate 4 Height (H4)
MNetClass3 Substrate 1 Dielectric (Erl)
NetClass4 Clear Al Substrate 2 Dielectric (ErZ)
NetClassh v Substrate 3 Dielectric (Er3) b
ok | cancel |
The chosen columns are displayed in the selected order.
Lowsr | Upper T —— ]
Impadancs | Red, Ref. | Trace | Trace [ Trace /
impadance | Structure |  Signal | Plana 1| Plane2 | Width | Width | Ssparation| Targat | Tol (s/-| Cakuisted
D Images Layor | inLayer| inLayer| (w1) | (w2} {51y | npedance| %) | impedance | NetCiass! | MetCisss? | MetCiassd | MetCisssd | MetClases

]

3

a

BI2a

T2

a.3m

100,000

10,000

=0
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Working with Si Projects in Speedstack and Si8000m/Si9000e

B

PP
PP
PP

Core

PP
PP
PP

To Si Project

Si Projects

The Si Projects feature incorporated in Speedstack and
Si8000m/Si9000e allows for easy transfer of controlled
impedance structures from the Speedstack stackup design
tool into the Si8000m and Si9000e field solvers.

Si Projects allows groups of structures to be saved and
recalled in Si8000m/Si9000e and entire stackups of
structures to be pasted from Speedstack into Si8000m and
Si9000e with just a few clicks of the mouse.

The To Si Project toolbar icon copies a group of structures
from Speedstack and places them onto the clipboard, these
structures can then be pasted directly into the Si8000m or
Si9000e Project group

Transferring structures from Speedstack to the field
solver

The stackup below in Speedstack's Stackup Editor contains
controlled impedance structures in the layers indicated by
the Ohms symbol.

Liquid Photolmageable Mask 4000

Copper Foil

PrePreg 1080

FR4 Core

PrePreg 3080
PrePreq 1651

PrePreqg 1651

FR4 Core

PrePreg 1651
PrePreg 1651

PrePreg 3080

FR4 Core

PrePreg 1080

Copper Foil
Liquid Photolmageable Mask 4000

0.700
4200 1950

1.400
4200

4200
4200
4.200

1.400
4200 12.000
1.400

4200
4200
4200
4200

4200

0.700

Click Speedstack's Controlled Impedance tab and use the
structure navigation controls to step through and display the
structures.
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Use the Si Project toolbar buttons in the Speedstack and
the Si8000m/Si9000e interface to transfer the structures via
the Windows clipboard to the field solver.

h

To Si Project

Switch to the field solver and paste the structures from the
clip board into the field solver Si project.

Al

|Paste?r-:|r‘r1 Speedstack into 5i Project

The complete set of structures appears in the field solver’s
Project window.

The Si Project window lists the transferred structures in layer
order, showing the layer number and value along with a
thumb nail graphic indicating the structure configuration.
Right click on a structure in the structure list to view the
structure options.

Add Structure to Project
Delete Structure from Project

Rename Structure within Project

Move Up

Mowe Down
Duplicate Selected Structure

Clear Project

Demo Mode: Load Sample Structures into Project
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Adding/deleting and modifying structures

Selecting each structure displays its associated graphic in a
grey background.

L1 100 ohms (1]

L1 75 ahms [2]

L4 100 ohmns (3]

L4 50 ahns [4]

LS 75 ohims [5]

Click the + and — buttons in the structure graphic to add
additional structures from the Si structure library or remove
selected structures from the Project folder. Click the Rename
Structure (the pencil icon) to assign the structure a
descriptive name.

+

4

L1 100 ohms (1)

With a structure selected the structure parameters can be
modified as required and the impedance recalculated.
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Frequency dependent loss calculations (Speedstack Si only)

=H

(2]

Properties

Frequency Dependent

Note: Frequency dependent loss calculations are available in
Speedstack only when used in conjunction with the Si9000e
Transmission Line Field Solver.

Speedstack Si (Speedstack stackup builder plus Si9000e
transmission line field solver) provides for calculations of
frequency dependent loss given the information applicable to
loss in the transmission line structure. The information
includes material properties, comprising dielectric constant and
loss tangent, conductor properties such as trace conductivity
and surface roughness and the frequency range over which the
transmission line structure will operate

Graphing against frequency is provided for impedance
magnitude, conductor loss and dielectric loss (with or without
roughness compensation,) inductance, capacitance,
resistance, conductance and skin depth. Graphing for
differential structures include differential, odd and even
modes.

Each structure in the stack includes a set of frequency
dependent properties.

Click the Frequency Dependent Properties icon to load the
Frequency Dependent Properties dialog.

Frequency Dependent Properties

Graph | Odd Mode | Even Mode

Edge Coupled Coated Microstrip 1B

— a x
) Result Presentation
leriieiins [ L1 £00.0000 & Length of Line ) fin Clim Sl
Trace Conductivity (Sm) ~ 1C [5a00E=07
Y (Sim) BB00E) Substrate Causal Extrapolation Reference Points e
Frequency Minimum (MHz)  FMin  [500 0000 ¥ Set Dielectric Constant (Er) from Stack Up materials @
Frequency Maximum (GHz)  FMax {00000 Set ¥ Set Loss Tangent (TanD) from Stack Up materials

Frequency Steps Fstep oo Mo D;;;EJH;J ; z'ﬁd Er |~??=T“D
Frequenoy of Interest (MHz)  Fren 10000000 S— S——

o i
Calculate H3 ’ir_a'nd‘ %a:hijo
:L —fore

[ dielgctricregion
Frequency dependent parameters | TR

Surface Roughness Compensation

" Smooth

& Hammerstad .
o e |
€ Huray ———  Edit..
Print Settings

¥ Include Loss Graph for this structure on the report

Surface roughness compensation models

= : Graph Settings
Edge Coupled Coated Microstrip 1B Display Series
Differential ’m
|mmm— Conductor Loss —‘ Dielectric Loss S Attenuation [——1 Conductor Loss with Roughness === Attenuation with Roughness Differential
0 E Differential -
E o]
w0 [ S = Loss Budget (dB)
B E e . — 0.0000 Refresh
&1 - i—-. —
&5 \ ___-._-.-q . Picked Data Point Information
o - . - Fi {MHz) - 9500.000
220 \_.__ — - Diclectic Loss (48) 2,764
5
é e ‘---.._____:-.__\
5 30 . Maximise | Print Export
E Loss v frequency graph B
835 - quency grap —
8 with conductor and dielectric logses 3
ERX Interactive
< .
45 graph settings
s0E
C1 L L L L L 1 1 1 1 1 L 1 L L L L L 1 1 1 1 1 L 1 L L 1 L L 1 L 1 1 L 1 1 L L 1 L L
1000 2000 301 4000 5000 6000 7000 8000 3000 10000

Frequency - MHz
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The Frequency Dependent Properties dialog includes:
the structure image of the selected structure

frequency dependent parameters for the user defined
frequency range and frequency of interest

a table of substrate causal extrapolation reference points
for each substrate dielectric/region

surface roughness compensation model selection
between Hammerstad, Groisse and Cannonball-Huray
methods

the loss v frequency graph showing the data series for
conductor and dielectric losses and total attenuation

interactive graph setting with data point selection allowing
drilling down to the underlying loss data

data tables for the selected frequency range

Graph Odd Mode | Even Mode ]

-

Frequency Impedance Impedance Impedance Inductance Resistance Capacitance | Conductance Skin Conduictor Dielectric Attenuation E:::mﬂ witahmatiDn
Real Imaginary Magnitude : Depth Loss Loss

Hz HAine Ohms/line F/line SAine dBAine Roughness Roughness
Ohms Ohms ms in dBAine dBAine

dBAine dBAine i

b SN SUGEO1 WSO SDSED MEM SN TZ0ETI oSSEOS LTBED |G LMEN  QseD AW w0 |
1.000E+09  5.048E+01 -2527E02 | 5.048E-01 3.060E-08 3.547E+00 1.201E-11 1.316E-03 8.228E-05 -3.051E01 -2.885E-01 -5.936E-01 -5.868E-01 -8.753E01 €
1.500E+09 5.051E=01 6.176E-02 5.051E+01 3.050E-08 4.334E-00 1.195E-11 1.974E-03 6.718E-05 -3.726E-01 4.33EN -8.057E01 -7 261E-01 -1.159E+00
2.000E+09 5.054E+01 1.140E-01 5.054E+01 3044E-08 4.998E+00 1.192E-11 2633603 5.818E-05 -4 295E-01 -5.778E-01 -1.007E+00 | -B.425E-01 -1.420E+00
2 500E+09 5.056E+01 1.455E-01 5.056E+01 3035608 5.583E+00 1.185E-11 3.291E-03 5 204E-05 -4 795E-01 72270 -1202E+00 | -9.443E-01 -1667E+00
3.000E+09 5.059E+01 1.765E-01 5.055E+01 3.036E-08 6.112E+00 1.186E-11 3.550E-03 4 750E-05 -5.247E-01 -BB77E-D -1392E+00 |-1.036E+00 |-1504E+00
3.500E+09 5.061E+01 1.574E01 5.061E-01 3.034E-08 6.598E-00 1.184E-11 4.608E-03 4.358E-05 -5.662E-01 -1013E+00  |-1579E+00  |-1120E+00  |-2.133E+00
4.000E=09 5.063E+01 21438 5.063E-01 3.032E-08 7051E+00 1.183E-11 5.267E-03 4.114E05 -6.048E-01 -1.158E+00  |-1.763E+00  |-1.198E+00  |-2.356E+00
4.500E+09 5.065E+01 2.255E-01 5.065E+01 3.031E-08 7.572E+00 1.181E-11 5.925E-03 3.879E-05 6452601 -1.303E+00  |-1953E+00 |-1287E+00 |-2591E+00
5.000E+09 5.067E+01 2.374E01 5.067E+01 3.029E-08 7.985E+00 1.180E-11 6.584E-03 3.679E05 -6.843E01 -1.449E+00 |-2133E+00 |-1.358E+00 |-2.807E+00
5.500E+09 5.069E+01 2478E-01 5.069E+01 3.028E-08 8.378E+00 1.178E-11 7.242E-03 3.508E-05 RAE: =1 -1.594E+00 |-2312E+00 |-1425E+00 |-3.020E+00
6.000E+09 5.070E+01 2568E01 5.070E+01 302708 8753E+00 1A77E-11 7S01E-03 3.355E-05 -7 A97E-D1 -1740E+00 |-2450E+00 |-1450E+00 |-3.230E+00
6.500E+09 5.072E+01 2643E-01 5072601 3.026E-08 5.114E+00 1.176E-11 8 555E-03 3.227E05 -7.804E-01 -1.885E+00 |-2666E+00 |-1551E+00 |-3.437E+00

7 nnnc.na En7aC.M 2716C M En7IC.n 2 NIRE No & ACiC.n0 117RE 11 & 1ec na 2 110C NE © nooc N 2 n91E.nn 7 081C.00 1c11c.nn 2 ca9C.nn

Frequency dependent parameters

Speedstack Si runs a detailed analysis of the transmission line
structure for controlled impedance and insertion loss. Each
structure in Speedstack can store a complete set of
frequency dependent parameters: Length of Lines,
Frequency Minimum, Frequency Maximum, Frequency
Steps, substrate data, surface roughness and loss budget.
Supply the values in the dialog below.

Length of Line E 40000000
Trace Conductivity (S/im) TC 5.300E+07
Freguency Minimum (MHz)  FMin  |500.0000

Frequency Maximum (GHz) FMax |1[:._|}|}|}[:-

Freguency Steps FsStep |20

Freguency of Interest (MHz)  Freg 5000.0000

Calculate
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Specify the line length and trace conductivity along with the
frequency range and frequency of interest.

To specify the frequency range click the Set... button and
enter the minimum frequency (in MHz) and maximum
frequency (in GHz); specify the frequency increment (in MHz)
then click Apply.

Frequency Entry n
Frequency Minimum (MHz)  FMin IW Apply |
Frequency Maximum (GHz) FMax |1|}_|}|}|}[}- Cancel
Frequency Increment (MHz)  Flnc IW

With all parameters entered, click Calculate. Results are
displayed in graphical and tabular form.

To provide for applications where the insertion loss
requirements or loss budget specifications are needed for a
given frequency the results for the specified frequency of
interest are highlighted in green in the table of data.

Presentation of results
Use the Result Presentation dialog to choose units in which
to present plots and tables of results.

Result Presentation

{* i ength of Line | " Jin " I'm

The graphs are able to display results in dB/line length,
dB/inch or dB/metre.

Click the unit of choice and click Calculate to refresh the
graphical display of data.

Graph settings

Use the Graph Settings dialog to choose the display series.

Speedstack Si graphs All Losses — conductor loss, dielectric
loss and total attenuation.

Display Senes

4 | osses ﬂ
Impedance Magnitude
Inductance
Resistance
Capacitance
Conductance
Skin Depth
Alpha Y
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If roughness compensation is applied the data series
conductor loss with roughness and attenuation with
roughness are added to the graph.

Edge Coupled Coated Microstrip 1B
Odd Mode

s Conductor Loss Emmms Dielectric Loss EEESSSE Attenuation [——= Conductor Loss with Roughness
1 Aftenuation with RoLllghness

U
- - - e —

All Losses with Roughness - dB/line
(%]
T

"--.._____-_.
"--.._‘_\-

/

a1 : S——

i

in

1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz

All losses with roughness

Speedstack charts are interactive. Click on a point on the
data series of interest to display the data point value in the
Picked Data Point Information text box

Edge Coupled Coated Microstrip 1B

Differential

055 BN Attenuation 2 Conductor Loss with Roughness
-
a— .
— _---"'""--...._____ . . Picked Data Point Information
_ e M : Frequency (WHz) - 9500.000
\ .....____._____ Diglectric Loss (dB) : -2. 760
_"‘--._\- S
AN N N A N T T T AT T ST S Y A
4000 5000 6000 7000 8000 9000 10000

Frequency - MHz

The range of data series includes losses, impedance
magnitude, inductance, capacitance and skin depth: Choose
the data series from the Display Series drop down.
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Edge Coupled Coated Microstrip 1B

Differential

@
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@
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Inductance - nH/line
(=3}
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@
=
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=
=

1000 2000 3000 4000 5000 6000 7000 8000 9000 10000
Frequency - MHz

Graph of inductance v frequency

Displaying the loss budget

A value for loss budget can be added to a graph. A loss
budget line will allow losses that exceed the budget to be
easily identified.

= = Graph Settings
Edge Coupled Coated Microstrip 1B Display Series
Differential |AII Losses ﬂ
e Conductor Loss B Dielectric Loss S Attenuation C——9 Conductor Loss with Roughness Differential
=——21 Attenuation with Roughness E="—"A Loss Budget ereme
£ 0 |Diﬁerential j
g | e ——r Loss Budast (d8)
% - B i ) e "_""'--..... ------------- —. Picked Data Point Information
3 T -""-'--..___.
=] —, M"*—-
i r e,
£ .30 S R‘—"“—'—‘. ""'---..____
= e
LI | e P S S — | SRS I — PR———— R Maximise | Print Export
gL ——
Z
S S 111 111 1 11 111 11 111 111 111 111 1
1000 2000 3000 4000 5000 6000 7000 8000 3000 10000
Frequency - MHz

The plot above indicates that the loss budget is exceeded by
the total attenuation (cyan) beyond 8000Mhz (8GHz.)

Setting the Loss Budget stores the value with the structure
for future use. This would prove useful if the stackupis
changed and it is necessary to ensure that the structure still
meets the loss requirements after the changes.

Material and surface roughness properties

The Speedstack graph above charts all losses, the dielectric
loss and the significant increase in the overall loss due to
surface roughness, allowing the materials supplier to isolate
the contributions of the different loss mechanisms.

Dielectric loss
In order accurately to calculate dielectric loss it is necessary
to understand the material / substrate properties.
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Speedstack Si allows substrate properties including dielectric
constant (Er) and loss tangent (TanD) to be specified for
each structure substrate region.

Substrate Causal Extrapolation Reference Points

Iv Set Dielectric Constant (Er) from Stack Up materials

[v Set Loss Tangent (TanD) from Stack Up materials
Freg (Hz) Ref Er Ref TanD

H1  [1000E+09  |4.2000 0.0195

] | |

T

H: | |

S | |

REr | | |

CEr  [1000E-09  |4.000C 0.0195

Speedstack Si causally extrapolates Er and TanD over the
specified frequency range using a single value of Er and
TanD to enable Svensson-Djordjevic frequency dependent
permittivity modelling for each dielectric layer in the current
controlled impedance structure. The table above therefore
provides the ability to specify the extrapolation reference
points for each substrate region; the reference point data is
usually available from the material supplier data sheets. The
values of Er and TanD can, optionally, be derived from the
materials in the stack. (See the Polar Application Note
AP8184 or the Si9000e User Guide for a more detailed
discussion of causally extrapolating substrate data.)

The fields shown active in the table in the dialog reflect the
structure selected; inapplicable fields are shown greyed out.

The fields shown above allow values to be specified for the
frequency of interest, the dielectric constant, Er, and loss
tangent, TanD for the prepreg dielectric and the coating.
Enter the parameters and click Calculate to refresh results.

Conductor losses — surface roughness compensation

In order to provide good adhesion between copper and
dielectric materials in core layers PCB materials vendors
control the roughness of the associated copper layers
(typically by chemical treatment). Speedstack Si provides
industry standard methods of compensation for surface
roughness in frequency dependent calculations; the
compensation methods include:

Smooth copper, (no compensation for Cu loss at all)
Hammerstad modelling

Groisse modelling

Huray modelling
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Speedstack charts dielectric losses along with conductor
losses and attenuation values that optionally include
compensation for surface roughness. Roughness is a
random quantity and is commonly specified in terms of the
rms (root mean square) height h of the surface unevenness
for the Hammerstad and Groisse compensation methods.
Huray modelling is based on a non-uniform distribution of
stacked copper nodules shapes resembling “snowballs”.

Surface roughness compensation methods
Accurate calculation of conductor loss requires the surface
roughness parameters for each method:

The Smooth copper option provides for no compensation for
copper loss.

Hammerstad modelling is a proven technique that has stood
the test of time but has practical limitations when used over
4GHz as the model tends to saturate.

Groisse modelling can, with care, be used to extend the
modelling up to 7 to 10 GHz before saturation in the model
blunts its accuracy.

Hammerstad/Groisse methods
To specify the roughness parameters for the Hammerstad or
Groisse methods, click the option button for the method:

Surface Roughness Compensation

" Smooth

¥ Hammerstad ]
" Groisse ]7 B
" Huray _— Edit...

Click the Hammerstad/Groisse Edit button.

Surface Roughness Compensation - Hammerstad / Groisse n

Surface 1 Roughness (RMS)  R1 D_200D| Spply |

Surface 2 Roughness (RMS)  R2 Iﬂ_zﬂ[ﬂ]
Cancel |

Surface Roughness Compensation

Enter the values for roughness in the R1 and R2 fields and
click Apply. Click Calculate to refresh results.
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Huray method
Huray modelling extends the roughness modelling validity up
to 40 to 50GHz (and possibly beyond).

Click the Huray option button:

Surface Roughness Compensation

" Smooth

" Hammerstad )
™ Groisse ]7 E-
% Huray _— Edit...

Click the Huray Edit button and specify the parameters for
the Huray spheres (snowballs.)

Surface Roughness Compensation - Huray

Courtesy of Bert Simonovich, Lamsim Enterprises Inc~ Application Note

Images by courtesy of Circuit Foil Luxembourg

(]

Ratio of Areas 1.0000) Apply |
Effective Ball Radius (pm) |{| 7500
i. Area of Ball Count (sq pm) 50,0000
" Number of Balls in Area R

By et

Ensble Cannonball-Huray [

|’Mat‘te—5ide Roughness

Rz Matte (um) |4.443D m

Rz Drum (pm) |3_[‘.~43D -

|'Drurn—5ide Roughness

Supply the values in the associated fields and click Apply.

If the Huray values are not available, click Enable
Cannonball-Huray and supply the Rz values for matte and
drum side roughness and click Calculate to populate the
Huray fields, then click Apply.

Click the Application Note link to access the paper Practical
Modelling of High-speed Channels Based on Data Sheet
Input (Bert Simonovich, LamSim Enterprises Inc.) which
includes a description of roughness modelling using the
Cannonball-Huray Model.
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Edge Coupled Coated Microstrip 1B
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Speedstack charts a range of data series, including losses,
impedance magnitude, inductance, resistance, capacitance
and conductance; for differential structures select the
transmission line mode, differential, odd or even mode.
Differential
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Click on the Display Series drop down to select the data to
be charted.
Display Series
[Skin Depth =]
Impedance Magnitude ~
Inductance
Resistance
Capacitance
Conductance
Skin Depth
Alpha
Beta b
The chart below displays skin depth v frequency
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Printing the technical report

The Speedstack Si technical report includes the stackup with
its stack data, the controlled impedance structures and
structure data, the drill data and loss data for each structure
in the stack.

Displayed loss data for each structure reflects the structure
type, the frequency dependent parameters, the substrate
causal extrapolation reference points, the surface roughness
method and settings, frequency of interest and associated
loss values for dielectric and conductor losses and total
attenuation and losses with roughness.

Edge Coupled Coated Microstrip 18

NI

Length of Line: 25 4

Frequency M
Frequency Steps: 20

Causal Points Surface Roughness Compensation: Huray
Freq (Hz) RefEr | RefTanD Ratio of Areas: 1 Frequency of Interest: 1000 MHz
Trace Conductivity: 5.8E+07 S/im H1 1.000E+08 | 4.2000 0.0195 Effective Ball Radius: 0.75 um Canductor Loss: -3.003E+00 dB/m
Frequency Minimum: 500 MHz H Number of Balls in Area: 32sq pm Dielsctric Loss: -2.840E+00 dBfm
10 GHz :l Area of Ball Count: 90 Attenuation: -5.843E+00 dBim
REr Conductor Loss with Roughness: -4.479E+00 dB/m
CEr T.000E+08 | 4.2000 0.0195 Attenuation with Roughness: -7 319E+00 dB/m

Click File|Print|Print Technical Report, Speedstack refreshes
the loss data results and displays them in high quality
graphical form.

Step through the pages to view the stack, impedance and
drill data and the frequency dependent loss graphs for each
structure in sequence in the stack.

CASpeedstack\Eval Imperial v13.stk

Units: Microns

- N
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Length of Line: 101600

Frequency Steps: 20

Trace Conductivity: 5.8E+07 Sim
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Frequency Maximum: 10 GHz

Substrate Causal Extrapolation Reference Points. Surface Roughness : Hammerstad
Freq(Hz) | RefEr | RefTanD Surface 1 Roughness (RMS) R1:5.08 Frequency of Interest: 1000 MHz
H1 1.000E+05 |4 2000 0.0185 Surface 2 Roughness (RMS) R2: 5.08 Conduator Loss: -3.003E+00 dBim
:§ Dielectric Loss: -2 B40E+00 dBim
H Atenuation: -5,843E+00 dB/m
RET Conductor Loss with Roughness: -5.7765+00 dBim
CEr TO00E=0S [42000 00735 Attenuation with Roughness: -& 615E+00 dB/m
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To Field Solver

From Field Solver

Paste Structure from
Speedstack

Copy Structure to
Speedstack

To Si Project

Paste from

Speedstack into Si Project

Speedstack Si to Si9000e data transfer

Speedstack and Si9000e incorporate the facility to realise
bidirectional transfer of all structure parameters (i.e. both
lossless and frequency dependent) for a single structure or
all structures via the clipboard.

Parameter transfer is accomplished via the data transfer
icons:

Single structures

Use Speedstack’s To Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Speedstack to the Si9000e

Use Speedstack’s From Field Solver icon to transfer the
parameters of a single structure via the clipboard from
Si9000e to Speedstack

Use the Si9000e’s Paste Structure from Speedstack to
paste the whole structure with all its parameters into the
Si9000e — the currently displayed structure will be replaced

With all calculations complete click the Copy Structure to
Speedstack to return the structure to the stackup in
Speedstack.

Multiple structures

Use Speedstack’s To Si Project icon to transfer all
structures as a project from Speedstack to the Si9000e

Use the Si9000e’s Paste from Speedstack into Si Project to
paste the set of structures into the Si9000e as a project.

Sharing structure properties

Each structure in Speedstack can store a complete set of
frequency dependent parameters, so each structure can
have its own Length of Line, range of frequencies (FMin,
FMax, FSteps and Frequency of interest) substrate data,
surface roughness compensation and loss budget.

Using the data transfer icons within Speedstack allows a
selected set of structure properties to be shared between
other structures on the same electrical layer on the stackup.

To share parameters between structures, select the source
structure (structure 1, Edge Coupled Coated Microstrip 1B.)

136 ¢ Speedstack PCB Stackup Design and Documentation



5E Polar Speedstack PCB Stack Up Builder:  Stack: Eval Imperial v13.stk  Project: Eval Imperial v13.sci - O X

File Edit View Tools Units External Utility Help

Esd

0

SUXO == %

7777 2T gl 20 AE
Stack Up Edtor | DRC 0 Controled Impedance | CI Resuts |

X EOEES =@
| e ||

Substrate 1 Height H1|161.29

%ii Select the Frequency Dependent Properties button to

Frequency Dependent  display the frequency dependent properties.
Properties

Frequency Dependent Properties - u] X
. . . Result
Edge Coupled Coated Microstrip 1B Length of Line L DD 001 IV(: T £ Jin Com | Close |
Trace Conductivity (Sim) ~ TC  [FB00E07
w2 - e  [RR00E-07 Substrate Causal Extrapolation Reference Points
A Frequency Minimum (MHz) ~ FMin  [so00000 Clear Results
| [¥ Set Ervalues from Stack Up materials
Frequency Maximum (GHz) FMsx [f00000 et Frea (Ho) B Ref TanD
Frequency Steps FStep [20 H1 1.000E+09 [4 2000 0.0195
Frequency of Interest (MHz)  Freq |—mﬂm H2 [ [
Calculate B [ I
! [ [
REC | I I
CEr [1.000E+03 [4.0000 0.0195
~Surface Roughness C
' Smocth
& Hammerstad -
- Grosss J—[E=]
© Huray Edit. |

Print Settings
[¥ Include Loss Graph for this structure on the report |

All the structure’s properties, including all the frequency
dependent parameters, will be available for sharing with the
target structure.

Close the dialog and click the To Field Solver button to copy
the parameters to the clipboard.

To Field Solver

Select the target structure (in this example, structure 2,
single ended Coated Microstrip 1B as shown below) and
click the From Field Solver button.

From Field Solver
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Coated Microetrip 18

R
L

-

Substrate 1 Height H1 [161.29
Substrate 1 Dielectric E1|4.2000
Lower Trace \Width W1 |114.30
lUpper Trace \width w2 13830
Trace Thickness T1 [17.78
Coating Above Substrate C1|25.40
Coating Above Trace C2 |25.40
Coating Dielectric CEFIW
Impedance Zo W
Target Impedance W
Target Tolerance % W

Speedstack displays the Paste Structure Properties dialog

Paste Structure Properties

Please select the Property Groups that yvou wish to paste to the selected structure:

Cancel

it

[ Impedance Parameters (H1, Er1, W1, W2, 51 etc)
[ Freguency Dependent Parameters (LL, TC, FMin, FMax etc)
|+ Substrate Causal Extrapolations Reference Points (Ref Freg, Ref Er, Ref TanD)

[v Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Select the properties to be pasted — in this case, the
impedance parameters are unchecked as the source
structure’s 100 ohm differential impedance does not apply.

The frequency dependent parameters, along with the causal
extrapolation reference points (frequency, Er and TanD) and
surface roughness compensation method are applied to the
target structure.
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Transferring structures between Speedstack and Si9000e

Speedstack Si is fully integrated with the Si9000e
transmission line field solver.

Users can transfer structures to the field solver for
processing then transfer the solved properties back to
Speedstack Si.

Transferring a single structure
Ensure the field solver is running. Select the structure to be
copied to the Si9000e

Stack Up Edtor | DRC: 0 Cortroled Impedance: | C1 Resuts |

XX EOD S = w @t

Al [1£] <|30f4 >|>I|

- PP PrePreg 3080

- PP PrePreg 1651

- PP PrePreg 1651

3 Core FR4 Core

e {53 PrePreg 1651 152.400

- PP PrePreg 1651 152.400

— PP PrePreg 3080 76.200

Click the To Field Solver button to transfer the structure
and all parameters to the Si9000e.

88 |7, Fiold Solver

Switch to the Si9000e.

Click the Si9000e’s Paste Structure from Speedstack
%E button to paste the structure complete with all impedance

Paste Structure from ; ;
Speedstack and frequency dependent parameters into the Si9000e.

The Si9000e displays the Paste Structure Properties dialog.

[EE Paste Structure Properties >

Flease zelect the Property Groups that you wizh to paste to the selected stucture:

[v Impedance Parameters [H1, Er, w1, W2, 51 ete]
Iv Freguency Dependent Parameters [LL, TC, Fiin, Fhas etc]

[v Substrate Cauzal Estrapolations Reference Points [Ref Freq, Ref Er, Bef TanD)

[v Surface Roughness Compenzation [Hammerstad, Groizse, Huray]

Choose which groups of properties are to be pasted into the
field solver and click Apply. The impedance, lossless and
frequency dependent properties are pasted into the field
solver for processing. The units setting in Speedstack will
replace the setting in Si9000e.

Solving for impedance

With the structure loaded into the Si9000e switch to the
Lossless Calculation tab to display the structure graphic and
lossless parameters.
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Edge-Coupled Offset Stripline 1B1A

Substrate 1 Height H1
Subsztrate 1 Diglectic Er
Substrate 2 Height Hz2
Substrate 2 Dielectic Er2
Lower Trace Width W1
Upper Trace width W2
Trace Separation 51
Trace Thickness T
Differential Impedance  Zdiff

Tolerance  Minimurn M aximum
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0.0000 [215.9000 [2159000 _Caleulate |
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0.0000 | 35,5600 | 355600 Caloulats |

I 100.00

| 100,00 | 100.00 (T

Specify the target impedance then click the Calculate button
for the parameter to be used in the goal seek (e.g. trace
width); with the target impedance reached switch to the
Frequency Dependent Calculation tab.

Running frequency dependent calculations
Enter the frequency dependent parameters, the extended

substrate data settings, the surface roughness compensation
method and values and click Calculate to refresh the results.
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Copy Structure to

Speedstack

For detailed Si9000e operation see the Si9000e User Guide.

With all calculations complete click the Copy Structure to
Speedstack to return the structure to the stackup in
Speedstack.

The Paste Structure Properties dialog is displayed.
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Paste Structure Properties

Please select the Property Groups that you wish to paste to the selected structure: Apply |

¥ Impedance Parameters (H1, Erl, W1, W2, 51 etc)
¥ Freguency Dependent Parameters (LL, TC, FMin, FMax etc)

Cancel

¥ Substrate Causal Extrapelations Reference Points (Ref Freg, Ref Er, Ref TanD)

¥ Surface Roughness Compensation (Hammerstad, Groisse, Huray)

Choose which properties are to be updated and click Apply.

Rebuild and calculate the structure in Speedstack. The
structure reflects the updated values.

Eile Edit View Teols Units External Utility Help

ﬁ.ﬂ-ﬁa
LY

B

Sl XO =& =ER 5 777727

Stack Up Edllurl DRC:0 Controlled Impedance |CI Hasuns|

XS EODL=w@nX
an|ie] <[3ota 55|

Substrate 1 Height H1 |692.91
Substrate 1 Dielectric Er1]4.2000
Substrate 2 Height H2 [388.11
Substrate 2 Dielectric Er2 |4.2000
Lower Trace Width Wi [191.97
Upper Trace Width W2 |166.57
Trace Separation S1 |215.90
Trace Thickness T1 |35.56
Differential Impedance za[100.00
Target Impedance 100.00
Target Tolerance % 10.00
[Master [Microns [Target Stack Up Thickness = 152400  [Stack Up Thickness = 1510.28 [Stack Up Thickness with Soldermask = 1561.08  [Beta V : 17.08.15343 A

Transferring multiple structures via Si Projects
To transfer all the structures in a stack use the Si Projects
transfer function incorporated in Speedstack Si and Si9000e.

Si Projects allows for transfer of all controlled impedance
structures along with all lossless and frequency dependent
parameters from Speedstack Si into the Si9000e field solver.

Si Projects allows groups of structures to be saved and
recalled in Si9000e and the updated structures pasted back
into Speedstack.

Frequency dependent loss calculations (Speedstack Si only) ¢ 141



The stackup in the example below contains four structures.

HE Polar Speedstack PCE Stack Up Builder  Stack : Eval Imperial v3.stk  Project : Eval Imperial v13.sci - O X

MG 7777 1T gl o0 =ME
Stack Up Edtor | DRC: 0 Controlled Impedance | i Resutts |
EXRTEAEL —w@h

File Edit View Tools Units Exernal Utility Help

Liquid Photolmagesble Mask

Substrate 1 Height B

Substrste 1 Dislectric Erl o200
Lawer Trace Width wi [215.30
Upper Trace Wiidth wi2 [190.50
Trace Separation s1 2612
Trace Thickness T1 [17.78
Coating Abave Substrate c1[za0

Liquid Photolmagesble Mask Costing Above Trace czlmm
Coating Between Traces c3[zma0
Costing Dislectric CErfa0000
Differential Impedance: zd[0035
Target Impedance 100.00
Target Tolersnce % 1000

M
[Microns [Target Stack Up Thickness = 1524 00 [Stack Lip Thickness = 1510 28 [Stack Up Thickness with Soldemask = 156108 |Beta V- 17,08 15543 4

Use the To Si Project toolbar icon to copy the group of four
structures from Speedstack Si and place them onto the

To Si Project clipboard; these structures can then be pasted directly into
the Si9000e as a new project.

Switch to the Si9000e and use the Si9000e’s Paste from
Speedstack into Si Project to paste the set of four
structures into the Si9000e as a project.

b

]

4 Paste from
Speedstack into Si
Project
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E L1 100 ohms (1)

L& 75 ohms (4] Differential

The Si9000e and Speedstack should automatically switch to
the units that were in use when the structure was copied.
(For instance, if Speedstack is in Mils and Si9000e is in
Microns and a structure is copied from Speedstack to
Si9000e the Si9000e should automatically switch to Mils.)
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| Rebuild and Recalculate

Displayed Structure

Rebuild and Recalculate
All Structures

The complete set of structures appears in the field solver’s
Project window in the same order as shown in Speedstack.

The Si Project window lists the transferred structures in
Speedstack’s display order, showing the order number and
impedance value along with a thumb nail graphic indicating
the structure configuration.

Modifying structures
Selecting each structure displays its associated graphic in a
grey background.

With a structure selected the structure parameters can be
modified as required and all values recalculated. The
recalculated structures can be pasted back into Speedstack.

To paste a structure back into Speedstack select the target
structure in Speedstack, switch to the Si9000e, select the
structure for transfer and use the transfer icons to update the
selected structure in Speedstack.

Click the Rebuild and Recalculate Displayed Structure to
refresh the displayed structure.

Click the Rebuild and Recalculate All Structures to update all
structures in the stack
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Creating CITS test files

& Set CITS Test

Speedstack can create CITS test file data for each controlled
impedance structure in the stack.

Select each structure and click Set CITS Test to display the
Edit Test data dialog; specify the CITS test parameters for
each structure to be tested and click OK.

Edit Test data
— Structure Details —Channel Select
Structure Description IOﬁ'set Coplanar Strips 1B1A
| ¥ Single Ende Probe 1D
Impedance 50.00 5 -
P Chan 1
S endleryes | 4
—Herizontal —Vertical
i Inches -
Units | =~ Ohms/Division 10 -
Test From |3
— Tolerance
Test To I?
¥ Locked
Test Method [Absolute |
- Plus Im 2
p
i |1D 3
* Default R -
= User

Exporting the CITS test file
With the test data specified for each structure, from the File
menu choose Export To|Export CITS File. Add descriptive

Board Details and notes as required.

Customer
Board Type
Part Mumber

Revision Mumber

IF‘uIar

|G308 back plane

[1234

|Rev D&

Click Make File and navigate to a suitable folder and save the

CITS (.cif) test file.
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Working with flex-rigid stackups

Speedstack Flex

Speedstack Flex allows PCB fabricators and OEM engineers
rapidly to create and document accurate and efficient flex-
rigid PCB layer stackups.

The graphical stackup display

The Speedstack Flex Navigator enables the board designer
to link and document as many cross sections as necessary
in order to fully document a flex-rigid build up.

Speedstack Flex supports documentation of common flex-
rigid constructions, including doublets where stacked pairs of
flex link two rigid sections of the flex-rigid construction
together (see graphic below.)

Flex-rigid stacks

Speedstack constructs a flex-rigid stack from an existing
stack to which will be added a series of sub-stacks. This
stack is referenced by Speedstack as the master stack. The
electrical layer numbers of sub-stacks are determined from
the master stack, so this stack should be created first.

The master stack is effectively a "bill of materials" stack and
contains all the materials used in all sub-stacks; i.e., the
master stack contains the full set of materials used in the
final stackup and documents each rigid and flex-rigid section
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with as many "sub-stacks" as needed for the design. There
are no limits to the number of sub-stacks or layer count of
the total build.

A range of materials including flexible adhesives, bondply
and FlexiCore can be enabled or disabled for each layer, and
impedance structures can be added to each sub-stack.

Mesh / Crosshatch ground planes

When used with Polar’'s Si8000m and Si9000e field solvers,
Speedstack Flex permits modelling and documenting
mesh/crosshatch ground planes from within the Speedstack
Flex environment. Mesh geometry and structure data can be
easily shared between Si8000m and Si9000e.

Internal Coverlays

Advanced rules allow impedance structures to be added
when coverlays exist internally within a stack. When a
coverlay is beyond the outer copper it will behave like a
coating, when internal it will behave like a bondply or prepreg.

Definable colours per material

Speedstack Flex can set and store individual material
colours via the material Properties dialog. This will help
ensure that special build requirements are obvious during
fabrication. This will be found useful for documenting plated
layers or highlighting specific material usage such as no-flow
prepregs and flexible cores.

Enabling Speedstack Flex/HDI
To enable Speedstack Flex/HDI select Tools|Options and

ensure the Licensing pane purchasable option Speedstack
Flex/HDI License check box is ticked.

Adding a flexible core
Create and save a symmetrical 6-layer stackup as shown in
the sample stack below
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Liquid Photolmageable Mask 1.000 1.000

Copper Foil

PrePreg 1080

PrePreg 1080

FR4 Core

PP PrePreg 1080

PP PrePreg

Core FR4 Core

PrePreg 1080

PrePreg 1080

Copper Foil

0.700
3.000 3.000
3.000 3.000

).700

3.000

3.000 3.000
3.000 3.000
0.3

2.000
3.000 3.000
3.000 3.000

0.700

Liquid Photolmageable Mask 1.000 1.000

Core FR4 Core

PP PrePreg 1080

PP

Core FR4 Core

PP PrePreg 1080

PP PrePreg 1080

PrePreg 1080

Flex Core

PrePreg 1080

This stack is referenced by Speedstack as the master stack
discussed earlier, this section describes adding a series of
sub-stacks to create the complete flex-rigid stack.

Ensure Symmetrical mode is off, right click the prepreg
above Layer 4 copper and add a flexible core:

Add Foil
Add C.l. Structure -
Full Stack Up Editor Mode RCC

3.000 L Flexible Core
Set to Signal

o A Bondply

3.000

e Set to Plane L

2 3.000

3.000

3.000
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Using the Navigator
Press F4 to display the Navigator

. Decking

Colours

Refresh

Right click the Navigator and choose Docking|Float to allow
the Navigator window to be resized. The Navigator will move
with Speedstack’s Stack Editor. Choose Free to allow the
Navigator to move independently of the Stack Editor.

Adding stacks

Adding stacks, for example, to form a flex-rigid structure or to
illustrate the press cycles of an HDI build, can be achieved
by:

¢ defining the layers of the new stack

e duplicating the master stack and disabling materials
selectively

Defining new stacks defined by layers
New stacks may be added, defined by layers of the master
stack. Choose Add Stack|Defined by Layers:

.Add Stack » Duplicate Master

Remowve Stack . Defined by layers

It will be necessary to choose layers in the master stack to
be the top and bottom layers of the new sub-stack and to
position the new stack relative to the original stack.

Use the drop-down controls to select the top and bottom
layers and position the new stack.
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Top Layer |3 LI
Bottom Layer el
-, 4
Pasition Stack —|5
&
Far Left 7 Far Right
I 9 [
10
Substack Root Name |Master
foply | Cancel

The starting and finishing layers (derived from the master
stack) form the top and bottom layers of the sub-stack; the
new stack is positioned relative to the current stack, choose
a descriptive sub-stack root name and click Apply.

Adding a flex stack Defined by layers

Select the stack in the Navigator window and click Add Stack
and choose Defined by Layers

Select Stack |
| Add Stack J Duplicate Master
Remowve Stack | Defined by layers |

From the drop-down list choose Layer 4 as the Top Layer
and Layer 5 as the Bottom Layer as shown below and enter
Flex as the Substack Root Name.

Top Layer |4 LI
Bottom Layer I 5 ll
Position Stack
Far Left Left Right Far Right
i i o i
Substack Root Name |Flex
Apply Cancel
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The new stack reflecting the top and bottom chosen layers is
added to the Navigator in the specified position (to the right
in the example below.)

Each sub-stack can be renamed individually as required.

ClLay Coverlay

FC Flex Caore

- Clay Coverlay

Click the new stack — the selected stack is reflected in the
Stack Editor and listed in the status bar.

Adding materials to the sub-stack
Select Symmetrical mode, in the Stack Editor click the new
core and add a coverlay above.

0.700
3.000 3.000
0.700

The coverlays are added symmetrically about the core.
Changes made in the Stack Editor are reflected in the
Navigator. Click into the Navigator — use the mouse wheel to
resize.

m
See 3D View

The Navigator can display in 2D or 3D views. Click on the
See 3D View button to display a 3 dimensional view of the
stackup
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The new stack with its added materials appears in the
Navigator; clicking each stack in the Navigator displays it in
the Stack Editor and allows editing as described earlier to
add controlled impedance structures, change layer types,
add non-copper layers, etc.

Adding a new stack Duplicating the master
Right click the Navigator and choose Add Stack|Duplicate
Master, rename the new stack and click OK.

o [ [P RCre

The new stack is added to the Navigator. Click on each stack
to display it in the Stack Editor and then edit as required.
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Copying and pasting stacks

To copy a stack in the Navigator select the stack, choose
Copy and Paste Stack, then from the dialog below choose
the position of the new stack

Position new stack. ..
Far Left Le=ft Right Far Right
o [ [ [
Apply | Cancel

Removing stacks
To remove a stack right click the Navigator, choose Remove
Stack and select the stack to be removed.

= e

SubStack01
SubStack(?

Aligning materials in the navigator
On occasions, adding a flexible stack results in misalignment
between layer materials displayed in the navigator, for
example, between the bondply and coverlay layers and the
associated prepreg layers — see the graphic below.

To move the layers into alignment, select the stack in the
Stack Editor and use the FlexNav Move Up and FlexNav
Move Down commands from the Edit menu.
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In the example above select the flexible stack in the Stack
Editor, select the upper Coverlay layer and shift the layer up
into alignment with the prepreg layer in the rigid stack (use
the Ctrl + Shift + Up arrow keys)

Repeat the alignment for the bondply and lower coverlay
materials (using the Ctrl + Shift + Down arrow keys.) The
materials are displayed aligned in the navigator — below.

To return the stack to its original alignments, from the Edit
menu Reset All NVDP (Navigator Visual Display Position)
Attributes.

The navigator display is reproduced in the Technical Report

. ]
-
. | Sttt —
I | | |
I

Y w
I —eed

[+] [4)]
P m—

Master flex Sub stack 3
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The technical report also supports different materials on the
same dielectric layer, improving the clarity of documentation
between the stackup designer and fabricator.

Displaying the stack in Proportional View

Speedstack can display the stackup so that the material
thicknesses are shown proportional to each other. Select the
stack in the Stackup Editor and from the View menu choose
Proportional Stack Viewer.

4 000 1.000
2.800

4 260 20.000
1.400

3.940 5.000

3.940 5.000

1.400
.4.000

1.400

4.000
1.400

44.000
1.400

3.940 5.000
3.940 5.000
1.400
4.260 20.000
2.800
4.000 1.000

This visual aid will be found useful when considering the
dielectric thicknesses between electrical layers.
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Using the Ruler within Proportional view
Select the stack in the Stackup Editor

63.500
101.600

76.200

101.600

63.500

Switch to Proportional View and click the ruler on.
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‘Distance:

Zoom in as required and use the ruler to measure material
dimensions, thicknesses, trace widths, etc.
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Working with HDI builds

Speedstack HDI

For HDI PCB fabricators, Speedstack HDI provides the
flexibility to quickly calculate the possible impact of
substituting alternative materials to improve manufacturability
and reduce cost while maintaining the specified parameters
and performance of the board.

Easy graphical stackup display

The HDI navigator provides a rapid guide through the
sequential sub-stack lamination sequence and presents the
complete assembly in a parsed graphical display that shows
each phase of the multi-step lamination sequence of an HDI
PCB. User-definable settings within the navigator allow
engineers to display layers in transparent, invisible or 3D
mode.

Sub-stack reordering

Speedstack Navigator makes re-ordering and renaming sub-
stacks quick and easy in HDI builds; sub-stacks can be
simply moved left or right within the Navigator window.

HDI builds

Use the Speedstack Navigator to document HDI press/drill
cycles. Speedstack can document press cycles based on foil
locations or drill start and end layers.

Sequential plan

The Sequential plan command creates sub-stacks that
represent each press cycle in a sequential lamination from
the Master stack based on foil locations.

Dirill plan
Using Drill Plan, Speedstack determines the sub-stacks by
the start / end layers of the drills.

Creating the target stack with the Stack Editor

Consider the target stack below — it will require three press
cycles. Build and document the stack in the Stack Editor.

Switch to 2D View.
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Liquid Photolmageable Mask
Copper Foil

PrePreg 1080
Copper Foil
PrePreg 1080

FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

PreFreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil
PrePreg 1080

Copper Foil
Liguid Photolmageable Mask

With the target stack completed use the Navigator's Add

Stack to document each press cycle, building up the stack in
the Navigator. Press F4 to start the Navigator and display the
master stack.
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Click Add Stack to copy the stack and name the new sub-
stack Press cycle 2.

Stack Name IF‘ress cycle 2

— Board Thickness

Target Stack Up Thickness IEE.EEE'I
Fositive Tolerance % I'H]'
Megative Tolerance % I'H]'

—Copy into new stack. . ..

[¥ Impedance Structures
¥ Motes

[~ File Properies

QK Cancel

The new sub-stack is copied into the navigator window.

To edit the sub-stack to illustrate the press cycles, click the
sub-stack to display it in the Stack Editor.
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Disabling materials in the sub-stack
Utilize the Stackup Editor to add the drills and to disable the
materials that are added in each press cycle.

s Note that if Symmetrical mode has been selected, material
L] will be disabled both at the top and bottom of the stack.
i Symmetrical Mode

With the sub-stack selected in the Stackup Editor, right click
the sub-stack, select the materials to be disabled —i.e., in
this case the materials added in the final press cycle, see the
graphic below — and choose Flex-Rigid and then choose
Disable Material

Flexi-Rigid L] Enable Material
Disable Material
Toggle Material Selection

PrePreg 1080

FR4 Core

FR4 Core

PrePreg 1080

Disabled materials are shown in blue and will be removed
from the sub-stack display to illustrate the press cycle.

The Navigator now displays the press cycle alongside the
master stack.
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The sub-stack can be displayed either to the right or left of
the master stack. Right click the sub-stack and from the
context menu choose Move Left.

Sub-stack Press cycle 2 is now shown to the left of the
master stack.

Press cycle 2

To add the next press cycle, right click the sub-stack and
choose Copy and Paste Stack and position the new sub-
stack to the far left.
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Pesition new stack. ..
Far Left Left Right Far Right
v [ [ [
Apply Cancel

Modify the new sub-stack, disabling materials added in the
first press cycle, in the Stack Editor as previously described
and display the completed stack in the Navigator.

Each press cycle appears as a separate stack, progressing
from left to right, in the Navigator.

Exposing the cores

In the fabrication process the manufacturer will process all
the core materials first, prior to bonding where each core is
interleaved with prepreg materials. It is sometimes useful,
therefore, to see all the core materials on a single sub-stack.

Right click the Navigator window and choose HDI
Build|Expose Cores to display the core layers.
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Using the Sequential Plan

Sequential Plan creates sub-stacks that represents each
press cycle in a sequential lamination from Master stack
based on foil locations. Consider the 14-layer stack below —
this stack will need several press cycles to manufacture.

Liguid Photelmageable Mask

Copper Fail

PrePreg 1080
Copper Foil

PrePreg 1080

FR4 Core

PrePreg 1080
FR4 Core

PrePreg 1080
PrePreg 1080

PrePreg 1080
FR4 Core

PrePreg 1080
Copper Foil
PrePreg 1020
Copper Foil
PrePreg 1080

Copper Foil

Copy |

Ligquid Photolmageable Mask

Opening the Navigator will display the completed master
stack (shown below) in the Navigator window.
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Right click the Navigator window and choose HDI Build
|Sequential Plan and name the sub-stacks:

Substack Root Name |Press Cycle

Mo Elind Mechanical Vias v

fpply | Cancel

Click Apply — the Navigator displays the 4 press cycles

Choose HDI Build|Expose Cores — the cores are displayed in
the Navigator window alongside the press cycles.

Using the Drill Plan

The HDI Build|Drill Plan creates sub-stacks that represents
each press cycle from the Master stack based on drill start-
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end layers. Consider the stackup below — a 10 layer
sequential lamination construction.

Liquid Photolmageable Mask
Copper Foil

PrePreg 3113

Copper Fail

PrePreg 1080
FR4 Core

PrePreg 1080

PrePreg

PrePreg 1080

FR4 Core

PrePreg 1080

PrePreg 1080

FR4 Core

PrePreg 1080

Copper Foil

PrePreg 3113

Copper Foil

Liquid Photolmageable Mask

Press the F4 key to open the Navigator

Master

The completed Master stack is displayed. Right click the
Navigator and choose HDI Build|Drill Plan.
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HO! Build J Sequential Plan
. Drill Plan |

Expose Cores

Rename Stack...

Supply the Sub-stack root name — the name willl be used
when numbering the press-drill cycles.

Substack Root Name |Press-Drill Cycle |

Mo Elind Mechanical Vias v

spply | Cancel |

Click Apply — Speedstack documents the build-up stages of
the sequential lamination.

Press-Drill Cycle 02

Exposing cores
Right click the Navigator and choose HDI Build|Expose
Cores — the cores are shown alongside the press cycles.

There are no limits to the number of press cycles that may
be documented.
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Working with multiple press cycles
The stack below is a 24 layer stack with multiple press-drill
cycles. Open the Navigator, choose HDI Build|Drill Plan.

Printing the Navigator screen

From the File menu choose Print Technical Report —
Speedstack prints the Navigator screen with its press cycles
along with individual stack data, impedance data and drill
data tables.
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Using Speedstack materials libraries

The materials libraries are collections of the materials used
in the process of designing stackups. Users can create and
manage their own libraries of board materials or use
libraries pre-built and provided by material suppliers. Using
> pre-built libraries can ensure accuracy and save
_aﬁ considerable time during stackup design. Speedstack allows
Materials Library libraries to be created and materials added. Up to date
libraries of materials may be downloaded from the Polar
Online Material Library. Click the Materials Library button to
display the Materials Library window.

Working with the materials libraries

When Speedstack is started the materials library specified as
the default materials library file (selected via the
Tools|Options|File Locations dialog below) is opened.

File Locations |

Select default matenials library file

C\Program Files (xBE)\FPolarSpeedstackiSamples'\Speedstack Imperial mibi Browse...

The dialog includes the data grid displaying the contents of
the loaded library and the associated library filter.

Each library component type is accessible via its associated
tab. Click on each tab to view or edit the component type.

§= C:\Program Files (x86)\Polar\Speedstack\Samples\Speedstack Imperial.mibx

ol B ek B FETE F)

Filter
Field Operand Criteria Logic Row Filter

| 5 || 5| | El
| 5 || 5| | El
| 5 |l 5 | | El
| | El
| | El

G|l G ||
G || =l

Fols | Prepregs | RCCs  Cores | Solder Masks | Ident Inks | Peelable Masks | Covertays | Bond Ply | Adhesive | Fiexible Cores | Shieids |

Type - | Suppiier Supplier Dascription | Description | Stock Number | Dislectric Base Thickness | Dielectric Finished Thickness| Dislectric Constant | LossTangent | UpperCu Base Thickness | LowerCu Base Thickness | ResinContert [Tg | =
b FR¢  PolerSamples  COM001 FR4 Core 400001 508 508 42 00135 17.78 17.78 75 180 |
FR¢  PolarSamples FRé Core 400002 50.8 50.8 42 0.0135 35.56 35.56 75 180
FR4 Polar Samples FR4 Core 400-002 508 508 42 0.0135 7112 7112 75 180
FRé  PolarSamples 400004 76.2 762 42 00135 17.78 17.78 60 180
FR&  PolarSample: = 400005 76.2 76.2 42 00135 35.56 35.56 60 180
FRa Polar Sample: 400-006 762 762 42 0.0135 7112 7112 60 180
FR¢  PolarSamples 400007 1015 1015 42 0.0135 17.78 17.78 53 180
FRé  PolarSamples 400008 1016 1016 42 00135 35.56 35.56 53 130
400008 1016 1016 42 00135 7112 7112 53 130

FR4  PalarSample

FR¢ 400010 127 127 42 0.0135 17.78 17.78 50 180

FRé 400011 127 127 4.2 0.0135 35.56 35.56 50 130

FR4 400012 127 127 42 0.0135 7112 71.12 50 180

FR¢ 400013 152.4 152.4 4.2 0.0135 17.78 17.78 47 180

FRe 400014 152.4 152.4 42 0.0135 35.56 35.56 47 180

FR¢ 400-015 152.4 152.4 42 0.0135 7112 7112 47 180

FR¢ 400015 2032 2032 4.2 0.0135 17.78 17.78 45 180

FRe 400017 2032 2032 432 0.0135 35.56 35.56 45 180 —

FR¢ 400-013 2032 2032 42 0.0135 7112 7142 45 180

FR& 400013 3048 3048 42 0.01%5 17.78 17.78 45 180

FRe 400020 3048 3048 42 0.0135 35.56 35.56 45 180

FR¢ 400-021 3048 3045 42 0.0135 7112 7112 45 180

FR4  PolarSamples  C0i022 o 400022 533.4 533.4 4.2 0.01%5 17.78 17.78 41 180 -
4 3

(Click on a material row to edit it
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Materials library toolbar

Use the toolbar to load and save libraries, import or export
libraries, arrange data columns or access the online or on-
premise libraries. The Toolbar and button functions are
shown below.

ERIT;

il

3
b
.

+ 4

Exit library

| Clear materials library

Open materials library

Open and Append

Save materials library

Clear current data table

Import CSV library

Export CSV library

Select & arrange column fields

Save column order

Load column order

Library lock

Online / on-premise library

Library filter toolbar
Use the library filter toolbar to filter materials by data field

Y%
Y

Set filter

Clear filter
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-

Open Materials
Library

Open and Append
Library

Opening a library
To open, or load, a library, click the Open Library icon and

browse to the library; click Open — the currently loaded
library will be replaced.

Opening and appending a library

To open a library and add the materials to an existing
library click the Open and Append Library icon, browse to
the library and click Open: the material will be added to the
existing library table.

Filtering Materials

When adding or swapping materials, available materials
(Foils, Prepregs, etc.) are listed in the associated material
library data grid. Lists can be filtered for materials matching
desired parameters (for example, dielectric thickness, Er,
loss tangent, etc.)

Filter
Field Operand Cnteria Logic Row Filter
I =l =l I =l Y% | Y
I =l =l I =l
I =l =l I =l
I =l =l I =l
I =l =l I =l
To list only materials matching required characteristics,
specify the criteria in the filter drop-downs and text boxes
and apply the filter.
Filtering for an exact match
For example, to select materials with a dielectric base
thickness of 3.937 mil select the field and operand and
specify the criteria, then click Apply.
Filter
Field Operand Criteria Logic Row Filter
| Base Thickness EE x| [3.937 | | BaseThickness = 3.937
I =l || I = hix E
I = =] I =
I = =] I =
| =l =l I =
Foils ] Prepregs | RCCs  Cores l Solder Masks ] Ident Inks ] Peelable Masks ] Coverays ] Band Ply ] Adhesive ] Flexible Cores ] Shields ]
Type Supplier Supplier Descripti Description Stock Mumber Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant Loss Tangent
» FR4 PolarSamples  CO/007 FR4 Caore 400-007 3.937 3.837 42 0.0185
FR4 PolarSamples CO0/008 FR4 Core 400-008 3.937 3.937 42 0.0185
FR4 PolarSamples CO0/009 FR4 Core 400-008 3.937 3.837 42 0.0185

The matching materials are displayed, along with the row
filter criteria.
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Filtering with multiple criteria
Multiple conditions may be specified with AND/OR logic.

Filter
Field Operand Criteria Logic Row Filter
|BaseThickness j |= j |3 937 |AND “ W BaseThickness = 3.937 AND UpperCuThickness = 1.378
|UpperCuThickness j |: j |1.3?E |

| =l =l |
| =l =l |
| =l =l |

Foils ] Prepregs | RCCs  Cores ]Solder Masks ] Idert Inks ] Peelable Masks ] Coverays ] Bond Ply } Adhesive ] Fexible Cores ] Shields ]

L Ll L] L 1]

Type Supplier Supplier Descripti Description Stock Number Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant Loss Tangent | UpperCu Base Thickness
13 FR4 PolarSamples  CO0/002 FR4 Core 400-002 3.937 3.837 42 0.0195 1.378

Use the AND/OR logic field to add each new condition:

Example: BaseThickness = 3.937 AND UpperCuThickness =
1.378 AND DielectricConstant = 4.2 AND LossTangent < 0.02

Apply Filter . ey .
The conditions are shown specified in the graphic below.
Filter
Field Operand Criteria Logic Row Filter
[BaseThickness ~|[- | [3937 [anD ~| BaseThickness = 3.937 AND UpperCuThickness = 1.378 AND DielectricConstant = 4.2 AND LossTangent <
[UopertuTrickoess = B = [0 = Y| Y (o
|D|ele::lncCun€Iam j |: ﬂ ‘4.2 |AND ﬂ
[LossTangent =1« =|joo2 [ ~|
| =l =l | =l
Fails ] Prepregs | RCCs  Cores ISo\der Masks] Ident \nks] Peelable Masks I Co\tedays} Bond P?yl Adheslve} Flexible Cores I Shlelds]
Type Supplier Supplier Descripti Desecription Stock Mumber Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant Loss Tangent | UpperCu Base Thickness Lower Cu Base Thickness Resin
» FR4 PolarSamples  CC/008 FR4 Core 400-008 3.937 3.937 4.2 0.0185 1.378 1.378 53
Filtering for an inexact match with Like
Use the Like operand to to search for a specified pattern in a
column. Use wildcard characters * or % to represent zero or more
characters.
For example,
Like *1080 returns all lines ending in “1080”
Like *1080* — below — returns all lines containing “1080”
Filter
Field Cperand Criteria Logic Row Filter
|Descri|:|ti0n ﬂ Like ﬂ |'1DED Description Like 1080

| |
| = = |
| =l = |
| =l = | =
| =l = | =

Foils ] Prepregs | RCCs  Cores lSoIder Masks ] Ident Inks ] Peelable Masks l Coverays ] Baond Ply ] Adhesive ] Flexible Cores l Shields ]

3%/ %

Description Diglectric Base Thickness Diglectric Finished Thickness| Dielectric Constant | Loss Tangent | Upper Cu Base Thickness | Lower Cu Base Thickness | Resin Content
| d 11080 a4 64 362 0.0083 18 18 57
1x1080 54 64 3.62 0.0028 35 35 57
121080 64 G4 362 0.0083 T 70 57
121080 76 76 3.5 0.0032 18 18 63
121080 76 76 3.8 0.0082 35 35 63
121080 76 76 35 0.0082 T0 70 63
1x106/11080 102 102 3.58 0.00% 18 18 53
1x106/1%1080 102 102 3.58 0.008 35 35 53
1x106/1:1080 102 102 3.58 0.003 0 70 539
1x106/11080 109 108 3.54 0.0082 18 18 61
1x106/1:1080 109 109 3.54 0.0082 35 35 81

‘& Click Clear Filter to return to displaying all materials.

Clear Filter

On exiting the library window, Speedstack prompts to save
the library.
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Creating a new library

To create a new library, click Clear Library to clear the
currently loaded materials; the library is removed from the

Clear Library library manager.

Import materials (usually supplied in comma separated
Import CSV Library ~ Values format) as described below and save the library.

Loading the new library at start up
Click Save Materials Library and supply a name and

jﬁﬂ destination folder to create the new library.

EL

5 | Save Materials To have the library load as Speedstack starts, specify it as
Library the default materials library file via Tools|Configuration

Options|File Locations as described earlier.

Importing material to the Speedstack materials library

Speedstack allows users to add existing material lists
(usually supplied from the material manufacturer’'s data
sheets) to its library; material data must be arranged in the
format and order used by the Speedstack library.

Library materials can be imported from the Polar Online / On-
Premise Library or from local library files.

Importing from local material files
Prior to importing the material data file ensure the file is not
open in another process (for example, in Microsoft® Excel®.)

ﬁk Click the Speedstack Materials Library button to open the

= import CSV Library Library, and then click Import CSV Library to open the

Import Library dialog.

o WPk [EE TTE %% &

Filter
Field Operand Criteria Logic Row Filter
| =l =l | = Y% | Y
| =] = | =
| =l =l | =
| =] = | =
| =] = | | =
Foilz ] Prepregs ] RCCs Cores ] Solder Masks ] Ident Inks ] Peelable Masks ] Coverlays ] Bond Ply ] Adhesive ] Flexible Cores ] Shields ]
Type Supplier Supplier Description | Description | Stock Number | Dielectric Base Thickness Dielectric Finished Thickness| Dielectric Constant | Loss Tangent
4 FR4 PolarSamples  CO/001 FR4 Core 400001 50 50 42 0.0185
FR4 PolarSamples  CO/002 FR4 Core 400-002 50 50 4.2 0.0185

When importing materials set the Import options in the Import
Library dialog: specify the units, delimiter and material type
and specify whether the material will be used to clear the
current data table or append to the existing library.
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Import Library
|nits for Import Delimiter File Type Exasting Data Table
Import

* Microns * Comma Fails * Clear

RCC —
' Mils/Thous " Tab PrePrei ' Append 43"*

" Millimetres " (Other SolderMasks
|dents

" Inches Peelables
Coverdays
BondPly
Adhesive
FlexCaores
Shields

Replacing existing material tables

Choose the Clear Existing Data Table option and choose the
field delimiter type. The library import function can accept
files in a variety of formats: tab delimited, comma separated
and Excel worksheet and template formats but must match
the arrangement of the supplied sample files with columns in
the correct order. Specify the units for import, file delimiter
and choose the file type (Foil, RCC, Prepreg, etc.) and click
Import. Navigate to the file via the Open dialog and click
Open. Repeat the procedure for every file type to be
imported. Save the resulting files as .mlbx library files.

Adding material data to an existing library

To add material data to an existing library table, open the
library, click Import CSV Library, click the Append to Existing
Data Table and click Import.

Navigate to the .csv or .txt file and click Open. Save the
modified library file as a .mlbx file.

Exit the library when all file types have been imported.

Adding new material to the data tables
Caution: ensure consistency of units

When defining dimensions, e.g., layer thicknesses, for a
stackup ensure that all measurements are defined using the
same units (mils, mm, etc.) throughout the structure and its
associated libraries.

Open the library to be modified. To add individual materials
to a library, click the associated component type tab; click
onto a material, or empty line. An editing box will open which
will contain the material clicked on, or the last material in that
type library.
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Review/Edit Cores

Supplier

Supplier Description
Description

Stock Mumber

Type

Base Thickness
Finished Thickness
Dielectric Constant
Loss Tangent
Resin Content

Tg

Td

CAF Resistance

Z Mxis Expansion

Tolerance +-%
Upper Cu Thickness
Lower Cu Thickness

Cost
Lead Time

Planes Both Sides

Laser Drillable

Add Delete

Size
[cosnz2 o
|FR4 Core
|400-022
|FR4
Mote 2
|540.00
|540.00
42 Mote 3
0.0195
|41
[180
|D Mote 4
o
o
[10 MNote 5
[18.00
[18.00
|22
o
o
-
-
«< | < 22of 29 > | = OK

The material can be edited or deleted, or a new material can
be added. To speed up the process of adding families of
materials, when a material is added the properties of the last
material are copied to the new material. The details can then
be edited. Clicking OK will add any new materials to the end
of the list.

Importing material to the data tables

Speedstack allows users to add existing material lists to its
library; material data must be arranged in the format and
order used by the Speedstack library.

Contact Polarcare@polarinstruments.com

Library sample files

Sample files for all material types in comma separated value
format and Microsoft Excel spreadsheet and template
formats suitable for importing to Speedstack are available on
request from Polar Instruments.
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Click the Materials Library button to open the Library, and

== b
E@n Import CSV Library then click Import CSV Library to open the Import dialog.

Import Library
|Inits for Import Delimiter File Type Exaisting Data Table
: |mipaort
* Microns * Comma Fails * Clear

RCC E—
" Mils/Thous " Tab PrePrei (' Append 43"*

" Millimetres " (Other SolderMasks
|dents

" Inches Peelables
Coverdays
BondPly
Adhesive
FlexCaores

Choose Clear or Append to Existing Data Table as
appropriate.

Creating a new materials library table

Choose Clear Existing Data Table, click Export Library as
CSV and choose microns as units and the field delimiter type
and click Export. The data table is exported as a “template”.

Open the file in a suitable text file editor — the file below is
opened in Microsoft Excel and shows the file header rows
with the column headers in the order and format expected by
the Speedstack library manager. Add the material data to the
associated columns and save in text format. As noted above,
templates for all materials are available on request from
Polar Instruments. Contact polarcare@polarinstruments.com

H - = Foil.csv - Excel
HOME INSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW Muance PDF

A3 v I
A B T D E F G H ] K L il N
1 |[*Foil
2 |*Type Supplier Supplier Description Description Stock Number Cu Thickness Cost Lead Time Motes 1 Motes2 Motes 3 Motes4 Motes5 Size
3 | |
4
3
6

Empty Foils library table

The library import function can accept files in a variety of
formats, tab delimited, comma separated and Excel
worksheet and template formats.

Sections of the sample files suitable for Speedstack are
shown below.
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A B C D E F G H 1
1 "Cores!
2 |* Dielectric Dielectric
3 *Type Supplier Supplier Description Description Stock Number Upper Cu Thickness Lower Cu Thickness Base Thickness Finished Thickness
4 FR4 Polar samples CO/001 FR4 Core 400-001 0.018 0.018 0.05 0.05
5 FR4 Polar Samples CO/002 FR4 Core 400-002 0.035 0.035 0.05 0.05
6 |FR4 Polar samples CO/003 FR4 Core 400-003 0.07 0.07 0.05 0.05
7 |FR4 Polar samples CO/004 FR4 Core 400-004 0.018 0.018 0.075 0.075
8 FR4 Polar Samples CO/005 FR4Core  400-005 0.035 0.035 0.075 0.075
9 |FR4 Polar samples CO/006 FR4 Core 400-006 0.07 0.07 0.075 0.075
10 FR4 Polar samples CO/007 FR4 Core 400-007 0.018 0.018 0.1 0.1
11 |FR4 Polar samples CO/008 FR4 Core 400-008 0.035 0.035 0.1 0.1

Sample Cores library file in Microsoft Excel format

* COres,,u555023030303333023333
*, 1122, 0ielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,Dielectric,,,,,,,,

*Type,Supplier,Supplier Description,Description,Stock Number,Upper Cu Thickness,lLower Cu Thickness,Base Thickness,Finished Thickness,
Content,Tg,Td,CAF Resistance,ZAxisExpansion,ExcessResin,Tolerance,Cost,Lead Time,Notes 1,Notes 2,Notes 3,Notes 4,Notes 5,5ize
FR4,Polar Samples,CO/@@l,FR4 Core,420-001,0.018,0.018,0.05,0.05,4.2,75,180,0,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,C0/@@2,FR4 Core,400-002,0.035,0.035,0.05,0.05,4.2,75,180,0,0,0,0,10,0,8,,,,,,*

FR4,Polar Samples,(0/603,FR4 Core,400-003,0.07,0.07,0.05,08.085,4.2,75,180,0,0,0,0,18,0,0,,,,,,*

FR4,Polar Samples,C0/@@4,FR4 Core,480-004,0.018,0.018,0.075,0.075,4.2,60,180,0,0,0,0,10,0,0,,,,,,*

Sampile library file in comma separated format

Files for importing into the library must be in the above
format, with columns in the correct order.

Specify the delimiter if necessary and choose the file type
(Foil, RCC, Prepreg, etc.) and units for import and click
Import and Clear or Append as required.

Choose the file from the list displayed in the Open dialog and
click Open. Repeat the procedure for every file type. Save
the file as a .mlbx library file.

Exit the library manager when all file types have been
imported.

Adding material data to an existing library

To add material data to an existing library, open the library
click Import CSV Library, click the Append to Existing Data
Table and click Import.

Choose the .csv or .txt file and click Open. Save the modified
Library file as a .mlbx file.

Selecting Materials from the Library

Column Order (Materials Library)

The default setting displays all columns. The columns
displayed and the order they are displayed can be set in the
materials Library form.

Arranging Columns in Library Forms
The Library windows can be customised in respect of which
columns to display and in which order.

Using Speedstack materials libraries ¢ 177



Columns; the dialog associated with the selected material

A Click the Go to Materials Library button and select Arrange
Arrange Columns  tab (Foils, Prepregs, etc.) is opened.

Select Prepreg Fields

Selected Columns HAwailable Columns

Supplier ~
SupplierDescription

Description

Stock Number

BazeThickness

Finished Thickness

DielectricConstant

Loss Tangent

ResinContent

Tg

Down

(et

Td Delete
CAFResistance

ZhxisExpansion .
ExcessHesin v Clear All

oK | Cancel ‘

The Left box of the dialog shows the columns that will be
displayed and the order top to bottom is the order they will be
displayed left to right in the library window.

Click OK to return to the Materials Library, which will show
the columns as set.

Until the column order is saved the column order is only

Wm available during the current session. Click Save Column

& Save Column Order ~ Order to define the selected column order as the default
order whenever the program is run.

E Load Col ord Click Load column Order to apply a saved column
oad tolumn traer arrangement.

Locking the library

The materials library can be locked and password
protected to prevent unauthorised or accidental editing. If
no password has been set the Material Library remains
open for any changes and modifications.

Library Lock

To lock the library, click the Library Lock button and supply
a password; the library is then locked and any editing
requires the password to be entered (via clicking on the
padlock). Once unlocked it will remain unlocked until
Speedstack is closed or the padlock is clicked again.
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Using the Online Library

The Online Library comprises the most up to date copies of
the material files supplied from materials manufacturers who
are members of the Polar Speedstack Supplier Partner
program. Each new version of Speedstack adds new and
updated materials to the Polar online library; utilisation of the
online library requires access to the internet.

Importing from the Polar Online Library

To add materials (Foils, Prepregs, etc.) from the online (or
on-premise) library, choose the Open Materials Library icon
and click the Online Library icon highlighted below.

5E C:\Program Files (x86)\Polar\SpeedstackSamples\ Speedstack Imperial. mlbx ] ks

ol e  EE FTE %% w(a)

Supplier Supplier Description
» PolarSamplas FOW001
PaolarSamplas FOJ002
PolarSamples FOv002
*

Online Library
Prepregs ] RCCs ] Cores ] Solder Masks ] Ident Inks ] Peelable Masks ] Coverlays ] Bond Ply ] Adhesive ] Flexible Cores ]
Description Stock Mumber Cu Base Thickness Type Cost
Copper Foil 100-001 0.7 Copper 1
Cappar Fail 100-002 14 Cappar 2
Capper Foil 100-003 23 Copper 3

Speedstack connects to the Polar Online Library and
displays the materials available for each file type from all the
suppliers in the Speedstack Supplier Partner program; click
on a material supplier's name in the Filter by Supplier pane
to view just the materials available from that supplier.

Online Library

Filter by Supplier File Type Library Files Available : All . p
Fails TUC_TU_872_SLK_10GHz_2001 mibx ~ Qr\ppen
i RCCs TUC TU 872 SLK_Sp_10GHz_2001 mibx
Jm All Su p pl Iers g TUC_TU_883_10GHz_2001 mlbx Sz
Cores TUC_TU_883_Sp_10GHz_2001.mlbx
SolderMasks TUC_TU_533_10GHz_2001 mlbx r
Idents Ventec_tec_speed_1_0_VT_464(M)_1GHz_1901.mibx S
Peelables Ventec_tec_speed_2_0_VT_464 1GHz_1501mlbx Use this option to
Coverays entec tec speed 2 1 VT 461 1GHz 1501 mlbx clear data from
] u BondPly Ventec tec speed 20 0 VT 870PP 10GHz 1501.mlbx the existing
Adhesives Ventec_tec_speed_3_0_VT_4B4L_1GHz_1901mibx library data table
FlexCores Ventec_tec_speed_4_0_VT_462(L)_1GHz_1501 mibx
Shields entec_tec_speed_5_0_VT_464G_10GHz_2303 mlbx
Ventec_tec_speed_5_0_VT_464G_1GHz_2303 mibx
Ventec_tec_speed_5_0_VT_464G_1MHz_2101 mlbx
A Ventec_tec_speed_5_0_VT_464G_20GHz 2303mibx v
Filter by Frequency Library Files Selected during this session
& Al
A TEFHAL S FENT ELEC TROMGOS i" BGHz B0 GHz
" 10GHz  75GHz
File Access Mode

* Online Polar Library ( fip://polarinstruments .com )

" On-Premise Mode Application Note

C:“Users"Ralph'AppData'.Roaming*Polar.Speedstack \Material Library Browse... Download...

Please Note: This data is accurate to the best of our knowledge, however it is provided, as is from our Material supplier partners. Please feedback any errors or
inaccuracies to Polarcare and we will contact the material partner for clarification or rectification.

Filtering libraries by frequency
Material libraries contain values for dielectric constant (Dk)
and loss tangent (Df) measured at frequencies specified by
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the supplier. The measurement frequency is indicated in the
library file name.

Use the Filter by Frequency function to list all files or just the
files with Dk and Df specified at the chosen frequency.
Speedstack provides frequency filtering at 1GHz, 5GHz,
10GHz, 20GHz, 50GHz and 75GHz.

On-Premise libraries

To download a copy of the online library to a local folder,
click the Download... button. The library will be downloaded
and saved by default to the following local folder:
C:\Users\username\AppData\Roaming\Polar\Speedstack\Ma
terialLibrary

Where access to the online library is unavailable or a local
copy is required, a complete set of the online libraries is
available on request to Polarcare subscribers; contact
polarcare@polarinstruments.com with your Polarcare
contract number and Speedstack version. The supplied
libraries should be copied to a suitable local folder with the
file/folder structure preserved.

To use the on-premise library, choose On-Premise Mode
and browse to the local copy: the library files should appear
as a local online library; import materials as described above.

Downloadable mlbx files
Note that the Online Library only lists files with .mlbx
extensions and that follow the file naming conversion:

<Supplier>_<MaterialFamily>_<frequency>_<release>. mlbx
(No spaces are permitted in downloadable library file names.)

All .mlIbx file names reflect the frequency at which dielectric
constant and loss tangent is specified and the Speedstack
release version.

Although the .mlbx file format will support multiple material
types (Foils, Prepregs, Cores, etc.) in the same file the
downloadable .mlbx file only contains a single material type.

Choosing material files

Browse through the list of available materials or scroll
through the list of suppliers and choose a supplier to filter the
materials by that supplier.

Choose the File Type and material. From the Existing Data
Table dialog select Append to add the new materials to the
table. Click the Clear checkbox to replace the contents of the
selected table type
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Repeat for each material to be added to the library then click
Close.

Note: Many organisations connect to the Internet via proxy
servers to provide caching and controlled access. In some
cases, a proxy server may return library content in a format
that prevents successful download into Speedstack. If your
organisation connects to the internet via a proxy server, you
may need to request the MIS department to grant address
ftp://polarinstruments.com permission to bypass the proxy
server — if this is not possible the libraries can be supplied for
local (on-premise) access (see above.)
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Printing stackup information

To print the stackup information, from the File menu choose
the Print Technical Report command to open the Speedstack
Report Printer.

Print Technical Report includes:
e Stack data columns
e Controlled impedance structure data columns
e Drill data columns
¢ Bill of Material data columns
e Frequency dependent loss graphs for each structure

along with frequency dependent properties and information
entered into the Stack File Properties.

. Speedstack Report Printer

File Options

v e ) (L | A S 2

- Ba [
\ﬂ& Sy ew oo DO Display Page -

& -2 P M S W
CONFIDENTIAL
== ol

C:AProgram Files (<B6)\PolariSpeedstackiSamples\Eval Impesial. sci

‘(‘Aml.aya Base
Type

Processed
Layer Stack up Description Thickness | Resin Content | _&r

Thickness.
M-5683 L1
L I Lauid Photimageable Mask 1000 4000
1 I'y IJEE A A A A A A B B A copef Signal 0.700 1400
r'y I ] PreFreg 1080 3.000 1850 60.000 4.200
2 / 8 /A & /& S S S S S & signal 1.400 1400
| FR4Core 3.000 3.000 60.000 4.200
3 1 Plane 1400 1400
= ] PraPrag 3080 3.000 278 60.000 4.200
C ] PrePreg 1651 £.000 5.552 47.000 4.200
E ] PrePreg 1651 6.000 5552 47.000 4.200
4 el @ = A A Jo Jan o N Ay Y \ Signal 1.400 1400
: : - ﬁ | FR4 Core 12.000 12,000 46.000 4.200
H 8| 8| & 7§ v W v ¥ ¥ ¥V VvV v Signal 1.400 1420
C ] PrePreg 1851 £.000 5552 47.000 4.200
T | PraPrag 1651 6,000 5352 47.000 4.200
= ] PrePreg 3080 3.000 2778 60.000 4200
8 ] Plane 1.400 1400
| FR4Core 3.000 3020 60.000 4.200
7 \ o I L v v v e Signal 1.400 1400
\ 4 I ] PrePreg 1080 3.000 1.950 60.000 4.200
2 Y (I W W W W W W W W W cwri Signal om0 1400
v Liquid Photolmagsale Mask 1000 4,000
414818
‘Copper Thickness = 11.200 | Diefectric Thickness = 49.660 | Solder Mask Thickness = 2.000 |
Stack Up Thickness = 60860 | Stack Up Thickness with Soldermask = 62,860
Stack Up Cost = 54.00
Lower | Upper Coaling
Trace | Trace Trace ‘Substrate | Substrate Ret. Ref. Above
Structure Target | Calculated | Width | Width | Thickness | 1Height | 2 Height | Plane 1 | Plane 2 | Substrate
Image Surucure Hame impedance [ Impedance | (W1) [ (W2) (T1) (H1) (H2) | inlayer | inLlayer| (C1)
Q Coated Microstrip 18 75.000 75.740 4000 3000 1400 6.350 0.000 3 a 1.000
Q E£dge Coupled Coated Microstnp 18 100008 100 230 7850 6650 1400 8350 0.000 3 [] 1.000

Stackiame: 10 Coniol

Drawing No: v1.03 Associated Documants: Revision: [Modification: Date of Revision: | Editor

Date: 01 08 2022 1.01 41112022 NIM

Desigrar. RRE 102 Tz SEW T %-
Deparment Eng Modal 103 1182022 FRE ] L]

Office._Garenne Park CONFIDENTIAL
Coppript it sty & pressotston copprige © P et Lid
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Speedstack Report Printer toolbar

The Speedstack Report Printer toolbar provides shortcut
access to the most commonly used printing commands.

e O AT EE- B HERSFEAQQE D0 wwwr—

Use these commands to set up the printer, page orientation
and margins, font size and printing order, select data columns
for display, display or suppress data tables and choose the
on-screen zoom levels. Button functions are described below.

Send report to printer

Print set up — choose printer, print range, copies

Page set up — orientation and margins

Print all pages

HBE E |

Print range of pages (display Page Range dialog)

From To

4o

Okay

Select page range

Select stack data columns

Select impedance data columns

Select drill data columns

Select BOM data columns

Change font size

Select stack/drills/impedance/notes print order

Set note field aliases
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][+][ ][ Show expanded drills — toggle wide stack
and narrow stack image

_‘_l
: ? Toggle suppress stack data table
—

H? Toggle suppress controlled impedance data table

Toggle suppress frequency dependent loss graphs

I
? Toggle suppress drill data table

Toggle suppress BOM data table

{'ﬂ 'x-?l&

Zoom in / Zoom out

Fit page to viewer

00
(|68 o5

Preview one / two / four pages

Display Page |1 -

Select page for display

Speedstack Report Printer menu system

File menu
Use the File menu under the Printing window to save and
load print settings.

Save Print Settings
Load Print Settings

Exit Ctrl+ 0

Click Save Print Settings and specify the Print Settings file
name and location. Click Load Print Settings to load a saved
Print Settings file.

Whichever settings were last used in a session will become
the default when the Printing window is next loaded.
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Options menu

The Speedstack Report Printer Options menu contains all
the settings for printing.

Print Setup

Page Setup

Stack Data Table Bl
Controlled Impedance Data Table ¥
Frequency Dependent Loss Graphs >
Drill Data Table »
E.0.M. Data Table »
Footer Bl

Mote Field Aliases

Print Order

General ¥
Confidential...

Restore Default Settings
Restore Default Table Fields
Restore Default Table Fields (Legacy)

Print Setup

Use the Print Setup command to choose the target printer,
along with its properties, the range of pages to print and
number of copies. Optionally, click the Print to file check box
to save the output to a file (for example, to save the file as a
document in PDF format) when printed.

Page Setup
Page Setup displays the Page Setup dialog to change the
paper size and source and page orientation and margins.

Stack Data Table

The Stack Data Table commands allow for optional display
of stack parameters, drills, thickness totals and tolerances.

Choose Stack Data Table, Suppress to hide the stack data
table and the associated columns selected for display via the
Stack Data Columns... command.
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Suppress

Stack Data Colurnns...
Show Drills (Stack Table)
Show Thickness Totals
Show Stackup Cost
Show Hatch Profile Data

L T

Show Finishing Class Data

%

Show Expanded Drills {(will widen materials celurnn)

Show Stackup Thickness... *
Show Stackup Thickness Telerance Yalue As... »
+  Show Stackup Thickness (Solder mask-5clder mask)

" Show Stackup Thickness (Laminate-Laminate)

Stackup Thickness Decimal Accuracy ]

Stack Data Columns...
Choose Stack Data Columns... to select and order the data
columns available for the stack as required.

Select a column from the Available Columns list, move it to
the Selected Columns list and use the Up and Down buttons
to order the displayed columns.

g Select Stack Table Columns — | ot
Selected Columns Lyszilable Columns
Description Supplier A
Copper Layer Type Supplier Description

Stock Mumber
Type

Base Thickness
Processed Thickness

Resin Cantent Min Trace Width
Er Up Tolerance
Loss Tangent Tg
Impedance D 0 Td
Finish Thickness own Ink Thickness
Copper Coverage Colar
Izolation Distance Delete Mask Thickness
Isolation Distance (Summed) Data Filenames

o Cost

Clear All Lead Time o

QK Cancel

The stack data table is displayed in selected column order:
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Stack ‘ Description ‘ Type Thickness

Isolation
Distance

Thﬂnnss‘ Resin Content umranp-‘ [} Tll'nln!ss‘ Coverage | Distance

Copperlayer| Base | Processed Finish | Copper | Isolation
up o (Summed)
I i1 Photolmageable Mask 25400 4000 00195
1 £WN AR AR A M CopperFoil Signal 17.780 17.780 1.2 17780 0.000
PrePrag 1080 76200 49530 60.000 4200 00195 76.200 49530 49530
H signal 35,560 35.560 35560 0.000
| FRd Core 76.200 76.200 60.000 4200 00195 76.200 76200 76200
3 | Plane 35.560 35560 35560 0.000
] Prafreg 3080 76.200 70,510 60.000 4200 00195 76.200 70510 352,352
| Prefreg 1651 152400 141021 47.000 4200 00185 152,400 141021 -
] Prefreg 1651 152400 141021 47.000 4200 0.0195 152,400 41021 -
4 ] Signal 35.560 35.560 3 35560 0.000
= | FR4 Core 304800 304800 46000 4200 00195 304.300 304800 304800
5 ] Signal 35.5680 35580 35560 0.000
| Prafreg 1651 152400 141021 47.000 4200 0.0195 152,400 141021 352552
| Frefreg 1651 152400 141021 47.000 4200 00185 152400 141021 -
| Prefreq 3080 76.200 0510 50.000 4200 00195 76.200 70510
& | Flane 35.560 35.560 35560 0.000
| FR4 Core 76.200 76.200 60.000 4200 00195 76.200 76200 76200
7 Signal 35.560 35560 35560 0.000
Prefreg 1080 76200 49530 50.000 4200 00195 76.200 49.530 43530
8 2| W W W W CoperFoll Signal 17.780 17.780 4 17780 0.000
I Liquis Phowimageable Mask 25400 4000 00135

Copper Thickness
Stack Up Cost =

=248 570 | Dielectric Thickness = 1261.364 | Solder Mask Thickness =50 800 | Stack Up Thickness = 1510.284 | Stack Up Thickness with Soldermask = 1561084
S4.00

Use the Show Drills (Stack Table) command to show or hide
the drills in the stackup graphic in the Stack Table.

The Thickness Totals provides optional display of the sum of
materials thicknesses, copper, dielectric, solder mask and
the stackup — with and without the solder mask thickness.

Copper Thickness = 284480 | Dinlectric Thickness = 1261.364 | Solder Mask Thickness = 50,800
Stack Up Thickness = 1545844 | Stack Up Thickness with Soldermask = 1596.644

Use the Show Stackup Cost option to display the cost in the
stack summary.

Select Show Hatch Profile Data to include the hatch pitch and
width and copper area percentage in the stack summary.

The Show Finishing Class Data displays the copper finishing
class specified from the list of Copper Finishing classes —
either a Copper Coverage Fishing Class or a Simple
Percentage Finishing Class — depending on which finishing
method was chosen via the Tools|Set Finishing Method.

Show Expanded Drills

By default, the Stack Data Table shows just the first six drill
slots in the stack (Stackup Columns in the Add Dirill dialog),
although up to eleven drill slots may have been defined. Use
Show Expended Drills to view all defined drill slots.

h A
1 1 A E A AR ] 1 I A 0N 00 ER R) L
Fy= - ) s FEﬁ - I /= @
3 E H 3 E I ] :3
C [ o [ T4 @
C o C - v 3
0 = B ] — | [ == B
e o ] R == b
C i o /0 [@
[ i C /0 [@
C D C EZ/=l5
[ 5 { | —
, £ =4 ? E =7=1
"_E% L \ AN - 3
3 L 4 [ & | ) 8 |'__'| 1 F
A \J
Standard Drill display Expanded Drill display

Use the Show Stackup Thickness commands to display or
hide the target or calculated values of total stack thickness.
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Values can optionally include solder mask and laminate
thicknesses.

£ S i Proomageable Mask
1 'y ] l:l ;| A & & & CopperFoi
4T i) | FrePreg 1080
2 [0l & & & &
| FRd4 Care
3 |
[ | FrePreg 3080
1 | PrePreg 1651
[ | PrePreg 1851
4 gl B = A & & & &
=l =2 = t | FR4 Core
5 Bl b| = w W W W w
O | FrePreg 1551
1 | PrePreg 1651
[ | FrePreg 3080
& |
| FRd4 Core
7 I:f ] W W W W
v i | | BrePreg 1080
8 v LI W W W W Copperfo
r Liquid Photolmageable Mask

When the target value of the Stackup thickness is chosen the
Stackup Thickness Tolerance values can be displayed as
percentages of the target stack thickness or as actual values.

Choose Stackup Thickness Accuracy to display accuracy by
number of decimal places.

Controlled Impedance Data Table
Use the Controlled Impedance Data Table options to show or
hide the controlled impedance structures and parameters.

Suppress

Impedance Data Columns...
Show Structures-by-Layer Separator
Sort Structures in SE/Diff Order Per Layer

Impedance Data columns can be selected for display and
ordered as required. Choose the parameters for display from
the Available Columns pane and change the order of display
using the Up and Down buttons.
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g Select Controlled

Selected Columns

Impedance Table Columns

Available Columns

Structure Image
Structure Mame
Target Impedance

Trace Thickness (T1)
Substrate 1 Height (H
Substrate 2 Height (H
Ref. Plane 1in Layer
Ref. Plane 2 in Layer

Lower Trace Width (W1)
Upper Trace Width (W2)

Coating Above Substrate (C1)

Impedance 1D

Impedance Signal Layer
Broadside 2nd Layer

Trace Separation (51)

Trace Pitch (51+W1)

Lower Ground Strip Width (G 1)
Upper Ground Strip Width {G2)
Trace Offset {01)

Ground Strip Separation (D1)
Calculated Impedance

Tal {+/- %)

Substrate 3 Height (H3)
Substrate 4 Height (H4)
Substrate 1 Dielectric (Er1)

oK

o
S

Up
1)

2 Down

Delete

Clear All

ddudas

W

Cancel

Grouping structures by layer

Within the Impedance Data Table structures can be grouped
by layer; choose Show Structures-By-Layer Separator. The
Separator will add a black structure separator bar on the
print out between structure groups, allowing the structures to
be sorted by layer number rather than the order that the
structures are added to the stack.

Lower | Upper Coating
Trace | Trace Trace Substrate | Substrate Ref. Ref. Above
Target Calculated | Width | Width | Thickness | 1 Height | 2 Height | Plane 1 | Plane 2 | Substrate
Struciure Name Impedance | Impedance | (W1) {wa2) {T1) {H1) (H2) in Layer | in Layer {C1)
Coated Micrastrip 12 75.000 5,870 114300 B8.500 17.780 161.250 0.000 3 o 25.400
=dge Coupled Coated Migrosing 1B 100,000 100,350 213,300 120,900 17,780 161.250 D000 ] o 3400

Lot Zinplne 18

Sorting impedance structures by type
The technical report, by default, prints the structures within a
layer in the order in which they were added to the stack.

In the example stack below the structures were added to the
stack in the order shown.
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Lower Upper
Impedance Ref. Ref. Trace Trace Trace

Impedance | Structure Signal Plane 1| Plane2 | Width | Width | Separation Target | Tol {(+/-| Calculatad
2 Image Struclure Namea Layar in Layer | in Layer | (W1} {W2) (51) Impedance %) Impedance

1 E Edge Coupled Coated Microstrip 18 1 3 0 8.500 7.500 8.115 100000 10,000 100.350

E Coated Microstrip 1B 1 a i} 4.500 3.500 0.o00 75.000 10,000 75870

E Coatad Microstrip 18 1 3 0 11,476 10476 0000 50.000 10,000 49.520

E Edge Coupled Coated Microstrip 1B 1 a i} 12.542 11.542 10.000 85.000 100000 BE.220

Structures within each layer can be grouped by type, single
ended and differential.

To sort the structures by type choose the Sort Structures by
SE/Diff Order per Layer; the structures within each layer will
be ordered in single ended then differential order as shown

in the graphic below.

Lower Upper
Impedance Ref. Ref. Trace Trace Trace
Impedance | Structure Signal Plane 1 | Plane 2 | Width Width | Separation Target Tol {+/-| Calculated
[ Image Struclure Name Layar in Layer | in Layer | {W1} {W2) (51) Impedance ) Impedance

E Coated Microstrip 18 1 3 a 4.500 3.500 0000 75.000 10,000 75.870
E Coated Microstrip 18 1 3 ] 11476 10476 0.000 50.000 10,000 49.520

E Edge Coupled Coated Microstrip 16 1 3 a 8.500 7.500 B115 100.600 10,000 100350

E Edge Couplad Coated Microstrip 1B 1 3 ] 12542 11842 10.000 85.000 10,000 BR.220
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Frequency dependent loss graphs

Speedstack Si provides graphing and tabular display of the
frequency dependent properties of each controlled
impedance structure in the stackup. The technical report
includes the option of displaying the loss v frequency graph
of every structure in the stackup — see below.

C\Program Files (:BE)P olai\SpeedstackiSamples\APS17.s6i

- —Polar

Offset Sipline 1B1A

Length of Line: 1000
Trace Conductivity: 5.8E+07 Sim

Fraquency Minimum: S00 MHz
Frequency Maximum: 10 GHz
Frequency Steps: 20

Substrate Causal Extrapolation Reference Points Surface Roughness Compensation: Hammerstad
Freq(Hz) | RefEr | RefTanD Surface 1 Roughness (RMS) R1: 0.2 Frequency of Interest: 1000 MHz
H1 1.000E+05 |4 2000 0.0155 Surface 2 Roughness (RMS) R2: 0.2 Conductor Loss: =7 485E-02 dBlline
Ei 1.000£=08 _[4.2000 00155 Sutface 3 Roughness (RMS) R3: 0.2 Dielectric Loss: -9.312E-02 dBfine
— Surface 4 Roughness (RMS) Rd: 0.2 Atienuation: -1 678201 d/line
RET Conductor Loss with Roughness: -1.097E-01 dB/ine
Cer Anenuation with Roughness: -2 022E-01 d&ine

All Losses with Roughness - d&/line

02

04

08

T~

m— Conductor | oss mmmsmm Dielectric Loss s Afienuation === Conductor Loss wilh Roughness === Attenuation with Roughness

......... T
1000 2000

1111111111111111111111111111111111
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When the technical report is selected for print Speedstack
recalculates and displays the loss v frequency for the
frequency dependent properties of each structure in the
stackup.

The display for each structure includes the structure graphic
and the associated frequency dependent parameters, the
substrate causal extrapolation reference points, the surface
roughness method and settings and the losses and
attenuation at the user defined frequency of interest.

From the Options menu, choose Frequency Dependent Loss
Graphs|Suppress to toggle display of frequency dependent
loss graphs and tables.
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Drill DataTable
Use the Drill Data Table command to show or hide the table
of drill parameters and to select and order parameter values

for display.
g= Select Drill Table Columns — O X
Selected Columns Ayailable Columns
Drill Image: < | Fill Type ~
1st Layer Hole Count
2nd Layer . Different Hole Sizes
Column Position - Minimum Size
Drill Type Data Filenames
Back Drill Must Cut Layer Mo Up Minimum Pad Size
Back Drll Must Mot Cut Layer Mo Minimum Drill Size
0 Minimum Drill Size Tolerance
own Minimum Bamel Wall Thickness
Back Drill Maximum Distance From {
Delete Back Drill Minimum Distance From C
Back Drill Primary Drill Size
o Drill Motes-1
Clear Al Drill Notes-2 v
QK Cancel

Use the Sort Drills... command to order the drill table — drills
can be sorted by start-end layer order or creation order.

Drill Data Table J Suppress

Drill Data Coelumns...

. Sort Drills... r Creation Order
Start - End Layer Order

Showing expanded drills
Speedstack can display up to eleven drill columns in a

]["'][ stack though six columns are often sufficient. Use Show
Expanded Dirills to toggle between wide stack and narrow

stack image mode. Selecting the narrow stackup image
][ frees up the horizontal space for more data columns.
Speedstack displays a warning if drills exist beyond
column six and narrow stack mode is selected,

Show Expanded Drills

A A
1 A [N /A & 0§ 1 L& | B Y
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Bill of Materials Table

Speedstack’s Technical Report incorporates the Bill of
Material (BOM) table with the stock-number displayed
optionally as a barcode. The table contains fields for Total
Quantity (No. Panels * Stack Quantity) and Total Cost (Unit
Cost * Total Quantity.)

Supplier Stack Total

Supplier Deseriplion Description Type Stock Mumber | Quantity | Unit Cost| Stack Cost| Quantity | Total Cost
Folar Samples SM001  Liguid Photimageable Mask  SolderMazk ” " " I || ||| | 2 0,00 0.00 2 0.00
Folar Samples FOmo1 Copper Foil Copper | | || || | || ||| | 2 oo 2.00 z z.00
Polar Samples PPM01 PrePreg 1080 Dietecrric [N 2 1.00 200 2 2.00
Folar Samples co/oos FR4 Core FR4 || || || ||| |||| 2 5.00 10.00 2 10,00
Folar Samples PPI0OZ FrePreg 3080 Dielectric | || || | || |||| 2 2,00 4.00 z 4.00
Folar Samples FPID04 FrePreg 1651 Dielectric I " " I || " " 4 400 15.00 4 18.00
Folar Samples co/mzo FR4 Core FR4 || || || |||||| 1 20.00 20.00 1 20.00
94,00 =400

Ho. of Panels = 1 | Circuits Per Panel = 1 | Price Per Circuit = 54.00 |

The table includes totals for the Stack Cost and the Total
Cost columns.

A summary section presents 3 values: No. of Panels, Circuits
Per Panel and Price Per Circuit. The No. of Panels and
Circuits Per Panel can be entered by the user at any time or
optionally at the start of each print session.

From the Options menu choose B.O.M. Data Table |
Panels / Circuits per Panel...

B.C.M. Data Table ¥ Suppress

Stock Number »

Panels / Circuits per Panel...

Printing stackup information ¢ 193




— | X

Enter the following data required for the Bill of Materials

[BEOM) table.
Mumber of Panels |_[|
Circuits per Panel |1

[ Always show this at the start of a print session
Ckay

Price Per Circuit is a calculated value (Total Stack Cost /
Circuits Per Panel).

Bill of Materials Table columns can be selected for display
and ordered as required. Choose the parameters for display
from the Available Columns pane and change the order of
display using the Up and Down buttons.

g Select Bill of Materials Table Columns — O >

Selected Columns Awailable Columns

Supplier

Supplier Description
Description

Type

Stock Number
Stack GQuantity 1
Unit Cost
Stack Cost
Total Quantity
Total Cost

o
=5

Diown

Delete

Clear All

d4ddas

oK | Cancel |

From the Options menu choose B.O.M. Data Table to display
or suppress the table. The Suppress command toggles the
B.O.M. table on and off in the report.

B.0.M. Data Table b Suppress
Steck Number k| + | Show as Barcode
Panels / Circuits per Panel... Barcode Font and Start/Stop

Stock numbers can be displayed in alpha-numeric form or as
barcodes. Choose Stock Number|Show as Barcode to toggle
the Stock Number display between barcodes or alpha-
numeric text.
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Stack

Description Type | Stock Number | Quantity | Unit Cost

Liquid Photolmageable Mask  SolderMask |||||||H‘||| ‘“H"””l"”“ 2 0.00
Copper Foil - Copper | [N 2 1o

PrePreg 1080 Dielectric [ [} Il 2 1.00

FRa Core PR IR 2 500

PrePreg 3080 Dielectric || il 2 20

PrePreg 1651 Dielectric [ [} I 4 400

FR4 Core FRa I T 2000

Choosing the bar code font

From the Stock Number command choose Barcode Font and
Start/Stop Character. The Select Barcode font and Start/Stop
Marker Characters dialog is displayed.

8 &
5
10
11
Angsana New
AngsanalPC 13
Aparajita 14
Arabic Typesetting 15
Avial 16
Arial Black 2 17 %
3 of 9 Barcode 12
Include Stop / Start Character
" None
(* Asterisk -~
" Exclamation - |
(" Other
Reset Close

Choose the font and font size and the start / stop character
as appropriate. (The barcode font must already installed on
the host computer.)

Choosing the start/stop character

The Start/Stop character is a requirement for certain barcode
types such as Code 39 (also referred to as Code 3 of 9,
Code 3/9, Type 39, etc.) The Code 39 asterisk character is
normally reserved as a start/stop character rendering the
data a valid barcode.

As an example, if the Stock-Number is 123-456, selecting
the Asterisk option will add enclosing asterisks to the Stock-
Number so that the barcode is valid.
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(In some instances asterisks may already be included in the
Stock-Number in which case choose the None option.)

There are other situations where another character may be
used. Exercise caution when determining the appropriate
font choice and start/stop character to use. In the event that
an inappropriate font is chosen, the results may be
unpredictable.

Footer
The report footer section is an optional item and may be
displayed or suppressed (hidden).

Footer > Suppress

Enable Expanded Footer

Override Footer Label...

Suppressing the footer
When the Footer section is suppressed the space is used for
other data, often reducing the number of pages required for

Version: V1805 |Reusion: Medification: Date of Revision. [ Editor

sociated Docume

nts: Rev #1 Coll 1 Dec 2018 _
Rev#l | Daia Net T fpr 2018 FE} o

@)

the technical report.
-
S

Using the expanded footer
Use the Expanded Footer option to allow longer and more
descriptive stack names to be displayed.

StackMame: Contraller M-Boarnd MW

Version: V15,05

AE:

Date: 12 June 2015

Author: B Johnson

Cepartment: Eng

Site: Narth Side

sociated Documents: Revision: | Modification Date of Revision:
Rev#l Call 1Des 2018
Rev#2 Diata Met 1 Apr201%

Overriding the footer labels
The labels in the footer may be changed to reflect the
stackup design workflow and organisational structure.

Choose Footer | Override Footer Label...
The Override Footer Labels dialog is displayed:
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HE Override Footer Labels — O >

Override the labels shown in the footer of the printout

ersion

Droving ol

Date

Author
|Designer

Department

Site
|0Hice

Clear Okay

The new labels will be reflected in the footer:

Crrawing Mo:| 15.03
Date: 12 June 20189

Eesigner:l B Johnson

Cepartment Eng
Office:| North Side

Note Field Aliases

Note Field Aliases allows for the free-text note fields (for the
Stack and Controlled impedance tables) to be given
descriptive names.

Print Order

Use the Print Order dialog to move the Controlled
Impedance Table, Drill Tables and Notes sections up or
down within the report.

Print Order —

Stackup Table P
Controlled Impedance Table
Drills Table Diown
Bill of Materials (B.0.M.) Table
Motes
Motes

Restare

P

Close

Note: the Stack/Materials data Table cannot be reordered
and must remain the first item in the print order.
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General options

Polar Logo L
User Logo *
Copyright 3
Data Mumber Format 3
Data Alignment L
Stack Alignment (Flex-Rigid only] ]
Font Size 2
Colours

File Path ]
Margin Guides *

Use the General Options to specify
Polar Logo: toggles the Polar Instruments logo on and off.

User Logo: toggles the user-defined logo on and off (as
set in the application configuration).

Copyright: toggles the copyright information on and off
and allows copyright test to be edited.

Data Number Format: sets the precision of numeric data
in the printout.

Data Alignment: specifies alignment (left, centre, etc.) for
stack, impedance and drill data.

Stack Alignment (Flex-Rigid only): — Align to Master
Stack allows the vertical position of sub-stacks (printed
on separate pages within the report) to be preserved with
respect to the master stack; Align to Page Top presents
each sub-stack at the top of each page.

Colours: allows for the colours of items within the report
to be customised. Click Override Default Colours and
Change to specify the new colour. Click Reset All to
return to the default colours.

File Path: toggles on and off the file path/file name

Margin Guides: toggles on and off boundary markings (in
the user selected units.) These match the Speedstack
units selected within the Stackup Editor | Units menu.

The margin guides allow for display of the printable area
of the page — which can vary depending upon the device
— even though the page size remains the same. (With
some devices the report cannot use the full extents of the

page.)
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Confidential... notice
The Technical Report includes an optional Confidential
notice to be added to the report.

Click Confidential... the Confidential Stamp Options dialog is
displayed.

Confidential Stamp Options

Select which location where you wish 'Confidential’ to appear.

Mate that some locations may interfere with existing text or loges. Itis your
responsibility to resolve this by editing the existing text or logos.

If you require, you can substitute Confidential with a word of your choosing.
Otherwise leave the field blank.

Alternative word
|Confidential

[+ Location 1 [ Location 3

[ Location 2 I+ Location 4

Clase

The notice wording may be changed from Confidential to
other text as appropriate.

The specified text may be displayed in up to four predefined
locations as shown in the dialog.

Click the check box for each required location.
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